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You wouldn’t give the keys of your house to a stranger, would you? Then
why do the same with your PC?

In today’s connected environment, it’s become increasingly important to
adopt safer computing practices than ever before. Sure, we all know the drill:
install an anti-virus software, update it regularly, avoid installing any suspicious
or unverified programs and shut down any open network shares on your PC.

But do you follow these basic guidelines as meticulously as you should? Or
to put it another way, what if these basic guidelines aren’t enough anymore?

Consider the ramifications of leaving your computer unguarded for a
moment: unprotected PCs are easy targets for propagating and instigating attacks
such as the infamous DoS (Denial of Service) attacks and are responsible for the
spread of viruses and worms.

In most online attacks, the attacker generally exploits a handful of well-
known software vulnerabilities. Couple this with the plethora of hacking tools
available online and it would be possible for even a six-year-old to hack your
computer.

Okay, so you might be one of those who practise absolutely safe comput-
ing methods and avoid clicking or previewing any messages with suspicious
attachments. But these infected attachments still reside in some corner of your
hard disk—there might come a time when someone will figure out a way to
activate these dormant viruses when you visit a rogue Web site.

It’s just not enough to update your anti-virus software’s data definitions
anymore. You need even more comprehensive protection in the form of network
firewalls. You also need to make it a habit to install new security patches to
defend your PC against certain kinds of worms that exploit well-known weak-
nesses in Windows and other popular software.

So this will ensure a threat-free existence, right?
No. Even if you take all the appropriate safety precautions, there might be

others on your network, or your friends and colleagues who have you in their
address books, who aren’t as well protected. You might prevent infection or
abuse, but you will still be hassled by these problems time and again, to say 
the least. 

There’s little you can do to prevent this, except to understand that each of
us who uses a PC is responsible in a small way, for preserving the security of
everyone around us. 

After all, prevention is not only better than cure, it’s the only cure! 

vinit_aggarwal@jasubhai.com

“Well-known software
vulnerabilities, 

coupled with the easy
availability of hacking

tools, make it easy for
even a six-year-old to

hack your computer”

Vinit Aggarwal
Assistant Editor

Play Safe
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ABBYY FineReader Professional
Size: 33 MB, Type: Trial
Mindware\Software\Office

Astrum InstallWizard 1.90
Size: 2.2 MB, Type: Trial
Mindware\Software\Developer Tools

Backup Plus 7.0.2
Size: 8 MB, Type: Trial
Mindware\Software\System

Book Organizer Deluxe 1.9
Size: 4.0 MB, Type: Trial
Mindware\Software\Home

Fresh UI 4.0
Size: 615 KB, Type: Freeware
Mindware\Software\System

Hitman 2: Silent Assassin
Size: 48.3 MB, Type: Demo
Playware\Arena\Games

ICQ 2002a
Size: 3.88 MB, Type: Freeware
Mindware\Software\Internet

Media Jukebox 8.0.348
Size: 8.7 MB, Type: Trial
Mindware\Software\Multimedia

Moral Minus
Size: 8.03 MB, Type: Trial
Playware\Arena\FunZone

Mozilla 1.1
Size: 10 MB, Type: Freeware
Mindware\Software\Internet

Talking Greeting Maker 1.03
Size: 4.5 MB, Type: Freeware
Mindware\Software\Home

Tobi On The Run
Size: 4.9 MB, Type: Demo
Playware\Arena\FunZone

Winamp 3
Size: 3.4 MB, Type: Freeware
Mindware\Software\Multimedia

HIGHLIGHTS

Sun ONE Studio 4,
Community Edition

Sun Open Net Environ-
ment (Sun ONE) is an
IDE for Java developers.
Based on the modular,
open source NetBeans
Tools Platform, the Sun
ONE Studio IDE is ideal

for building and deploying Web services
across multiple hardware and software
platforms. This modular, extensible IDE
enables fast adoption of new technolo-
gies. It provides a highly scalable and
robust foundation for traditional soft-
ware as well as current Web-based appli-
cations, while laying the foundation for
the next-generation distributed comput-
ing models such as Web services.
Size: 88 MB, Type: Feeeware
Mindware\Software\Developer Tools

Paint Shop Pro 7

Paint Shop Pro offers the easiest, most
affordable way to achieve professional
imaging results! Don’t waste your time
with high-end professional products that
cost a fortune and take a lifetime to learn.
And don’t settle for
slow, cookie-cutter
programs that tie
you to templates.
Retouch, repair, and
edit photos with
easy-to-use, high-
quality, automatic
photo enhance-
ment features, cre-
ate and optimise Web graphics with
built-in Web tools and artistic drawing
and text tools, design cool animations
and much more.
Size: 30.17 MB, Type: Trial
Mindware\Software\Multimedia

America's Army: Operations
Developed by the US Army and a world-class team of
Department of Defense experts in simulations and vir-
tual environments, America’s Army is an innovative,
realistic computer game providing civilians with an
inside perspective and a virtual role in today’s premiere
land force, the US Army.
Size: 260 MB, Type: Freeware
Playware\Arena\Games

ON THE CD

8

The Game Trailerssection on your Digit CD
brings you video
teasers of the latest
and upcoming
games. Get a sneak
peek into the
graphics, cool
effects and gory
creatures even
before the game is
released!

This month we bring you two
Machinima videos—movies made
completely using game engines. In

Comedy in Armour,  a psychotic captain of
the Red Army exterminates the Blue
Army in a variety of bizarre but
humorous ways. Hardly Workin’ is a
hilarious tale of two wandering

lumberjacks and
their quest to find
employment. It’s
directed by Emmy
award winner Paul
‘IllRobinson’ Mari-
no and produced
by the award-win-
ning ILL Clan.

KNOW YOUR CD

MUST-TRY SOFTWARE

OCTOBER 2002

Droolmaal Sponsored by:

D r o o l  o f  t h e

PLAYWARE\ARENA\GAME TRAILERS
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Want to subscribe to Digit? Want to
renew your subscription? Have a com-
plaint? Download subscription forms
and get in touch with our customer
service department here

Technology@home
Have you ever wished you had a
door that locked up by itself? A
vacuum cleaner that you could
control from your office? Well,

your wishes are on the verge of
coming true

WEB SPECIAL SUBSCRIBE

WEB SPECIAL

taste technology at http://www.thinkdigit.com

BY DEMAND
You get to choose what goes on 
Digit Interactive. This month, you 
have chosen:
Magenta II MultiMedia Tools

(10.13 MB) for Playware 

Another War Demo
(232 MB) for Mindware

Expect these on the November 2002 CDs.

Perfect with
Words
Learn the smart moves to
become a whiz at working
with word processors

OCTOBER 2002
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iSCSI
■ What is it?
iSCSI (Internet SCSI) adapts
the widely used SCSI standard
for connecting hard drives to
computers over a network
connection such as a LAN or
even the Internet. By carrying
SCSI commands over IP net-
works, it is used to facilitate
data transfers over intranets
and to manage storage over
long distances.

■ How does it work?
When a user sends a request,
the operating system gener-
ates the appropriate SCSI
commands and data request.
IP packets are transmitted
over an Ethernet connection.
When a packet is received, it
is separated into the SCSI
commands and the request.
The commands are sent to
the SCSI controller and then
to the SCSI storage device.
Because iSCSI is bi-direction-
al, it can also be used to
return data in response to
the original request.

■ What is its implica-
tion?
iSCSI has just been formally
adopted and standardised. It
builds over existing infra-
structure, using SCSI hard
disks, Ethernet networks and
the Internet. Because of the
ubiquity of IP networks, iSCSI
can be used to transmit data
over local area networks,
wide area networks, or the
Internet and can enable loca-
tion-independent data stor-
age and retrieval.

hypethesis

■ WorldCom’s former CFO Scott Sullivan denies fraud, bailed at $500,000 ■ Napster faces liquidation ■ Microsoft, with others, campaigns against open source

The Fraunhofer Institute,
developer of the MP3

codec, has announced that it
will start charging licensing
fees from users of the MP3
decoding algorithm (previ-
ously it charged only for the
encoders). Red Hat has
already removed all software
packages from the next Linux
release that would fall under
the licensing scheme pro-
posed by the Institute.

The fees of $0.75 (approx
Rs 37) per decoder would add
up to $16.5 million (approx
Rs 82.5 crore) for download-
ers of Winamp from Down-
load.com alone. Fraunhofer
also allows a one-time fee of

$60,000 (approx Rs 30 lakh)
for unlimited use of the
decoder. Encoders and users
of the mp3PRO software are
taxed more heavily, with 
a levy of $2.50-$5 (approx 
Rs 125-250) per encoder. Use
of the mp3PRO decoder soft-
ware plus patent rights
requires $1.25 (approx Rs 62)

per unit or $90,000 (approx 
Rs 40.5 lakh) up front.

A consequence of these
fees has been a resurgence in
interest in competing free
audio codecs. The Ogg Vorbis
codec is a patent-free, profes-
sional audio codec that has
been gaining steam recently.
In an open letter to Thomson
Multimedia, creators of the
MP3 licensing scheme, Vor-
bis.com has stated its unabat-
ed glee at their actions, thank-
ing them for the free publici-
ty and noting that traffic to its
site has increased substantial-
ly since the revocation of the
free-licensing status of the
Fraunhofer codec.

In New York’s Hudson Valley
region, IBM’s fabrication
plant will be the only one
that, when fully deployed,
will produce chips using all
three of the industry’s bleed-
ing edge technologies: low-k
dielectrics, copper intercon-
nect and silicon-on-insulator-
based transistors. IBM will
build chips on 12-inch wafers
that pass from station to sta-
tion in wafer pods on central-
ly controlled, automated, ele-
vated rails. To run this, Linux
was evaluated against a Win-
dows-based system and per-
formed flawlessly for three
months, whereas the Win-
dows-based system failed
after six or seven days.

First JPEG, now MP3

Linux wins

Apple revealed souped-up
Power Macs in the first

major upgrade to the profes-
sional system in about a year
and a half. The new Power
Macs sport faster memory
and speedier system architec-
ture. Apple also reintroduced
dual-processor sys -
tems. Processor
speeds range from
867 MHz to
1.25 GHz.

The new
systems come
with a 167 MHz
system bus, but are still well
behind a 533 MHz bus for the
fastest Pentium 4 systems.
Greg Joswiak, Apple’s senior
director, defends, “Our archi-
tecture is tough to compare to

a PC bus, because we don’t run
everything off the same bus
the way a PC does.”

The changes also include
a move to 266 MHz DDR
SRAM and Mac OS X 10.2 pre-
installed. The biggest incen-
tive for purchasing a Power

Mac would be the
d u a l - p r o c e s s o r
architecture—Mac
processors max out
at 1.25 GHz, com-
pared to more than
double that for PCs.

Support for a second opti-
cal drive and up to four hard
drives complete the circle.

The 1 GHz system comes
with an 80 GB hard drive,
DVD recording drive and 64
MB ATi Radeon 9000 Pro.

Power-up Mac
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Digital signatures
Digital signatures can easily
be forged and therefore can’t
be trusted in Outlook because
of a certificate chaining issue
plaguing Internet Explorer.
SSL certificates can be signed
by an untrusted intermediary
without warning to the end
user. Thus, an attacker can
sign an untrusted certificate
with a trusted, intermediate
one. Neither Internet Explorer
nor Outlook check basic con-
straints and the end user is
never warned that the certifi-
cate chain is questionable.
SSLsniff, a tool written to
demonstrate the vulnerability,
can be used to intercept a
third party’s SSL session
where the victim and attacker
are on the same LAN.
Microsoft has begun patching
the security flaw; you can find
the patches for Windows at
www.microsoft.com/technet/secu-
rity/bulletin/MS02-050.asp.

Encrypted=safe
A curious flaw in a PGP’s han-
dling of file names could
allow an attacker to run a
remote Windows machine as
Administrator with a mali-
cious, encrypted archive. File
names over 200 characters in
length cause a buffer over-
flow, which, if exploited
properly, could allow running
arbitrary code on the target
machine. This code could
give the attacker complete
control of the PC. A typical
attack would involve sending
an encrypted archive to a vic-
tim via e-mail. The flaw
affects PGP Corporate Desk-
top 7.1.x. for Windows. A
patch has been developed by
former PGP owner Networks
Associates, and is available at
www.nai.com/naicommon/down
load/upgrade/patches/patch-
pgphotfix.asp.

redalert

■ New Kodak cameras less dependant on PCs to share photos ■ MSN Messenger for Mac to be released next year ■ Broadband to hit South Pole by 2009

Chinese authorities are
feared to have blocked

access to the popular search
engine, Google (www.google
.com). The reason? Google
seemingly provides a window
to pornography and could also
compromise national security.
In November last year, the
Chinese Government shut
down 17,500 Internet cafes for
failing to block sites consid-
ered subversive or porno-
graphic. Google says it is try-
ing to resolve the problem. 

Less than a week after

banning Google, even Alta-
Vista.com was found to have
been blocked in China. These
measures come ahead of a
Communist Party meeting in
November during which the
country’s leadership is expect-
ed to be overhauled. Yahoo! is
still accessible though—it is

one of the 130 major Web
portals that recently signed a
voluntary pledge not to post
information that would jeop-
ardise state security and dis-
rupt social stability in China.

But there’s a humorous
twist: someone has set up a
Google search mirror—literal-
ly! Called elgooG, this beats
the Chinese firewall to the
outside world. It displays all
of the text backwards, requir-
ing you to use a mirror to read
it! Check this site at www.all -
tooflat.com/geeky/elgoog/ .

Microsoft has announced
the release of the much

awaited Windows Media Series
9. It brings advances in usabil-
ity and performance. Buffering

time on streaming media has
been reduced greatly, while
audio and video quality has
been increased to television
quality. It integrates several
online content subscription
services, including Pressplay,
the joint venture between
Sony Music Entertainment and
Universal Music Group.
Microsoft’s Digital Rights Man-
agement software maintains
copyright policies.

Google blocked!

statattack

Released: Windows Media 9 Insecure in a Flash

Macromedia has warned
that its Flash Player has a

vulnerability that could allow
attackers to run malicious code
on Windows and Unix-based
operating systems. More than
90 per cent of PCs are estimat-
ed to be capable of playing
Flash content. The file-execu-
tion vulnerability, discovered
by eEye Digital Security, uses a
modified header in a Flash
movie file to create a buffer
overrun, in all versions of Flash
Player earlier than 6.0.40.0.
The malformed headers can
only be created by editing the
file with a binary editing tool,
and not with the Flash author-
ing tool. Not only are browsers
affected, but also applications
capable of reading embedded
SWF files, including e-mail and
instant messengers. A pro -
grammer has also warned that
a flaw in the XML functionali-
ty of Flash Player 6, and possi-
bly other versions, could allow
an attacker to read files on a
person’s hard drive. This bug
has been fixed in newer ver-
sions of Flash Player. The latest
versions of Flash Players for all
software are available at
www.macromedia.com.

Bill Gates and James Cameron at
the launch of Windows Media 9

INFOGRAPHICS: Jaya Shetty

/
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AMD is all set to introduce
a four-way product,

which will provide a choice of
x86-based, four to eight-way
servers. AMD has previously
shown single and dual-proces-
sor configurations of its
eighth-generation
processor family,
running both 32-
bit and 64-bit
operating systems.
The AMD Opteron
processor is
designed to scale
from one to eight
processors with no
external logic
required. This can reduce the
cost and complexity of build-
ing servers and workstations
and increase scalability.

Modern micro-chips in
use today are based on 32-bit
technology and so far, the
maximum frequency the
developers have reached on

the Pentium 4 is 3.5 GHz. 
Intel, in the meanwhile, is

cutting prices on its proces -
sors. When it introduced its
2.8, 2.66 and 2.6 GHz Pen -
tium 4s, it notified resellers of
the price cuts, which apply

not only to
boxed desktop
chips, but also
to notebook,
server and
w o r k s t a t i o n
CPUs. There are
also rebates on
boxed mother -
boards. The
biggest drop is

on the 2.53 GHz Pentium 4
using a 533 MHz front side
bus, which amounts to a stag-
gering 62 per cent of its origi-
nal price. Intel is also current-
ly working on Banias, Intel’s
first processor for laptop com-
puters that it has designed
from scratch.

Processor wars heroes
Gaming Icons
Little Mario has made $7 bil-
lion in revenues, Nintendo
said, as it announced the latest
incarnation of Super Mario
Sunshine for the Game Cube.
Harrison Ford’s films have
earned only $5.6 billion world-
wide. Nintendo claims Mario
to be the ‘leading man’ of the
entertainment industry!

Print media
Ziff Davis Media (publisher of
PC Magazine and other tech-
nology magazines), had filed
for Chapter 11, having been
one of the hardest-hit by the
advertising slump in the indus-
try. It has now announced that
95.1 per cent of its bondhold-
ers had approved its financial
restructuring, enabling them
to avoid filing for bankruptcy.

Jaguar, OS X 10.2  
Apple’s new OS costs $129
(approx Rs 6,450), and
there is no upgrade-pricing
plan. If you’ve bought a
new Mac or the earlier 
OS X before July 17, you
pay a $20 (approx Rs 1,000)
‘fulfilment’ fee, otherwise
you pay the full price.  

Windows
Dell Computer is making
Windows optional for some
of its business desktops. Dell
will introduce the n-Series
corporate desktop and work-
stations that ship without
Windows or any other oper-
ating system pre-installed.
These computers will include
a copy of a free, uninstalled
operating system, FreeDOS.
This move is in direct
response to a rising demand
for PCs without OSes.

zeroes

Source: The Financial Express

Of the total

1.6 Gbps of

bandwidth avail -

able in india, over

50 per cent is

snapshot

JVC has announced that it
will use a CD-ROM copy pro-
tection scheme based on col-
laboration between itself and
Japanese company Hudson-
soft. The scheme, called
Root, records an encryption
key when a CD-ROM is cre-
ated in such a way that an
error is generated when any

attempt is made to play back
software from copied disks.
It will be built into CD-ROMs
so that copying to CD-R/RW
disks cannot circumvent it.
The technology prevents
encryption keys being read
when copied disks are
played back, and JVC hopes
to sell mastering units incor-
porating the copy protection
to other manufacturers. The
same technique can also be
used to prevent copying of
DVDs and other media.

New unbreakable
copy-protection
scheme

followup

People travelled from
around the world to the

Mesquite Convention Center,
Texas, to what is known as the
Mecca of Network Gaming
Events. Quakecon (August 15-
18) attracts the best of the best

in the online gaming world,
and they come to take a shot
at the $1,00,000 (approx 
Rs 50 lakh) that’s at stake. id
Software’s continued commit-
ment to Quakecon is perhaps
best thought of not only as a
sign of gratitude, but as a real
chance to see the progress
that fans have made in play-
ing the games. It also gives

their fans the opportunity 
to interact with the develop-
ers of the software and 
mods, which of course leads
to some very interesting
developments. 

A variety of sponsors sup-
port LAN gaming and
have a chance to reach
some of the consumers
who are the most diffi-
cult to nail down. For
four days, these sponsors
take the time to talk to

the gamers and introduce
them to their products. The
importance of the gamer mar-
ket is often overlooked, with
many people believing the
notion that gamers are not
professionals. In reality
though, they have regular day
jobs and many of them are
involved in making buying
decisions.

Quakecon 2002

■ Samsung adds 10 GB HDD to Yepp YP-900 MP3 player ■ British Library’s Koran now in digital version ■ FCC pushes digital TVs with anti-piracy technologies
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The government of Greece
has made a heroic effort to

ban all electronic games.
Something as innocent as
playing Pac Man is now a
crime with penalties of up to
three months in jail and a fine
of 10,000 Euros. The purpose
is to crack down on Internet
gambling, which already was
illegal. Improved enforcement
of the existing law is all that
was needed, but unfortunate-

ly, the Greek government is
“incapable of distinguishing
innocuous video games from
illegal gambling machines,”

according to an article in the
English-language Kathimerini
newspaper.

Earlier the Greek govern-
ment had outlawed all LAN
and Internet games and any
kind of game that is support-
ed by electrical, electronic or
software means in Internet
cafes. If anybody had some-
thing looking like a game on
the screen, the cafe manager
would be liable for arrest.

Greece bans all computer games

Consumer Reports magazine,
which recently polled sub-

scribers to its Web site, said
that the results show customer
satisfaction with technical sup-
port is down across the PC
industry. “Consumers are par-
ticularly concerned with
increased time spent on hold
as well as dropped calls to tech-
nical support,” said Mark
Kotkin, assistant director of
survey research for Consumer
Reports. The lone bright spot in
the survey was Apple, which
grabbed the top spot with a
score of 74 out of 100 and was
the only company to earn

higher marks this year
than it did last year. Dell
and Gateway were neck
and neck with scores of
65 and 64, respectively. HP
was fourth with a score of
56, while Compaq Computer
received a score of 52.

Customer service has been
an area of focus for HP and
Compaq, HP spokesman
David Albritton said. “We’ve
definitely seen that we’ve
needed to improve over time,”
he added, and claims that HP’s
own analysis of customer serv-
ice data differs from the study.
Albritton said the company

has already taken steps, includ-
ing increased training for cus-
tomer service workers as well
as shifting schedules so more
people are on the phones dur-
ing peak calling times. Other
vendors are of a similar opin-
ion, but are quick to put the
blame on new, untrained staff
and high PC penetration.

Unhappy consumers

Opera, the self-described
fastest Web browser, is on

the verge of releasing a beta
version of Opera 7, which will
resemble its predecessor only
in looks. The rendering
engine—the heart of the
browser, which interprets and
displays HTML pages—has
been rewritten from ground
up over the past 18 months.

Dubbed Project Presto, the
rewritten browser is designed
to make Opera both faster and
more compatible with the
Document Object Model

(DOM), an emerging standard
technology that lets scripts
such as JavaScript act on indi-
vidual elements of a Web page.

“There were some things that
were difficult to do with the
old engine, particularly with

changing elements in pages,”
said Opera Software co-
founder and CEO Jon S. von
Tetzchner. “We felt we needed
a rewritten engine to have
something that works with all
the DOM that is coming out.”

Tetzchner resisted com-
parisons to Netscape’s gamble
in 1998 to cast off its legacy
code in favour of a new brows-
er that would be more in line
with industry standards and
more easily separable into
components. “Our old engine
wasn’t that bad,” Tetzchner

said. And indeed the Opera
rewrite has proved to be far
quicker and less painful than
Netscape’s, which dragged on
for four years before produc-
ing marketable results. Opera
Software employs about 60
engineers. When Project
Presto began 18 months ago,
two of them were working on
it; now a majority have left
the legacy Opera code behind.

In addition to the new
rendering engine, Opera 7
will include rewritten mail
and news clients.

■ MS to launch Xbox Live online gaming service on November 15 ■ Handspring combines PDA and cell phone in Treo ■ Siemens promotes mobile gambling

A brand new Opera

Internet penetra-

tion to cross

11.64 million
in Asia by 2003

Source: Gartner

snapshot

Audiogalaxy (www.audio-
galaxy.com), one of the

largest sources for downloading
hundreds of genres of MP3
music, which had shut down
due to piracy claims, is back. It
has launched a new subscrip-
tion service called Rhapsody
which gives you instant, unlim-
ited, on-demand access to over
17,000 albums. The service will
cost $9.95 (approx Rs 500) per
month, which pays royalties
for the music. A Rhapsody sub-
scription features a personal
music library to organise music
by artist, album, track, playlist
or radio station, custom
playlists that can be shared and
many other features, in addi-
tion to Audiogalaxy’s powerful
music search and editorial rec-
ommendations.

Audiogalaxy
returns
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Enhancements in chip fab-
rication techniques have

resulted in smaller transistors
on processors and this will
result in some interesting
architectures in tomorrow’s
processors. Today’s processors
contain a single core with
associated processing subsys-
tems such as cache and data
controllers. However, with the
ability to pack greater number
of circuits on chips, fabricators
are trying to integrate two 

separate cores into a single
processor package. The low
manufacturing cost, as com-
pared to single-core processors
of the same power, will ensure
that dual core technology will
eventually bring multiprocess-
ing power to the desktop.
Since the fabrication will be on
the same chip, the speeds will
be significantly higher than of
current processors.

This is already becoming a
reality—processors like HP’s

new RISC-based PA-8800
processor (code-named Mako)
integrates two complete PA-
8700 cores, their integrated L1
caches and L2 cache controller
on a single chip, along with an
off chipset of L2 cache SRAMs.
It has also been publicly dis-
closed by AMD that its new
Sledgehammer processor will
have two cores. Intel is, how-
ever, indicating that it would
be ready for dual-core Itanium
processors only by about 2005.

“PCs will communi-
cate even more
than they do today
and cell phones will
compute even more
than they do today”
An Intel spokesman, when
unveiling details about its
first processor for laptops,
named Banias.

“They (Microsoft)
believe they are so
big that they can
take away what
consumers want.
They believe their
size and momentum
can drive an entire
industry in a propri-
etary direction with
technologies built by
Microsoft. That
direction is very
much opposite to
where most of the
industry is going.”

Frank Casanova, Apple’s
director of QuickTime prod-
uct marketing, referring to
Windows Media 9 and

■ Sony PlayStation 3 to be out by 2005 ■ ASUS introduces AGP 8x motherboards ■ IBM cuts over 15,000 jobs ■ Ericsson threatens to end Sony relationship

AMD challenges the most
common way of rating

computer performance, what it
calls the ‘megahertz myth’. It
has been urging consumers to
question the notion that a PC
with a faster chip will always
outperform one with a slower
processor. They argue that a less
expensive machine with one of
its own 1.8 GHz Athlon XP
2200+ processors can perform

as well or better than a PC using
Intel’s 2.26 GHz Pentium 4
chip. AMD says that standard
benchmarks tell only part of the
story and that trying to juggle
all of them only muddles buy-
ers, especially first-timers.
“Lightbulbs have better infor-
mation about them at the point
of sale than PCs,” says Patrick
Moorhead, vice president of
consumer advocacy for AMD.

Acclaim Entertainment is
on what sounds like the

most bizarre branding exercise
for their next first-person
shooter, Turok: Evolution,
released on September 1 this

year. If you legally change your
name to Turok, you get a 
shiny new console, a truckload
of games, $785 (approx 
Rs 39,250) plus the cost of 

getting your name changed to
and back from Turok!

Acclaim will also award the
parents of the first child born
on September 1 a $10,000
(approx Rs 5 lakh) US savings

bond if the child is
named Turok for one
year, on the condi-
tion that it is born 
in a US hospital.
Acclaim has a similar
promotion in the UK,
where it is asking five
British adults to legal-

ly change their name to Turok
for one year, in return for
around $800 (approx 
Rs 40,000) and the complete
Turok game collection.

Turok or not Turok

Dual-core chips from Intel
tomorrow’stechnology

A new PC rating method

quoteworthy

Number of cell

phone users in

India to climb to

10 million by

the end of 2002

and 120 mil-
lion by 2008

snapshot

Source: Reuters

Microsoft may go back on
an earlier pledge to not

use its Xbox Live online gam-
ing service to crack down on
mod chips—chips that modify
the Xbox console to run
copied game discs and unli -
censed software. The new
agreement states, “Microsoft
may…retrieve information
from the Xbox used to log on

to Xbox
Live as nec-
essary to
operate and
protect the
security of
Xbox Live,
and to

enforce this Agreement.” Xbox
hackers seemed unconcerned,
saying mod chips offer a num-
ber of safeguards, including
on/off switches and firmware
that can be easily modified to
bypass any new security meas-
ures. “The newer mod chips
can already defeat any
attempts by Microsoft to
detect them, as they are
firmware-upgradeable via a PC
parallel port,” writes one mod
chip enthusiast, Tony Dalton-
Richards. “I don’t think this
will affect modding very
much,” adds Dan ‘SiliconIce’
Johnson, founder of the Xbox-
Hacker Web site (www.xbox-
hacker.com). “Mod chips can
simply be switched off when
the user wants to play on 
Xbox Live.”

Xbox pirates
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Q. Which amongst these four comparison tests would you
like covered in an upcoming isssue of Digit?

Your vote counts

Whew! This was a close one, but then games it is!

This month’s question:

OCTOBER 2002

“What type of interface would you prefer on the
Digit CDs?”
■ HTML ■ Shockwave/Flash
■ Doesn’t matter. I’m only interested in the software

Log on towww.thinkdigit.com and vote on it

Dear Jaidev,
In a nutshell, game development is made up of three streams: design,
programming and art. The safest route you could take is by going the
animation way (art). A good animator is a very important asset to a
game development company. Moreover, the skillset carries over to the
film and broadcast industry (ads, serials and the like). Of course, ani-
mation is not an easy subject to tackle—it requires sound knowledge
of biology, physics and mathematics. Plus you would need to famil-
iarise yourself with 3D modelling packages such as 3D Studio Max and
Maya. For more information, check out www.gamedev.net.

Hi Keith,
Ordinarily we don’t carry such large software since we do have ‘lim-
ited’ space on the CDs and need to cater to a large audience that
has varying preferences and needs. Luckily for you, America’s Army
was the winner of the August-September 2002 By Demand poll, and
is being included with this issue of Digit. Find it in the Arena section
of the Playware CD.

40%
Linux

44%
Gaming

16%
Mobile Computing



Hi Vinit,
In your anniversary issue, you used a female
model on the cover. At that time you had said
that for sleek hardware (like mobile phones)
you will use female models, but now you
are using female models even for printers.
Does Digit have to resort to eye-catch-
ing models to attract buyers?
Ajay Datta

Via e-mail

Dear Sir,
You have changed big time
in the past few months.
What surprises me most is
that you show models in place
of product shots on the cover. I
have always thought people use
models when they don’t have faith in the
product itself. Digit doesn’t need models!
And yes, I am one of those who think an
iMac is hotter than Aishwarya Rai!
Sushubh
Via e-mail

Dear Vinit,
I just renewed my subscription from Septem-

ber 2002 to August 2004. As soon as I
received the September issue, 

I realised that I had made no
mistake. I simply can’t do
without Digit. The cover
model Raksha Kapoor was a

real cutie. I kept gawking at
the cover!

Alok Moghe
Via e-mail

Hello,
The cover of the Septem-
ber issue is very good and

attractive and the model on
the cover is damn cute. Her

charming face makes the cover
very attractive and the green colour adds even
more life to the cover. Your anniversary issue’s
cover was radically different and marvellous, but
this one is even better.
Jack
Via e-mail

Dear Mr Pethe,
We are aware of this. In fact, Winamp 3
was mentioned in last month’s article, ‘The Enter-
tainers’. But it was still in beta and there were sev-
eral warnings on the Winamp Web site. As we
don’t carry beta software on our CDs, we were
waiting for the final release, which incidentally has
been included in the Mindware CD this month. The
Playware CD still carries version 2.8 to ensure
compatibility with the various Winamp skins in the
Gallery section.

Head2Head: Cover models?

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 
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Short Bytes

Con job
Hi,
The graphics card test
(August 2002) was superb.
But you missed out one
important thing—the top
10 ways to hoodwink your
dad into buying that new
graphics card! I'm looking
to upgrade and can't think
of a suitable excuse. Help!
Arjun Ghose

Via e-mail

Dear Arjun,
How about getting a job and
paying for it yourself?!

Help is at hand
Hi Vinit,
I read your September edi-
torial on Helping Hands
and am planning to work as
a bridge to help underpriv-
ileged children in India
become computer literate. I
appreciate your work in this
direction.
Uma Maheswaran

Via e-mail

Sound bytes

Dear Vinit,
Your September issue was a
wonderful experience, espe-
cially the detailed test on
soundcards. I am an
acoustic engineer and I’m
sure that your magazine
will make more people
aware about the less-heard
acoustic industry.
A. X. Devaprasath

Via e-mail

Kudos
Dear Digit,
Your September issue was
fabulous, especially the test
drive section where you
reviewed everything in 
the PC audio world.
‘Smart@work’ was also a
brilliant idea.
Amit Kundalia

Via e-mail



30 OCTOBER 2002

First there was the race for greater
density, then came the quest for
newer technology, heralding an
accelerated adaptation of RAM.

This almost quick-time implementation
of memory catalysed growth in other
areas of technology, rushing us to the age
of nanosecond computing.

If it were not for these advancements,
tiny cellular devices with 500-address
memories, PDAs that let you watch
movies and MP3 players that store your
entire music collection would never have
seen the light of day. In more familiar ter-
ritory, even computer memory has seen
numerous architectural iterations—from
EDO RAM to the numerous flavours of
SDRAM, all the way to RDRAM and DDR.

The need for speed
In the continued quest for the perfect
memory, companies are struggling to

achieve the golden balance between fac-
tors such as data transfer speed, reten-
tion, density and low costs. However,
each implementation of RAM has
greater strength in some of these areas
than others. Today’s computers are com-
posed of different types of data storage—
the hard disk that stores the permanent
data, the RAM (either SDRAM, DDR or
RDRAM), which is used to store pro-
grams that are loaded and running, and
finally, SRAM that is used in high-speed
implementations such as the cache on
processors.  

RAM (SDRAM, DDR and RDRAM) as
we know it today, can not retain data
once the power has been switched off—
this is a definite shortcoming. SRAM is
significantly faster than other forms of
RAM but is expensive to produce on a
very large scale, which is why it is used
only in small quantities in computer sys-

tems. Though manufacturers have figured
a workaround to the problem of data loss
in case of Flash RAM, this kind of RAM
has an associated life cycle before it begins
to lose its ability to retain data.

While the architecture of each solid-
state storage technology differs, they are
still fabricated using the same funda-
mental design. This is the problem that
is throttling the power and functionali -
ty in today’s computing applications—
be it on the desktop or on mobile
devices, and this limitation is the main
driver of the innovations in fabricating
newer forms of volatile storage. 

The search begins
Considering the overall size of the mem-
ory chip market ($25 billion, (approx Rs
1,25,000 crore) in 2001, even in the face
of recession and sagging economies), it is
of little surprise that some of the biggest

Computing at the speed of thought: a look at the next step in the evolution 
of cheap, fast and dense solid-state memory 

Memory Mat-
GRAPHIC DESIGN: Ram

➜
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names are on the hunt for next-genera-
tion memory. While this race has been

in the running for
well over a
decade, it’s only
recently that a
headway has been
made in the

implementation of these technologies.
Giants such as IBM, Infineon and
Motorola are in the lead, being specifi-
cally involved in the research of a new
form of solid-state memory called Mag-
netoresistive RAM (MRAM).
This type of RAM uses princi-
ples of alignment of magnet-
ic particles as the basis for
storing zeroes and ones in a
digital system. With the
advancement of magnetic sensing tech-
nologies (that are, incidentally, also used
in hard disk drives), smaller magnetic
fields are capable of being sensed with
far greater accuracy than before, allow-
ing for greater densities in storage 
system. (See box, ‘MRAM: Saying Bye to
Bootup?’)

Another new solid-state memory

technology is Ferroelectric RAM (FRAM).
Though it sounds similar to MRAM, this
technology uses principles of electric cur-
rents to change the polarity of ceramic
crystals (and not metallic materials, as the
name suggests), which is the principle ele-
ment for storing digital informa-
tion. The advantage is that it
retains data even after the power
is switched off. These crystals also
have significantly lower power
requirements, making them ideal
for mobile consumer devices. Recent

developments in this field have
improved the number of times
these chips can store data with
lower manufacturing costs and
increased densities. David Bon-
durant of Ramtron says that

they are only now beginning to evaluate
what they can accomplish from the
enhanced manufacturing processes.

One very interesting technology
that spells volumes for solid-state stor-
age is 3D memory. Until now, the fabri-
cation process of silicon-based memory
consisted of layers of microscopic 
components being fabricated on two-

dimensional surfaces. With 3D memory,
scientists have found a way to extend
the fabrication process such that the
microscopic components (such as tran-
sistors and capacitors) can be stacked on
top of one another resulting in signifi-

cantly higher storage densi -
ties per unit area of fabri -
cated silicon. This directly
spells lower manufacturing
costs per megabyte. This
concept has been around

for about a decade, but only now when
fabrication technologies have been so
vastly improved is it viable to put it to
practise. This is possible due to a process
called chemical mechanical planarisa-
tion where silicon surfaces are prepared
for vertical stacking of microscopic com-
ponents. A form of this process is already
being used to manufacture flat panel dis-
plays. Prototypes of this technology
have demonstrated
speeds of the order
of milliseconds—
faster than today’s
hard disks, but still
way slower than

This type of RAM was born out of the same
cast as the hard disk drive. Using a phe-
nomenon called Giant Magnetoresistance
(GMR), which was first developed by IBM,
very small magnetic fields can be stored
and sensed reliably and quickly.

MRAM uses the same principle where
similar types of GMR materials are used
to fabricate arrays of microscopically
small magnetic elements. The orientation
of the magnetic field in these elements
(North or South) determines whether it is
carrying a digital zero or one. Each GMR
cell is a sandwich made of special metal-

lic materials (like iron and chromium). In
an MRAM cell, there are parallel rows of
microscopic wires above and below the
magnetic sandwiches. The ones above
run parallel to the sandwich while the
ones below run perpendicular to it, look-
ing much like the weft and warp of a fab-
ric loom. In its normal state, each mag-
netic element will have an inherent
charge in it. If a current is passed through
the neighbouring wires, this magnetic
orientation can be changed and thus the
data can be modified and also written
into the element.

While reading data from these elements,
a current is passed through the sandwich
and the magnetic resistance is measured—
a low resistance signifies a zero while high
resistance signifies a one. This process of
reading does not disturb the magnetic
condition of the cell.

The inherent advantage with MRAM 
is that since it is based on the principle 
of magnetism, it retains whatever infor-
mation is contained in it even after power
is switched off. Additionally, unlike con-
ventional DRAM, these elements do not
need an electric charge to retain the
information—it is only needed during
read-write processes. Hence, power 
consumption of these devices is fractional
compared to that of DRAM, which 
needs to be continually refreshed in 
order to retain data. Finally, with the
absence of the delays associated with
transferring electricity between the stor-
age elements for retaining the informa-
tion, MRAM is expected to be up to 
30 times faster than DRAM. With these 
characteristics, MRAM is poised to 
give rise to a new breed of instant-on
computing devices.

MRAM: Saying Bye to Bootup?
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present-day volatile memory. Another
problem is that the data can be written
only once, much like a CD-R disk—there
is no way data can be modified in this
form of storage. 

Smaller chip sizes translate into sig-
nificantly lower manufacturing costs and
this subsequently spells cheaper compo-
nents to the end-user. Consider this case:

in most chip fabri -
cation processes,
there are usually
about five bad spots
in a silicon wafer. If
this wafer were

used to produce, say, 10 chips, this would
imply that five chips would be faulty and
would have to be discarded.  However, if
this same wafer were used to produce 100
chips, there would still be just five faulty
chips in the batch. 3D fabrication will use
a very small footprint due to the expan-
sion in height of the fabrication process,
and therefore this form of memory is
expected to be significantly cheaper than
other solid-state storage tech-
nologies today.

The next radical memo-
ry implementation is Ovonic
memory. In this solid-state
memory, heat is used to trig-
ger a reaction in certain types
of crystalline materials. These crystalline
materials can exist in one of two chem-
ical states that correspond to a digital
zero or one. The factor that causes these
states to change is the heat applied to
these crystals. However, the main hurdle
here is controlling the voltage in these
devices—a state change occurs only
when the crystalline material is heated

at about 600 degrees Centigrade, imply-
ing heavy power consumption. The
upside is that the access time of proto-
types of this technology has been logged
at about 50 nanoseconds—about the
same speed as today’s DRAM, but slower
than MRAM technology.

New horizons
Each of these new technologies has
marked a new trail in the fabrication of
volatile memory. With the inherent
advantages seen in terms of performance
and lowered fabrication costs and
the plethora of applications these
technologies can be put to, they
seem all set to edge out the exist-
ing solid-state memories into
oblivion.

In terms of performance, technolo-
gies such as MRAM have already demon-
strated speeds that are magnitudes faster
than existing solid-state memory stan-
dards. Once fabrication processes and
yields get further improved, this type of

memory will be seen in PC-
based applications where large
densities and performance is of
paramount importance. Its low
power consumption will also
enable it to surface in portable
and mobile devices like PDAs,

MP3 players and cell phones. Technolo-
gies such as 3D memory boast of inher-
ent characteristics such as lower produc-
tion costs per megabyte and very small
footprints. The immediate applications
projected by companies involved in
these technologies have been in portable
applications such as digital camera and
PDA memory. 

There are a handful of companies
that are actively involved in these new
memory technologies. Skymoon Ven-
tures, the company that invested in RAM-
BUS, is now funding Matrix Semiconduc-
tor, a prime pusher of 3D memory.
Ramtron has been one of the pro -
pounders of the FRAM technology. This
company was founded in the 1980s and
released its first FRAM chips in 1992. Ini-
tial avatars of this technology produced
memory chips where data used to degrade
over time and could record information

about only a dozen times
before losing their storage
ability. However, the newer
iterations are far more sta -
ble and have  lower manu-
facturing costs. On the

MRAM front, IBM has partnered with
Infineon and has already demonstrated
chips operating at sub-10 nanosecond
speeds.

In order to keep up with the
advancements in other areas of comput-
ing such as processing and 3D graphics,
the need for significantly faster memory
that is both denser and lower in cost, is of
increasing importance. Companies
involved in the development of these
technologies are determined to turn high-
volume solid-state memory into com -
modity items found at the same store as
your digital camera. This does not seem so
far fetched when considering that our
SIM cards are nothing but 32 K Flash RAM
implementations! We are at the dawn of
the revolution in volatile memory and
the future can only get faster.

MARCO D’SOUZA

Density
Technology

Data transfer
speed
Cost of 
implementation
Time to 
implement
Applications

Companies
involved

MRAM
High
Giant 
Magnetoresitance

Very high 

High

2-5 years

Desktops/ 
portables
IBM, Infineon,
Motorola

FRAM
High
Ceramics

High

High

3-5 years

Desktops/ 
portables
Ramtron, 
Samsung,
NEC, Infineon

Ovonic memory
Medium
Crystalline state
change due to
heat
Medium

High

4-5 years

Embedded 
systems
Energy 
Conversion
Devices, Inc

3D memory
High
3D fabrication
and chip design

High

Medium

3-5 years

Portables, Flash
replacement
Matrix 
Semiconductor

DRAM
Medium
Silicon charge
store capacitance

Medium

Low

Already present

Desktops and
portable PCs
Kingston, Crucial,
Samsung,
Hyundai

SRAM
Low
Silicon transitor
flip-flops

Very high

High

Already present

System and
processor cache
ST Microelec-
tronics, Samsung

Flash
Medium
Charge storing
transistors

Low

Medium

Already present

Portable digital
devices
Intel, AMD,
Sandisk

Ramped up RAM
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Fujitsu PDS-5001
Bring home the movies
This plasma screen display incorporates a host of advanced
technologies to display output from virtually any video
source. The outstanding 500:1 contrast ratio produces excep-
tionally bright and realistic visuals and it also includes
Fujitsu’s AVM processor, which improves vertical resolution
and reproduces natural movement without a stutter.
Featuring a resolution of 1366x768 pixels, it displays true
1080i and 720p signals meant for HDTV, 480p signals from a
DTV set-top box or computer, and the RGB output from a
computer up to SXGA resolution. And with a diagonal
screen-size of 50 inches, it’s time to say bye-bye to the 
cinema hall.
Web site: www.fujitsu.com

OCTOBER

Technological elves to help you around the

eGO Cycle2
An ego trip like no other
Made of anodised aluminium, the eGO is an environment-friend
ly electric ride with a classic design. The simple controls, large
wheels and a low centre of gravity make it safe and easy to oper
ate. Its powerful onboard battery delivers enough juice for a 40
km range with a top speed of 37 kmph and the included battery
charger provides a fast 4 to 5 hour recharge. The front suspension
ensures a smooth ride and front disc brakes allow it to stop on a
dime. It’s made to carry 113 kg onboard and an additional 45 kg
of trailer cargo—perfect for that quick trip to the grocer’s.
Web site: www.egovehicles.com
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Crestron TPS-6000
...and one panel to bind them all
The Crestron TPS-6000 is a home control interface that
can be configured to control any device in your home,
be it smart lighting, perimeter security, or audio-video
devices. Based upon a 15-inch XGA TFT monitor, this
device houses a surprisingly easy to use interface that is
touch panel-based. Capable of wireless operation, it
can also be ported to other locations in your house.
With 16 MB of internal memory, Ethernet connectivity
and WAV playback capability, this device marks the
culmination of your home of the future.
Web site: www.crestron.com

▲
▲

Klipsch Quintet Micro
Theater
It’s dynamite!
These tiny monsters pack quite an
acoustic punch, making them the
perfect audio companion
to your home PC or hi-
fi system. With an in-
built amplifier that
pumps 225 watts, the
system delivers awesome
surround sound via its
5.1-channel system.
Mere 7.5 inches in
height, the satellites have
built-in swivel stands that
let you aim the speakers or mount them
on a wall. 
Web site: www.klipsch.com

LG Bagless 
Vacuum Cleaner 
V-C7070CT
The cleansing touch
The LG V-C7070CT promises
to clean up the competition
with its stunning looks and
plethora of user-friendly features.
With a 360 degree swivel hose for
deep nooks and crannies, an auto-
matic cord re-winder and filters
instead of a dust bag, the V-C7070CT
is more than just an attractive proposi-
tion. A suction power
of 330 watts and
seven layers of fil-
ters ensure that
it keeps your
sweet home
dirt-free.
Web site:
www.lge.com
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Asystem configuration that
reads a Pentium 4, a 7,200-rpm
40 GB hard disk drive, 256 MB
of RAM, and sprinkled liberally

with an assortment of hardware such as
a high-powered graphics card, a 17-inch
monitor, 5.1 surround sound speakers,
an optical mouse, et al. All this at a price
that is anywhere between 10 to 30 per
cent cheaper than similar configurations
of branded PCs. 

Local assemblers push their concoc-
tions in your face everyday in the form of
newspaper advertisements and handouts
at the railway station. They promise you
the world, all within your earthly budget.
While some deliver their promises, 
others will try to take advantage of an
ignorant buyer. 

But take heart—you can be the proud

owner of a computer that rivals the best in
its price range and still be assured of after-
sales support. All you need to do is ask the

right questions, do a bit of background
research and look out for possible pitfalls.

Looking forward to a machine built exactly to your satisfaction? Here’s how to select the 
right assembler who will deliver your dream machine

ILLUSTRATION : Mahesh Benkar
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✔ Chat with friends and relatives who have
purchased computers from the same
assembler. You can gain a wealth of inside
knowledge from them regarding after-sales
support and trustworthiness. Trusty assem-
blers should not hesitate to provide you the
names of a few people who have bought
from them. 
✔ Don’t buy from a vendor who tries to
overwhelm you with technical jargon.
✔ Don’t buy a computer from a store
where the salesperson makes you feel like
you’re not worth their time—if this is the

way they treat you while you’re buying a
system, you could well imagine what after-
sales service would be like.
✔ Find out if the company has any quality
certifications such as ISO 9000—this would
spell better quality products and attention
to detail.
✔ Find out if the vendor has any other
branches and what the strength of their
after-sales force is. Preferably, choose a
vendor that is located within an hour’s
driving distance from where the computer
is installed.

Choosing the Right Assembler

Made to Order

➜

features ■
■ firsthand
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Which assembler?
If you take a walk down Lamington Road
in Mumbai or Nehru Place in Delhi,
you’ll come across a myriad of assem-
blers—those who are informative and
help you with your decision, to those
who are nonchalant and indifferent.
Assemblers are quite a misinterpreted
lot—most of them are perceived as
wolves, waiting to swindle you out of
your last paisa. However, in most cases,
nothing could be further from the truth.

Many buyers have come across assem-
blers who have been helpful and patient,
answering each query.

The trick to finding the right assem-
bler is to not rush through your deci -
sion—buying a PC is often a one-time
exercise. Take your time making your
decision and review a few assemblers.
You don’t have to go with the system
suggested by the first assembler. Go with
the one who gives you the best deal, not
only with respect to the system, but also
in terms of after-sales support (see box:
‘Choosing the Right Assembler’).

Most assemblers interact directly
with the grey market and their modus
operandi is markedly different from the
way MNC brands do business. Profit
margins are different for assemblers
since they deal in bulk quantities, while
access to hardware and a whole range of
components enable them to bring the
latest hardware into the market faster
than most MNC brands. Also, being
smaller players, assemblers are capable
of offering much more personalised 
support to their customers than large
companies. 

The buyer’s guide
To get the best out of the assembler, you
must be clear about your hardware
requirements. Though a little ambiguity
is expected if you are a first time buyer, a
customer who insists on the buzzwords

of technology without knowing how it
will help him can be quite exasperating.
“Most people ask for a computer for a
given application like surfing. They only
know key words like Pentium 4, 3D accel-
erated graphics, etc and convincing them
to buy suitable system configurations and
capabilities is very difficult,” says Deepak
Jotwani, proprietor of Future Shock, a
Mumbai-based computer dealership. It’s
always a learning experience to know
which component is compatible with

what and the best person to learn it from
than is the assembler himself.

Besides deciding on your computer’s
configuration, there are a number of
other aspects that you should consider
when buying from an assembler. First, get
a clear fix on what you are going to 
primarily use your computer for and how
much money you are willing to spend on
it. This will dictate the best choice of
processor, graphics subsystem, amount of
RAM, hard disk size and speed for your
particular application. If your primary
application is gaming, with your second-
ary being Internet surfing and office

applications, then you would need to buy
the fastest processor, with the maximum
amount of RAM and hard disk you can
afford. The scenario would be quite dif -
ferent if your priorities were reverse. Then
you would do fine with a gigahertz-class
processor, 128 MB of RAM with a good
integrated graphics chipset such as an
845G-based Pentium 4 motherboard or
an nForce-based board with a Duron
processor. 

Though most assemblers are helpful,
it isn’t a good idea to only depend on the
assembler’s suggestions regarding the
hardware configuration that would be
most suited to your needs. Assemblers
tend to suggest only the hardware that
they stock and there might be other hard-
ware options that could get your job done
at a lower price. With some background
research on the best hardware suited to
your needs, you can insist on your con-
figuration. If the assembler doesn’t have
some of the hardware, you can always ask
him to source it for you.

Very often, people tend to finalise the
price of the system without taking into
account the after-sales support and cost
of the software. Inquire about the war-
ranty period and the type of warranty
(carry-in or on-site), so that you know
how reliable your assembler is. 

When it comes to software, 
you’ll have to be a little wary. Unfortu-
nately, most assemblers install the software
without any regard for licensing issues.
Make it a point to choose an assembler
who provides you with legal OEM soft-
ware—doing so makes it easier to obtain
after-sales support on the software and
upgrades. And it’s the legal thing to do!

Assemblers want to sell you the
fastest moving hardware they have
in stock—it is wise to check the
price, suitability and the warranties
of the hardware offered by a variety
of assemblers before going in for a
system

Vivek Louis
OWNER OF AN
ASSEMBLED COMPUTER

“
”

“It has a high-
powered graphics 
card”
“It’s the lowest priced
system among other 
vendors”
“Free printer/scanner/
mouse bundled”

“Software installation
extra”

A TNT2 or integrated graphics
solution that will just barely let
you play the latest games
Sub-standard or very low 
powered components

End-of-life peripherals that 
are on their way out of the
market

Possibly pirated or 
outdated software 
with little hope of after-sales
support

What do...
...they mean ...you need to do...they say

Find out the exact name of the
graphics card and see if it suits
your applications
Make sure that he isn’t selling you
secondhand or repaired system
components
Find out if these peripherals meet
your need and have after-sales 
support that you would require
later on
Go with vendors who offer lower-
priced OEM versions of the soft-
ware and whose cost is integrated
into your system price
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Making the purchase
Once you’ve decided on which assembler
you want to entrust your system to and
have finalised on the configuration, it’s
time for the final step. But before you
actually place the order, make sure that
you have a clear understanding with the
vendor regarding the hardware configu-
ration, warranty, after-sales support and
the payment terms. Most vendors accept
only cash-down payment, but you
should insist on paying a major part of
the amount upon satisfactory installa -
tion. Also, iron out details regarding 
the delivery and installation of the 
system. Make sure that there is a clause

that clearly specifies the date of delivery
of the system and that the assembler cov-
ers any damage caused to the system dur-
ing delivery. Plan it such that you per -
sonally receive the system and check
each and every component upon arrival,
all the way from specifications and brand
of components, down to the colour! Very
often, vendors try to squeeze in surprises
at the last minute and refuse to accept a
return later. Sign the bill only after you
have personally verified that the system
is working to your satisfaction and that
the specifications match what you had
ordered. Also check that the software
installed is what you had asked for. If a

PC fails due to faulty components, it usu-
ally does so within the first week. Make
sure that you have an understanding
with your assembler, which allows you to
return the system within a certain time-
frame after installation in case something
goes wrong.

Now that you have the roadmap,
buying a PC from your local assembler
should be a whole lot simpler. Stick by
these ground rules, do the background
work, keep a lookout for overzealous
vendors and you’ll have a system that
will stick by you through all your quests
in computing.

MARCO D’SOUZA

The demanding buyer
It’s a very simple decision for you: you like
the very best, cost be damned!
You want the latest proces-
sor under your computer’s
hood, coupled with the
most powerful graphics
card and exotic
peripherals
such as alien-
esque game
controllers,
blazing 
CD-RW drives,
optical mice,
etc. You cor-
roborate spec-
ifications of
hardware with
review sites on the Internet and read every
computer magazine in sight. You know
your GeForce 4 from your GeForce 3 and
know how to get it too! 
Possible pitfalls: You often expect more
than what your budget allows. Since
you’re trying to fit the best into your
budget, beware of assemblers trying 
to sell you sub-specification devices. If
you’ve paid for the fastest 40 GB IDE drive,
make sure it is a 7,200-rpm drive and not 
a 5,400-rpm drive. Since you’re spending
a lot of money on exotic hardware,
demand warranties on all the devices.
Ensure that the assembler uses licensed 
or OEM versions of software. OEM versions
are lower priced than retail software—
negotiate with your assembler regarding
the overall price of the system and make
sure that this includes the cost of the
installed software.

The price-conscious buyer
You are well aware that the tree outside
your house will not sprout money to let you
buy a Logitech WingMan Extreme Digital
joystick. Money is of paramount impor-
tance—you will not spend a single paisa
more than you have to
and will bargain till
hoarse on the price of
the mouse! You’ve
been to over
20 vendors
and meticu-
lously noted
down the
price for each 
piece of
hardware in
their inven-
tory. You’ve
inquired
about their prices in
Singapore and Dubai and have an average
understanding of them and what they’re
suited to.
Possible pitfalls: Beware of vendors who
try to sell you sub-standard or lower speci-
fication hardware. If you’ve specified the
brand, make sure you get exactly that one.
Use foreign prices only as a guideline—
the scene is completely different after
hardware passes through the various tax
and custom duties in our country. Since
you are on a limited budget, you will not
be able to buy a system that has best-of-
class processing and graphics power. 
Settle for one that includes a Duron or
Celeron processor with integrated graphics
or a card such as the GeForce2 MX 200 
or a TNT2.

The confused buyer
You are the light of the assem-
bler’s life. Blissfully unaware of
the different components, all
you know is that
you want a com-
puter. You will be
the target of the
full force of the
assembler’s mar-
keting babble.
Technology buzz-
words like Pentium
4, 3D accelerated
graphics and 40 GB drives can be baf-
fling—try not to fall prey to the ‘an nVidia
TNT2 is actually a high-powered graphics
card’ talk! 
Possible pitfalls: You need to look out
every step of the way. Beware of eager
vendors who insist on closing a deal quick-
ly. Take your time looking around and eval-
uate how much different vendors are
charging you. Do your homework through
online sites, other PC-owners and through
a survey of different assemblers. The best
solution is to take along a ‘techie’ friend
who might know about hardware prices.
Or, get a listing of the specifications you
would need from a trusted source and
then insist on those specifications only.
Insist on licensed software and be clear
about the after-sales service offered since
you’ll need it often. Most importantly, see
that you have all the documentation with
regards to the warranties—verify the type
of warranty, the period and what hardware
it covers. Remember to have the system
checked by a knowledgeable person when
it is ready to be delivered to you. 

What kind of Buyer are you?

ILLUSTRATIONS: Ram



test drive ■
■ start up

42 OCTOBER 2002

The Digital Media
Test & Research
Centre (DMTRC)
conducts a series

of elaborate tests to eval-
uate the merit of each
hardware and software
product. To ensure that
our readers have all the
information they need to
make an informed buy-
ing decision, engineers at
DMTRC evaluate and
review the latest hard-
ware, software and technology services in accor-
dance with the most up-to-date evaluation
processes and methodologies used around 
the world. 

Comparison Tests
We use a dual rating system, the first of which is

applied to the Comparison
Tests in which we compare
the performance of products
within a particular category.

Each product is evaluat-
ed under different parame-
ters such as performance,
value for money, features,
warranty and support, etc. 

Weightages are then
applied to the various test
parameters according to
their importance for 
that particular category of
products. 

These weightages are
then used to arrive at an
overall grade for each indi-
vidual product. An overall
grade of A+, therefore, indi-
cates that the product is
close to perfection.

The Awards
Digit awards out-
standing products
by selecting a Best
Performance and
Best Value winner in
each comparison
test. The winner of
the Best Perfor-
mance Award will be
the product that
scored the highest in
the performance seg-
ment of our tests.

This award represents the best performing prod-
uct in our tests and doesn’t factor in any other
parameter such as value for money, features, sup-
port, etc. The winner of the Best Value Award
will be the product that scores the highest in
our value for money parameter which is derived

taking into account the ratio of
a product’s performance and fea-
tures to its price. The product
winning this award offers good
performance at a great price.

In Bazaar
The second part of the rating system is used to
evaluate individual hardware and software prod-
ucts in the Bazaar section. The evaluation covers
parameters such as performance, ease of use,
value for money and the build quality/features of
the product in question and then arrives at an
overall rating. 

Here each of these parameters is given a
weightage of 25 per cent and is rated on a scale
of 5, which is represented by arrows ( ). 

The greater the number of arrows, the better
the product. This simple five-point rating system
is designed to give you an easy-to-interpret
assessment of a product. For example, a product
that receives an overall score of five arrows sig-
nifies an outstanding buy!

How we Test
Branded PCs typically offer
the right mix of price, per-
formance and after-sales
support and are thus ideal
solutions for the first-time
buyer or the corporate envi-
ronment. This month’s com-
parison test brings us face-
to-face with 12 such offer-
ings from companies such
as Compaq and HCL. We
took an application-based
approach to evaluating
them. We conducted real-
world tests that covered
office applications, produc-
tivity and gaming, and
derived a Suitability to Task
Index (STTI) that will help
you choose a PC to fit your
needs. To add spice to the
PC mix, we also took a look
at the latest Apple iMac.

Next, we tested three
software suites—all-in-one
solutions for system security,
maintenance and recovering
lost data. The suites came
from the houses of Norton,
McAfee and Ontrack and
were evaluated for the fea-
tures they offered as well as
their performance under fre-
quently used-tasks.

In the Bazaar section, we
tested some of the latest
hardware and software. The
latest versions of both Red
Hat Linux and CorelDRAW
went under the Test Centre
knife. The fastest Intel
processor, the Pentium 4
2.8 GHz, also found its way
among the products we
tested, followed closely by
possibly the fastest graphics
card in India, the Gainward
GeForce 4. To round up the
range of products tested,
we evaluated the ACi
Impression notebook com-
puter and a stand-alone
disk-defragmentation tool—
the Executive DisKeeper.

In Test this Month
It looks good and the technology is glitzy, but does it do the job?

Excellent: a brilliant combination of price, performance and features—far 
beyond expectations
Good: a good buy, better than most products in its category
Average: reasonably competent but nothing spectacular about the product
Mediocre: does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be 
used for its target application

The 5-point Rating System used in Bazaar
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So you’re looking for a computer that offers bleeding-edge performance for
your applications, features that will allow for effortless computing, backed
up with prompt and efficient service when you need it? We’ve got the pick
of the pack that promise to deliver just that
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T
rot back to the last time we did a PC comparison
(October 2001)—the top dog then snarled with
the combined power of the 1.5 GHz Pentium 4
processor and a GeForce 3 graphics accelerator,
and was armed to the teeth with peripherals. In
terms of sheer performance, it managed to wow

even some of the more stringent reviewers in the Digit Test
Centre. Many a megahertz, megabyte and rendered pixels later,
the envelope of what’s considered to be hot technology is still

being pushed further.
The advancements in technology have resulted in

quantum leaps in system performance and amazing
features—GeForce 4 Ti 4600 graphics cards, searing-

fast DDR and RDRAM and of course, the ever spi-
ralling clock speeds of today’s processors have

brought some serious horsepower onto
your desktop, at relatively low prices.

Given their complexity, these prod-
ucts need robust after-sales support

and warranties. Customer support is
as important as the usual parameters of

performance and features—comprehensive,
countrywide after-sales support and service

spells the difference between a branded PC and a
locally assembled one.

Digit Test Process
For a PC to be accepted as branded, it had to fulfil a set of cri-

teria. First it should have a distinctive logo and a national pres-
ence with authorised service centres in at least all the major
metro cities. Besides, a particular PC model should come with a
constant configuration, regardless of where in the country it is
sold. A branded PC is also required to include a licensed operat-
ing system or a recovery CD that carries the licensed software.

The PCs received in our Test Centre were of the same config-
uration as those found in the market, with the necessary periph-
erals, supporting software and documentation included. They
were tested ‘as they were’—we did not tweak or load additional
software into them, except the benchmarking applications. This
was done to capture the performance as would be experienced
by the end-user. Finally, to complete the picture, we also tested
the bundled peripheral components such as printer, scanner,
monitor and speakers. 

Test methodology
The PCs were tested on four primary parameters: features (30 per
cent), performance (40 per cent), value for money (20 per cent)
and warranty and support (10 per cent). The weightages alloted
to each parameter was used to calculate the overall scores.

Features: The various features of the PCs were divided into four
major categories:
a) System configuration and bundled peripherals: We noted
specifications such as the processor type, amount of RAM, hard
disk type, motherboard, CD/DVD/CD-RW drive, graphics card,
motherboard, etc. The better the specifications that a computer
boasted, the higher it scored in this category.
b) Build quality: To evaluate build quality, we noted aspects
such as the overall layout of the components within the system
cabinet, roominess and airflow within the systems through addi-
tional fans and ducts and attention to details such as tied IDE
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and power cables. We also observed the sturdiness of the
CD/DVD drive tray, the quality and feel of the buttons on the
cabinet, the mouse and the keyboard, labelled ports at the rear
of the system, etc.
c) Upgradability: Here we logged specifications such as the
extent to which the processor could be upgraded (the highest
clock speed and technology), the maximum amount of RAM that
could be added, the number of PCI slots on the motherboard
and the number of ports (USB, serial) available in the system.
d) Package contents: Since the documentation and software bun-
dle play an important role in the overall value of a branded sys-
tem, we logged the inclusion or exclusion of components such
as the operating system installer CD or restore disk, the various
bundled software, driver CDs, manuals, setup guides, etc.

Performance: To determine the overall performance of the
PCs, we used a battery of software ranging from low-level tests
for the system’s subcomponents, to real world applications for
evaluating the performance of a machine in specific usage areas.

SiSoft Sandra 2002 SE was the main benchmarking tool for eval-
uating the system’s component-level performance. It examined
the performance of components such as the system processor, the
hard disk drive and CD/DVD drive (data transfer rates and access
times) and the RAM bandwidth. Virtual Dub was used to evaluate
DivX video encoding and Audio Catalyst for MP3 encoding. We
logged the time taken by the system to process a sample test file
in each of these cases. These tests determined the capability of the
computers in handling large amounts of streaming data. On the
gaming front, we used Quake III Arena version 1.31 and Evolva Scout
Bump Rolling demo for ascertaining the performance of a computer
under OpenGL and Direct3D, respectively. The final real world
test was related to image processing. Here, we ran a set of 21 fil-
ters in Photoshop 7 and logged the time taken to complete the
task. This test provided an insight into the performance of the
processor, RAM and hard disk.

We also tested a set of important subsystems in the computer
and the peripherals that came with it—RMAA was used to evalu-
ate the frequency response, Total Harmonic Distortion and noise
in the soundcard and Displaymate was used for evaluating the
sharpness and resolution of the monitor. The speakers were test-
ed for music and movie performance.  

A special score for each of the PCs, called the Suitability to Task
Index (STTI), was finally computed. This index was calculated
using a different set of weightages for each of the tests according

to the effect they would have on three prime application areas: pro-
ductivity, gaming and entertainment, and office and Internet
applications. This index provided a clear indication of the per-
formance of each PC in these application areas. For example, the
STTI for productivity was calculated by allotting a greater weigh-
tage to tests such as the Photoshop filter test than to the gaming
tests. Similarly, for gaming and entertainment, a greater impor-
tance was allotted to the Quake III and the speaker tests.

Value for money: This index was computed by evaluating the
system’s performance coupled with the features, in relation to the
price: the higher this index, the better a product scored.

Warranty and support: Here, we logged specifications such
as the type and duration of warranty offered by the manufac-
turer, the facility of an Annual Maintenance Contract (AMC),
presence of a call centre, the average time taken to attend to a
system problem and the number of service centres present in the
country. We also allotted extra points if the manufacturer offered
finance options for purchasing the computer.

How they Fared
Desktop computers used to be chunky devices that were purely
utilitarian. But PCs have now evolved to include high-speed
processors, faster and larger hard disks, cheaper and faster RAM
and supercharged 3D graphics accelerators—all this allows you
to use your PC not just for simple computing but also for enter-
tainment and for professional applications. Here’s how the PCs
in this comparison fared in terms of the features they offer and
their suitability to different application areas. 

A task as simple as playing an MP3 file requires the process -
ing power of at least a 133 MHz CPU in order to run smoothly.
A few years ago, we would have been shocked at a single enter-
tainment application taking up so much processing power. But
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Over 20 lakh PCs are sold in India in a year, a majority of them in
the metros. However, due to the general economic slow down,
the rate of sale is not as high as expected. Corporate customers,
who contribute to a majority of the sales, are resorting to either
upgrades or the assembled variety. Government purchases have
minimised to the extent that they are practically non-existent. The
SoHo and home segment accounts for a major sales chunk. The
local dealer market has been slowly regressing due to stiff compe-
tition from bigger brands and piracy is rampant with assemblers
relentlessly loading whichever operating system and application
software on their PCs. However, the recent efforts of organisations
such as NASSCOM have delivered very perceptible results in curb-
ing this trend.

MNC brands still command a higher market share than the
Indian ones, due to the various bundled applications and their
prompt service and quality assurance. This spells advantages, espe-
cially for those who place a high premium on quality and service.

The hot favourite MNC brands are Dell, which has excellent
upgradability options; Compaq, an eternal favourite with the
home segment; and IBM, which is doing well in the corporate
world with its PCs specifically tailored for business users.

However, several Indian vendors have developed their own
strategies to counter the foreign powers. Unlike last year, where
Indian brands were primarily large dealers with a national presence,
today after-sales support and service, licensed and free software and
peripheral bundles are given primacy by even the local vendors.

Bazaar Buzz

The Suitability to Task Index is an indication of the PC’s performance in
each of the three application areas they were tested in. Higher scores
indicate the PC being more suited to that particular application area
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today, an entry-level soundcard such as the Sound Blaster Live! 5.1
DE (available for under Rs 3,000) has the processing power of a 133
MHz Pentium processor and has full Dolby Digital support to
boot! A Pentium 4 at 1.8 GHz or an Athlon XP 1800+ processor is
now capable of handling tasks that would have required tens of
yesteryears’ computers to execute in the same amount of time.
This explosive advancement in hardware has naturally spawned
a whole new generation of usage patterns. Conversely, the usage
pattern itself determines the system configurations you need.

Features
One of the most appealing factors in a PC is the type and quality
of the components it features. We noted the specifications of the
processor, the amount and type of RAM, hard disk, motherboard,
etc. We also considered the ease with which a computer could be
upgraded and we evaluated the build quality of the system. 

System configuration: All the systems were either based on
SDRAM or DDR RAM platforms; we did not receive any RDRAM-
based systems. Also, seven of the 12 systems were based upon the
integrated graphics core of the 845G or 845GL Intel chipsets; we did
not receive any based on AMD processors. In terms of system spec-
ifications, the system that stood out from the others was the Visu-
alan Lavish. Its core components consisted of a 2.53 GHz Pentium
4 and a 40 GB 7,200-rpm Seagate Barracuda hard disk, with 256 MB
of DDR RAM. The video graphics system was also robust, with the
ATi Radeon 7500 driving a 17-inch LG Flatron monitor. The Visu-
alan Lavish was also the only system that featured a CD-RW drive
with a 32x write speed capability. To help alleviate the clutter on
your desktop, this system also featured a wireless mouse.

Another noteworthy PC was the HCL Beanstalk 4455. This
computer was based upon a 2.4 GHz Pentium 4 with 256 MB of
DDR RAM and featured an ASUS V8170 Magic graphics card with
64 MB of DDR video RAM. However, its high point was the two
40 GB 7,200-rpm Seagate Barracuda hard disk drives that were
configured in RAID-0 on the onboard Promise ATA/100 IDE RAID

In this comparison test, we tried our best to procure all
the branded computers available in the market. In
spite of our continued efforts, we missed out on
brands such as Dell, IBM and Acer. Each of them had
varied reasons for not being able to participate in this
comparison test, which we respected.

IBM was unable to participate in the test saying that they
were uncomfortable with a comparison test between the lead-
ing brands of the country. 

ACER readily agreed to send their systems of different con-
figurations, only if we carried individual reviews on each of
them and did not do a comparison test.

Dell could not participate because their PCs are built as per
customer-requests and only after confirmed orders would they
bring them from Singapore. This entire process would take
around a month or a little over. 

Minicomp stated logistic problems for the absence of their
PC in our comparison test.

The last brand was Cerebra—in spite of repeatedly calling
them, we were unable to elicit a suitable response. Hence, they
were omitted from the test.

Those who didn’t make it
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controller. This storage subsystem configuration resulted in
impressive data transfer rates in the performance benchmarks. It
also featured a 17-inch monitor and a 16x Pioneer DVD drive
that had a slot-in interface. The motherboard had a four-chan-
nel integrated sound chip, but the bundled speaker system was
a stereo set with a subwoofer—the only thing that stopped it
from being suitable as a home theatre system. With four USB 2.0
ports and one FireWire port, there are enough resources for con-
necting a host of external peripheral devices.

The Zenith Premium Corporate PC also featured a decent set
of specifications and came bundled in a small form factor tailored
for the corporate world. It featured a 2.4 GHz Pentium 4 proces-
sor on an 845G-based motherboard with 128 MB of DDR RAM
and a conventional 40 GB, 5,400-rpm Seagate hard disk. It also
housed two USB 2.0 compliant ports on its front panel.

The Visualan Celebrity and the Vintron Elixir 1000 appeared
on the lower end of the specifications spectrum—both these sys-
tems were based upon a 1.2 GHz Celeron (with the Tualatin core)

and ran on a dated Intel 810E-based
motherboard. These systems used
graphics and sound that were inte-
grated into the motherboard and fea-
tured 128 MB of SDRAM and
standard 15-inch monitors. Their
specifications were virtually identi-
cal, but the Vintron Elixir 1000 had
a 56K PCI modem.

Upgradability options: The Visu-
alan Wisdom and the Visualan Lavish
featured large and airy cabinets with
ample room for expansion. Their
motherboards had six PCI slots each,
out of which only one was used for a
PCI modem. In comparison, the HCL
Beanstalk 4455 and the Compaq Pre-
sario 3705AP featured only four and
two slots respectively.

Since most computers were based on the 845 family of
chipsets, they were able to support the
Socket 478 Pentium and the new
Celeron processors up to 2.6 GHz
speeds. However, the two systems that
were based upon the 810E chipsets
had an upgradability handicap—the
Visualan Celebrity and the Vintron

Elixir 1000 were
based upon the
older Socket 370
interface and the
highest they could
go was to P-III
Tualatin proces-
sors—they cannot
be upgraded to a
Pentium 4.

Some of the
Pentium 4 systems
here were based
upon SDRAM

memory, which proved to be the biggest bottleneck in the sys -
tems. These included the Vintron Elixir 1000 and 4000, the
QMAX Quadrant and the Visualan Celebrity and the Visualan
Wisdom. These systems cannot be upgraded to newer and faster
forms of memory such as DDR RAM or RDRAM. While SDRAM
is suited to non-demanding applications, it can quickly turn into
a bottleneck during more strenuous tasks. However, the Visualan
Wisdom, like the Qmax Quadrant and the Vintron Elixir 4000,
had three RAM slots allowing for a greater amount of RAM to be
installed as compared to the other SDRAM based systems. All the
DDR based systems had just two slots for RAM but since the den-
sity of DDR RAM is greater than that of SDRAM, these systems
could accommodate up to 3 GB of system memory.

Build quality: We evaluated the build quality of the PCs by
observing the overall construction of the systems and its details.

The HCL Beanstalk 4455
has nearly every port—
including FireWire!

The Visualan Wis-
dom (above) offers
plenty of room for
adding expansion
cards, unlike the
Compaq Presario
3705AP (right)

Apple has always been a trendsetter in the domain of industrial
design and it has outdone itself once again with the new iMac.
Sporting one of the most innovative computer designs in recent
years, the flat 15-inch TFT screen beams a crystal clear display even
when viewed from almost edge-on angles. This screen rests on a
chrome-plated steel rod that facilitates easy positioning of the
screen either horizontally or vertically. The small but powerful
Apple Pro speakers look similar to glass snooker balls and deliver a
surprising amount of acoustic punch. However, the high point of
the design lies in the semi-spherical base, which houses all the sys-
tem components. 

The iMac is powered by a 700 MHz Power PC G4 processor with
256 KB of L2 cache running at full speed, 256 MB of SDRAM that
can be upgraded to 1 GB, a 40 GB hard disk, a 12x8x32x CD-Writer
and an nVidia GeForce 2 MX graphics card. There is virtually every
type of connectivity option on the periphery of the base unit, includ-
ing FireWire, USB, speaker and headphone jacks, modem and Ether-
net ports and an extra VGA output to connect an additional monitor
for dual display. Adding to the ‘solid ice’ looks of the systems is the

operating system itself—it came loaded
with Mac OS X, which with its aqua
interface, gelled very well with the
squeaky clean appearance of the
machine. The OS incorporated iTune
for managing music files, which also
enables it to be coupled with Apple’s new
iPod MP3 player. With the brilliant
TFT display, QuickTime files
looked truly astounding and
this, when coupled with the
speakers’ sound quality, makes watching movies a great experience.
The system also included Microsoft Office X along with other good-
ies such as Roxio Toast 5, Titanium iMovie and VCD creator, which
makes it fun and easy to share your experiences with family and
friends. Due to its aesthetic appeal and flaunt value, this machine will
easily find a place on the desk of top executives and afficionados.

iMac, Refreshed

Price: Rs 1,20,700; Contact: Apple Computers Intl Pvt Ltd;
E-mail: indiainfo@asia.apple.com; Phone: 080-555057
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In terms of system design and construction, the Compaq Pre -
sario 3705AP turned out to be the sturdiest. This system had a
tool-free casing where thumbscrews were used to make it easy to
open the system for troubleshooting or upgrading. It came in
classic black and had two USB ports on the front panel to attach
USB peripherals conveniently. Another system that had two USB
ports on the front panel was the Dart Emerald.

While the Visualan Lavish sported a very large cabinet, its
cables were not organised or tied together. Nor did it have any
labelled ports on the back panel to indicate which peripheral
goes where—a detail that is useful to novices. Interestingly, this
system had provision for two USB ports on the front panel of
the cabinet, but not the ports themselves. The Visualan Wisdom
too had a similar type of cabinet, while the PCS Oriion came
without labelled ports or organised cables.

As for the HCL systems, the Beanstalk 4455 featured a very
roomy cabinet with adequate airflow. Since the Pioneer 16x DVD
drive in this system featured a slot-in disk interface, it is not sus-
ceptible to damage like other tray-based CD or DVD drives. The
HCL Beanstalk 4458, however, featured a smaller cabinet with
unorganised cables. However, this system had two USB ports on
the front of the cabinet and a keyboard that included virtually

HCL Beanstalk 4455

Powered by a Pentium 4 running at 2.4 GHz, the Beanstalk
4455 has great features for technology enthusiasts, at a

reasonable price. The
processor sits on an
Intel motherboard

based on the
D845 chipset and
a 533 MHz FSB
(front side bus),

giving you
extreme power to tackle

intensive tasks such as editing movies in real-time. The 256
MB DDR-RAM allows for a snappy system response and makes
the resource-hungry Windows XP work very smoothly.

The system comes with a 4x AGP slot on which sits an
ASUS V8170 Magic (64 MB DDR) graphics card, which pro-
vided decent gaming performance. The 16x DVD drive with
a slot interface eliminates the tray-jamming problem faced in
most DVD drives. Audio is handled by the onboard sound-
card coupled with a powerful 30 watt 2.1 speaker system from
Altec Lansing. The system provides users with four free PCI
slots, six USB ports and a FireWire port (IEEE 1394) that offers
blazing transfer rates for the external peripherals. An onboard
10/100 Mbps LAN card is also included. 

The machine implements the storage subsystem using IDE
RAID-0, which delivers substantially higher performance
than a single hard disk.

On the software front, it comes with XP Plus for Windows
XP, Norton AntiVirus 2002, Microsoft Encarta Encyclopedia,
School Whiz and Multilingual software. Sporting very pow-

erful core components at Rs 59,990,
this computer is suited to both,
work and play.

Suitability to Task Index
Gaming 6.03
Productivity 7.37
Office apps/Internet 6.24
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every type of control in the form of
extra shortcut buttons, ranging from
audio controls to Web surfing and
page navigation controls. 

Package contents: Finally,
we evaluated the software,
the documentation and the
manuals that accompanied
the system. Here, the Vintron

systems stood out—they included Norton AntiVirus 2000 6.0,
McAfee 5.0, Satyam 100-hour Internet Pack, Eudora 5.1, Pega-
sus Mail 3.1, and trial versions of Front Page 98 and
Dreamweaver 4. Also included were utilities such as Winamp
2.7 and Real Player 8. The Visualan Wisdom, with its ATi Rage
Pro 128 graphics card, brought along PowerDVD 3.0 and 4x4
Evolution, a racing game. The Compaq Presario 3705AP also
included a good set of software: Norton 2002, Money 2002,
Encarta Encyclopedia 2002, Norton Security 2002, Microsoft
Works 6.0 along with a 30-hour Satyam Internet package. It
also had Windows XP Home Edition loaded and the appropri -
ate CD was also provided.

The Dart Emerald also had a good set of bundled goodies,
which included an HCL InfiNet 45-day Internet pack, Simon &
Schuster Millennium Encyclopedia, four games (Odium, Septerra
Core, Claw and Shogo) along with three other entertainment and
multimedia CDs. It also had a recovery CD to restore the OS to
its factory condition.

Both the HCL machines came loaded with Windows XP Home
Edition and the Plus! Pack loaded; they too had CDs to restore

the operating system to the original factory condition. The only
two computers that were loaded with Windows XP Professional
were the PCS Oriion and the Zenith Premium Corporate PC. The
PCS Oriion bundled Britannica Encyclopedia with a CD of utili-
ties, one for teaching Internet basics and Web design and one
with an assortment of MP3 songs. The Zenith Premium Corpo-
rate PC bundled Norton Internet Security Software, Norton

AntiVirus 2002 (three months of free
virus update subscription) and NTI
CD Maker along with a few freeware
utilities.

The only system that came
loaded with Windows 98 SE was the
Visualan Celebrity. It included soft-
ware such as CD Ghost, Genesys,
Language Genius, Media Ring Talk,
PC-Cillin Antivirus, PC DJ, Recovery
Genius and Super Voice along with a
few freeware utilities. A system that
really skimped on software was the
QMAX Quadrant. It included only a

100-hour Satyam Internet package along with the Windows XP
Home Edition CD. 

All the computers we received had driver CDs and contained
the manuals and documentation that explained the functioning
of the system and how to set it up. 

Performance tests
Performance was evaluated using an assortment of real world
and synthetic applications. To help evaluate the suitability of the
various systems to specific application areas, we also created Suit-
ability To Task Indexes for measuring their performance in three
target application areas—gaming and entertainment, productiv-
ity, and office and Internet applications. This was done by allot-
ing varying weightages to each benchmark depending on the
application area.

Gaming and entertainment: Here, we specifically observed
the performance of the computers in the gaming, monitor per-
formance, audio encoding, speakers, CD-ROM and soundcard tests . 

The computer
that excelled in this
application area was
the Visualan Lavish.
With its ATi Radeon
7500 graphics card, a
fast 2.53 GHz Pen-
tium 4 processor, 256 MB of DDR memory and a 40 GB, 7,200-
rpm Seagate Barracuda hard disk, the PC excelled in gaming and
applications involving work with audio and video. In the gaming
tests, it pumped out a commendable 74 fps when running the
Quake III test at a resolution of 1024x768 and in the Evolva test,
it churned out 50.5 fps.

It delivered a best-of-class score in raw processing, thanks to its
2.53 GHz Pentium 4 processor. Similarly, it performed well in the
hard disk and the memory tests due to the fast 7,200-rpm hard disk
and DDR RAM, logging 41 MBps in the sequential read/write tests
for the hard disk and a shade over 2 GBps in the memory band-
width tests. When it came to the peripherals, the 17-inch LG Fla-
tron monitor returned good clarity and colour reproduction, and
the 2.1 speakers performed adequately during the audio tests. The

HCL Beanstalk 4458

This black beauty from HCL boasts a good configuration
with a very appealing design. A 2 GHz Pentium 4 proces-

sor on an Intel 845GL motherboard defines new highs in
multimedia entertainment and learning. It comes with a 17-

inch flat monitor
and a powerful

Altec Lansing 2.1
speaker system.

The 128 MB
of DDR RAM and

onboard graphics
ensure reasonably smooth 3D gaming and movies, and the 40
GB hard disk suits most general applications that do not need
excessive storage. The appeal of this system lies in the optical
mouse and the functional keyboard that boasts of an assort-
ment of shortcut keys for everything from editing text, to
browser control and quick access to your media files. On the
expansion front, it can support up to 6 GB of memory but has
only two free PCI slots. With four USB ports, you can easily
connect devices such as a Web camera, scanner, printer, etc.

This computer represents a good out-of-the-box experi-
ence for customers. It comes bundled with XP Plus for Win-

dows and a host of other system
applications and utilities—all at a
price of Rs 48,990.

The HCL Beanstalk 4458’s keyboard
offers several shortcut buttons

Suitability to Task Index
Gaming 6.32
Productivity 6.49
Office apps/Internet 6.25

The Zenith PC has two USB
ports on the front panel



cordless mouse was very smooth and well suited for the accuracy
needed in Quake III Arena rail-gun matches! Since it has a CD-RW
drive too, you can easily copy your home videos onto VCDs and
archive your bank of DivX movies and other files. This drive logged
a commendable score of 3.48 MBps in the sequential read test. 

The Visualan Lavish was rivalled by the HCL Beanstalk 4455
in the gaming and entertainment tests. This PC was armed
with a powerful configuration of 2.4 GHz Pentium 4 processor,
256 MB of DDR RAM and the piece de resistance—the two 40 GB
7,200-rpm Seagate Barracuda hard disk drives configured in
RAID-0. This method of implementing hard disk storage
enabled it to achieve a sequential read/write data transfer rate
of 43 MBps and 40 MBps, respectively. The graphics subsys-
tem was also very robust with the ASUS V8170 graphics card
coupled with a 17-inch monitor, but a faster graphics card
would have done this system much good in the gaming arena.
For gamers who like to hear the resonance of rockets explod-
ing around them, the 2.1 Altec Lansing speakers did a good job
of delivering the audio experience. 

Finally, movie buffs will be delighted with the 16x Pioneer
slot-in DVD drive. The drive did especially well in the tests,
where it logged a data transfer rate of over 3 MBps in the
sequential read test. The four USB ports make enough space for

the gaming periph-
erals you may want
to upgrade to. 

The HCL
Beanstalk 4458 also
delivered reasonably
good performance
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QMAX Quadrant

Though the 1.7 GHz is not a top-of-the-class PC, it hous-
es sufficient power to see you through most applications.

The 32 MB AGP card delivers playable frame rates for your 3D
games, while the 128 MB of SDRAM gives you a more afford-
able upgrade path if you do not need too much power. With

support for 3 GB RAM and
two free PCI slots, you
have reasonable expan-
sion capability. It comes

with a 15-inch moni-
tor that goes up to a
resolution of
1024x768 at an 85
Hz refresh rate. The

system provides all basic level
components that a user would expect such as a PS/2 key-
board, mouse, a 52x CD-ROM drive and two channel audio
support. It also has a reasonably powerful stereo speaker sys-
tem. Completing the package is a 56K PCI modem. 

The system is lacking on the software front—it bundles
just the operating system (Windows XP Home Edition) and

a 100-hour Satyam Internet pack.
However, with a price tag of 
Rs 39,000, it’s a decent choice  for
those on a budget. 

Suitability to Task Index
Gaming 3.91
Productivity 5.72
Office apps/Internet 5.29



with its 2 GHz Pentium 4 processor, but featured a standard 40 GB
5,400-rpm Seagate hard disk drive coupled with 128 MB of DDR
RAM and the integrated graphics of the 845G chipset. It scored rea-
sonably well in the SiSoft Sandra tests and the inclusion of the 2.1
Altec Lansing speakers with this system enabled it to do well in the
audio tests.

Understandably, the computers that fell below par in this
subtest were the ones based on the Celeron/Intel 810 combina-
tion—the Vintron Elixir 1000 and the Visualan Celebrity. Since
they featured slower processors and integrated graphics systems
that used shared memory, their performance in the gaming 
and the low-level subsystem tests were among the lowest in 
this category.

Productivity: For this application area, we looked at the com-
puter’s performance in running tasks such as office applications,
image editing, video encoding, etc. Therefore, we observed the
performance of the computer’s processor, hard disk and memo-
ry along with real world applications such as Photoshop, Virtu-
al Dub video encoding and the performance of subsystems such
as the monitor, CD-ROM drive and soundcard. 

Once again, the computer that came out tops was the Visu-
alan Lavish. The components that were responsible for its suc-
cess were the 2.53 GHz Pentium 4 processor, 256 MB of DDR
RAM and the fast hard disk drive. This was clearly seen in the
Photoshop test where it crunched through the set of 21 filters in
just 14.5 seconds. Also, since Photoshop 7.0 had special support
for the Pentium 4’s SSE2 instruction set, the performance of the
computer in this application was unsurpassed. Even in the video
encoding tests, the Visualan Lavish delivered stellar scores by
processing the test video file in just 1 minute 3 seconds. The 17-
inch monitor was
clear and sharp and
quite suited to mul-
timedia applications
that require atten-
tion to detail. The
accompanying CD-
RW drive burned a complete 650 MB CD in a span of just 3 min-
utes 18 seconds. All this makes the Visualan Lavish suited to
authoring multimedia titles for distribution, image editing and
video processing.

Next up, the HCL Beanstalk 4455 did very well in the proces-
sor, memory and especially the hard disk subsystem tests. The
memory bandwidth
of its 256 MB of
DDR RAM was
logged at a shade
under 2 GBps, mak-
ing it well-suited to
applications such as
image and video editing where large files are stored and worked
upon in RAM. With its RAID-0 implementation of the two 40 GB
Seagate Barracuda hard disks, the system delivers brilliant 
data transfer performance, especially in the sequential read and
write tests (43 MBps and 40 MBps, respectively). This implied
that it is a good choice for applications such as audio and video
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Dart Emerald

The Dart Emerald sports a 2 GHz Pentium 4 processor
combined with an Intel 845GL-based motherboard. It

comes with a 40 GB Samsung IDE hard disk and 256 MB of
DDR RAM, a part of which is used by the onboard Intel
Extreme graphics. There is no AGP port provided on the
motherboard and therefore, there is no room for enhancing

the system’s graphics performance.
The onboard SigmaTEL inte-

grated chipset sings
to you through the
2.1 speakers and the
AT keyboard comes
with a PS/2 convert-
er and features very
good tactile

response, sans any shortcut keys.
One area where the Dart Emerald makes a mark is in the
package contents. It provides you with a number of educa-
tional, game and multimedia titles. Also provided are all the
necessary driver CDs, along with Windows XP Home Edi-

tion. The Dart Emerald is sold
with a three-year onsite warranty.
At Rs 40,000, it’s quite suitable for
home users. 

Since computers comprise an assortment of delicate components,
regular cleaning and maintenance is necessary to ensure your sys-
tem’s long life. The following are the main areas you should con-
centrate on for keeping your PC in optimum shape:
■ You hard disk is most susceptible to wear and tear and one of
the best ways to maintain it is to nip any problems in the bud.
Regular system scans will ascertain that the file system is in
good condition and will take care of the minor problems that
may arise as a result of crashed programs and hard reboots. To
ensure that the space on your hard disk is well utilised, you
should defragment it regularly. This arranges the files in con-
tiguous clusters, thus improving performance and freeing up
wasted space.
■ Hardware manufacturers usually have product Web sites that

offer regular driver updates that improve performance or
iron out hardware compatibility issues and bugs. Update
your drivers frequently for a smooth-running system. The
same logic extends to patches for software applications
such as your operating system, office suites and anti-virus pack-
ages. As a precaution, verify that you load the updates and drivers
specific to your operating system.
■ Don’t forget to keep your system clean and free from dust. While
not perceived as an immediate threat, dirt and dust are silent agents
that cause serious problems down the line. They affect the moving
components in your system: from the keyboard keys, to the more crit-
ical components such as the fans cooling your system. Covering and
cleaning your computer will help ensure that these critical system
components do not fail due to a buildup of dust.

…to Keep the Doctor Away

Suitability to Task Index
Gaming 5.58
Productivity 6.93
Office apps/Internet 5.06



authoring where
h i g h - v o l u m e
sequential data is
worked upon in the
form of audio and
video streams.

Also delivering
good performance in this application area was the Dart Emer-
ald, featuring a 2 GHz Pentium 4 processor with 256 MB of DDR
RAM. Since the PC was well geared with a powerful processor
and RAM, even with onboard graphics, it managed a very
impressive score in the Photoshop test, where it sped through
the 21 test filters in just 16 seconds. The 17-inch flat screen
monitor produced crisp and vivid images even at high resolu-
tions and refresh rates, making it suited to serious multimedia
and productivity applications. In the video encoding tests, the
powerful processor enabled it to process the test video file in just
1 minute 15 seconds.

Office and Internet: In this application area, we evaluated the
performance of the computers in relatively non-taxing applica-
tions such as office suites and Internet browsing. The specific sub-
system that decided the performance of the computer here was the
processor, the RAM, the hard disk, the CD-ROM drive, monitor
and also the speaker and soundcard. Therefore, a higher weightage
was given to the SiSoft Sandra subsystem tests, monitor, CD-ROM,
the soundcard and the speaker tests. In fact, if you are looking for
a computer that is suited to simple office applications, you need
to just look at the processor, RAM and hard disk.
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Compaq Presario 3705AP

This good-looking computer comprises a 1.7 GHz Pen-
tium 4 processor, 128 MB of DDR RAM, a Maxtor 40 GB

hard disk and a very clear and sharp 15-inch monitor.
Another very good addition is the JBL Platinum Series
speakers that render pleasant sound quality. The chic black

colour and the overall design aesthetics make the
system stand out in a crowd. The cabi -

net features a tool-free con-
struction and provides two
USB ports on the front panel
with audio connections for
the mic and headphones.

The Compaq Presario 3705AP
also bundles a 10/100 base

Ethernet card and a Conexant 56K PCI
modem. An AGP port is provided so that the

graphics subsystem can be enhanced with a faster graph-
ics card. On the software front, it comes preloaded with
Windows XP Home Edition and the necessary driver CDs
are also provided along with a recovery CD. The package
includes a host of anti-virus, multimedia and educational
applications. This was one of the few brands that offered

telephonic support and at Rs
50,363 is a good choice for users
who like appealing looks and
upgradability.

Suitability to Task Index
Gaming 5.64
Productivity 6.15
Office apps/Internet 6.14

➜



Features
System Configuration
CPU (Manufacturer/Clock Speed)

Hard Disk Drive (Brand, Size, rpm)

Memory (Amount, Type)
Graphics (Name, RAM)

Motherboard
Chipset
Slots (PCI, Memory, AGP)
Ports

Onboard
Graphics

Sound

LAN
USB 2.0 (number of ports)

Peripheral Subsystem
Keyboard (Keys, Interface)
Mouse (Interface, Technology)
Monitor (Brand, Size, Resolution)

Optical Drive (Speed, Type)
Soundcard (Name, No. of Channels)
Speakers (Brand, Power Output, 
No. of Channels)
Modem (Name, Speed, Type)

Extra Peripherals (Printer, Scanner,
Web cam, UPS, Spike Buster, 
Headphone/Mic)
Upgradability
CPU
Memory
PCI Slots
Package Contents
Operating System

Recovery CD
Driver CDs
Manuals & Setup Instructions
Bundled Software

Performance
Subsystem (out of 10)
Processor (SiSoft)
Hard Disk Drive (SiSoft)
Memory (SiSoft)
CD-ROM / CD-RW / DVD (SiSoft)
Monitor (Displaymate)
Soundcard (RMAA)
Audio Encoding (seconds)
Video Encoding (seconds)
Photoshop 7 Test (seconds)
Gaming
Quake III Arena 1.31 Demo -
1024x768x32 (fps)
Evolva Bump Rolling Demo (fps)
Suitablity to Gaming (out of 10)
Suitablity to Productivity (out of 10)
Suitability to Office apps (out of 10)
Warranty and Support
Warranty (in years)
Number of Service Centres
Annual Maintenance Contract (Y/N)
Telephonic Customer Support
Overall Score
Features (30%)
Performance (40%)
Warranty and Support (10%)
Value for Money (20%)
Overall Product Rating
Overall Grade
Vendor Name

Phone
E-mail
Price (In Rupees)

Compaq Presario
3705AP

Intel P4 @ 1.7 GHz

Maxtor 40 GB, 5,400-rpm

128 MB, DDR
Integrated

Intel 845G
3, 2, AGP 4x
1 Parallel, 2 Serial, 
3 USB 1.1

Intel Extreme, shared
memory
SigmaTEL 
C-Major
Intel Pro 100
✔ (1)

PS/2
PS/2, Ball
Compaq 5500, 15-inch,
1024x768 @ 60 Hz
52x CD-ROM drive
Integrated
JBL Platinum Series, 6 watts
(total), 2 
Conexant HSF V92, 56K,
PCI
✖

2.4 GHz and above
2 GB
2 vacant

Windows XP Home

✔
✔
✔
Norton 2002, Money
2002, Encarta Encyclopedia
2002, Norton Security
2002, Microcosft Works
6.0, Satyam 30-hour
Internet package

5.97
4.55
8.50
5.78
6.80
4.67
29
95
21.86

10.4

68.6
5.64
6.15
6.14

1*
1000
✔
✔

19.56
24.51
8.83
13.46
66.36

AVI Electronics

022-6465522
aviteam@vsnl.com
50,363

Dart Emerald

Intel P4 @ 2 GHz

Samsung 40 GB, 
5,400-rpm
256 MB, DDR
Integrated

Intel 845GL
4, 2, ✖
1 Parallel, 2 Serial, 
3 USB 1.1

Intel Extreme, shared
memory
SigmaTEL

✖
✔ (1)

AT with PS/2 Convertor
PS/2, Ball
Dart Flatvision 43F1,17-
inch, 1280x1024 @ 60 Hz  
52x CD-ROM drive
Integrated
MS-431, 800 watts PMPO,
2.1
D-Link, 56K, PCI

Headset

2.6 GHz or more
3 GB
3 vacant

Windows XP Home

✖
✔
✔
HCL InfiNet 45-day pack,
Simon & Schuster
Millennium Encylopedia,
Odium, Septerra Core,
Claw, Shogo games, The
complete family CD,
Entertainment Mania and
The Road to Freedom
Multimedia CD

6.97
4.46
8.74
0.53
4.6
8.33
23
75
16

19.5

80
5.58
6.93
5.06

3*
275
✔
✖

19.24
25.89
6.76
17.36
69.25

Dart Computers Pvt Ltd

07104-32565
rohit@dartcomputers.com
40,000

HCL Beanstalk 4458

Intel P4 @ 2 GHz

Samsung 40 GB, 
5,400-rpm
128 MB, DDR
Integrated

Intel 845G
3, 2, ✖
1 Parallel, 2 Serial, 
3 USB 1.1

Intel Extreme, shared
memory
Avanche

✖
✔ (1)

PS/2
USB, Optical
HCL HCM 770FH,17-inch,
1280x1024 @ 60 Hz  
52x CD-ROM drive
Integrated
Altec Lansing, 30 watts, 2.1

Conexant HSF, 56K, PCI

Headset

2 GHz or more
6 GB
2 vacant

Windows XP Home 
(with Plus!)
✔
✔
✔
Norton AntiVirus 2002,
Encarta Encyclopedia (Std),
HCL School Wiz, ValueFon
Dialer, Ankur Software,
HCL Expert Utility, HCL
Asset Tracker, HCL InfiNet
12-month pack

7.05
4.99
8.59
5.03
5.4
8.83
25
80
22.83

10.4

85.8
6.32
6.49
6.25

1*
500
✔
✖

19.72
27.65
6.18
14.87
68.42

HCL Infosystems

0120-4520977
response@hclinsys.com
48,990

HCL Beanstalk 4455

Intel P4 @ 2.4 GHz

Seagate  2x40 GB, 
7,200-rpm
256 MB, DDR
ASUS V8170 Magic, 
64 MB DDR

Intel D845 
5, 2, AGP 4x
1 Parallel, 2 Serial, 
2 USB 1.1 + 1 FireWire

✖

SoundMAX

Intel Pro 100
✔ (4)

PS/2
USB, Optical
HCL HCM 770FH,17-inch,
1280x1024 @ 60 Hz  
Pioneer 16x DVD drive
Integrated
Altec Lansing, 30 watts, 2.1

Conexant HSF, 56K, PCI

Headset

3.06 GHz or more
3 GB
4 vacant

Windows XP Home 
(with Plus!)
✔
✔
✔
Norton AntiVirus 2002,
Encarta Encyclopedia (Std),
HCL School Wiz, ValueFon
Dialer, Ankur Software,
HCL Expert Utility, HCL
Asset Tracker

8.21
5.61
9.46
4.54
5.4
1.88
18
66
17.4

67.9

32.6
6.03
7.37
6.24

1*
500
✔
✖

24.80
27.77
6.18
13.48
72.23

HCL Infosystems

0120-4520977
response@hclinsys.com
59,990

PCS Oriion

Intel P4 @ 1.7 GHz

Seagate 40 GB, 
5,400-rpm
256 MB, DDR
Integrated

Intel 845GL
3, 2, NA
1 Parallel, 2 Serial, 
3 USB 1.1

Intel Extreme, shared 
memory
Avance Logic

Realtek RTL 8139
✔ (1)

PS/2
PS/2, Optical
PCS 38F1, 15-inch,
1024x768 @ 85 Hz
52x CD-ROM drive
Integrated
PCS, NA, 2

✖

Headset

1.7 GHz and above
6 GB
3 vacant

Windows XP Professional

✖
✔
✔
Britannica, 25-Software
Mega CD, New Hits
(songs), Millennium Games
Vol-3, Internet Basics, Web
design and authoring tools

6.03
4.15
8.02
4.55
5.2
Failed
30
92
21.1

17.6

74.7
4.44
5.43
4.97

1*
200
✔
✖

19.08
19.63
4.59
15.45
58.75

PCS Industries Ltd

022-8503721
enquiry@pcsil.com
38,550

CATEGORY

Disclaimer: All prices are subject to variation, *On-site Warranty, ** Carry-in Warranty, ^ DirectX not loaded, ^^ On-site within city limits



QMAX Quadrant

Intel P4 @ 1.7 GHz

Seagate 40 GB, 
5,400-rpm
128 MB, SDRAM
SiS 300, 32 MB, 
SDRAM

Intel 845
3, 3, AGP 4x
1 Parallel, 2 Serial, 
2 USB 1.1

✖

Intel Integated Audio

✖
✖

PS/2
PS/2, Ball
Microtek 38F1C, 15-
inch, 1024x768 @ 85 Hz
52x CD-ROM drive
Integrated
Microtek Josh, 820
watts PMPO, 2
HSP 56, 56K, PCI

✖

2.4 GHz
3 GB
2 vacant

Windows XP Home with
media
✖
✔
✔
Satyam 100-hour
Internet package

5.89
4.49
4.66
4.50
5.2
2.61
28
106
20.33

31.4

12.9
3.91
5.72
5.29

1**
100
✔
✖

19.08
19.22
6.71
15.11
60.12

Nebula Technologies
Pvt Ltd
022-6730567
pratik@nebulatech.com
39,000

Vintron Elixir 1000

Intel Celeron @ 1.2 GHz
(Tualatin)
Seagate 40 GB, 
5,400-rpm
128 MB, SDRAM
Integrated

Intel 810E
3, 2, None
1 Parallel, 2 Serial,
No USB

Intel 810, shared
memory
Avance Logic

✖
✖

AT
PS/2, Ball
Vintron, 15-inch, 
1024x768 @ 60 Hz
52x CD-ROM drive
Integrated
Vintron, 720 watts
PMPO, 2
NA, 56K, PCI

✖

1.5 GHz or more
1 GB
2 vacant

Windows 98 SE (provid -
ed only if you specify)
✖
✔
✔
Norton AntiVirus 2000,
McAfee 5.0, Satyam
100-hour Internet Pack,
Eudora 5.1, Pegasus
Mail 3.1, Front Page 98
trial, Dreamweaver 4
trial, Winamp 2.7, Real
Player 8

5.47
4.33
2.67
5.08
5
5.88
26
195
20.33

15.3

14.4
4.29
5.27
4.62

1^^
300
✔
✖

11.45
20.10
5.12
17.88
54.56

Vintron Informatics Ltd

011-6810815
corporate@vintron.co.in
27,145

Vintron Elixir 4000

Intel P4 @ 2 GHz

Seagate 40 GB, 
5,400-rpm
128 MB, SDRAM
SiS 300, 32 MB 
SDRAM

Intel 845
3, 3, AGP 4x
1 Parallel, 2 Serial, 
2 USB 1.1

✖

Intel Integrated Audio

✖
✖

PS/2
PS/2, Ball
Vintron, 15-inch,
1024x768 @ 60 Hz
52x CD-ROM drive
Integrated
Vintron, 720 watts
PMPO, 2
D-Link, 56K, PCI

✖

2.4 GHz and above
3 GB
2 vacant

Windows XP Home (pro-
vided only if you specify)
✖
✔
✔
Norton AntiVirus 2000,
Mcafee 5.0, Satyam 100
Hour Internet Pack,
Eudora 5.1, Pegasus
Mail 3.1, Front Page 98
trial, Dreamweaver 4
trial, Winamp 2.7, Real
Player 8

7.00
4.01
4.71
4.37
5
4.34
25
100
22.5

8.4

Failed
3.89
5.69
4.95

1^^
300
✔
✖

13.67
19.92
5.12
13.10
51.81

Vintron Informatics Ltd

011-6810815
corporate@vintron.co.in
39,445

Visualan Wisdom

Intel P4 @ 1.6 GHz

Seagate 40 GB, 
5,400-rpm
256 MB, SDRAM
ATi Rage Pro 128, 
32 MB SDRAM

Intel 845D
6, 3, AGP 4x
1 Parallel, 2 Serial,
No USB

✖

Intel Integrated Audio

✖
✖

PS/2
PS/2, Optical
LG Studioworks 563A,15-
inch, 1024x768 @ 75 Hz
52x CD-ROM drive
Integrated
Mercury SW880, 880
watts PMPO, 2 
Motorola SM 56, 56K, PCI

Headset

2.4 GHz and above
768 MB
5 vacant

Windows XP Home with
media
✖
✔
✔
Norton AntiVirus and
Firewall, Adobe Acrobat
Reader, Intel LDCM,
Utiltiy Management
Tool, Easy Tune,
PowerDVD 3, 4x4
Evolution

5.28
4.71
4.68
4.66
5.2
5.91
30
108
23.26

8.3

Failed
4.03
5.54
5.00

1*
9
✔
✖

18.76
20.07
3.58
17.70
60.11

Visualan Technologies

022-7686817
sales@visualanindia.com
33,750

Visualan Celebrity

Intel Celeron @ 1.2 GHz
(Tualatin)
Seagate 40 GB, 
5,400-rpm
128 MB, SDRAM
Integrated

Intel 810E
3, 2, None
1 Parallel, 2 Serial,
No USB

Intel 810, shared
memory
Avance Logic

✖
✖

AT
PS/2, Ball
LG Studioworks 563A,15-
inch, 1024x768 @ 75 Hz
52x CD-ROM drive
Integrated
Mercury MS440, 440
watts PMPO, 2
✖

Headset

1.2 GHz or more
512 MB
3 vacant

Windows 98 SE with CD
and boot disk
✔
✔
✔
3Deep, Adobe Acrobat
Reader, CD Ghost,
Genesys, Language
Genius, Media Ring
Talk, PC-Cillin Antivirus,
PC DJ, Recovery Genius,
Super Voice

5.47
4.81
2.81
6.38
5.2
4.16
27
173
24.83

13.2

Failed^
3.97
4.98
4.92

1*
9
✔
✖

12.40
18.92
3.58
18.71
53.61

Visualan Technologies

022-7686817
sales@visualanindia.com
25,750

Visualan Lavish

Intel P4 @ 2.53 GHz

Seagate 40 GB, 
7,200-rpm
256 MB, DDR
ATi Radeon 7500, 
64 MB DDR

Intel 845G
6, 2, AGP 4x
1 Parallel, 2 Serial, 
3 USB 1.1

Intel Extreme, shared
memory
SoundMAX

Intel Pro 100
✔ (1)

PS/2
PS/2, Cordless ball
LG Flatron E700S, 17”,
1280x1024 @ 60 Hz 
32x CD-RW drive
Integrated
Mercury SW 980, 
36 watts, 2.1 
Motorola SM 56, 56K,
PCI
Headset

2.53 GHz and above
3 GB
5 vacant

Windows XP Home with
media
✖
✔
✔
Motocross Mania, 4x4
Evolution, Serious Sam,
Heavy Metal FAKK2,
Rune games, Nero 9.0,
PowerDVD 4.0, Blank
CD-RW

8.90
6.12
9.75
6.75
5.6
4.88
17
63
14.5

74.1

50.5
7.17
8.32
7.13

1*
9
✔
✖

23.69
32.51
3.58
11.68
71.46

Visualan Technologies

022-7686817
sales@visualanindia.com
74,000

Zenith Premium
Corporate PC

Intel P4 @ 2.4 GHz

Samsung 40 GB, 
5,400-rpm
128 MB, DDR
Integrated

Intel 845G
3, 2, AGP 4x
1 Parallel, 2 Serial, 
4 USB 1.1

Intel Extreme, shared
memory
SoundMAX

Intel Pro 100
✔ (2)

USB
USB, Ball
Zenith, 15-inch,  
1152x864 @ 60 Hz
52x CD-ROM drive
Integrated
Zenith, NA, 2

✖

✖

3.04 GHz and more
3 GB
3 vacant

Windows XP Professional

✖
✔
✔
Norton Internet Security
Software, Norton
AntiVirus 2002 (3
months), NTI CD Maker,
Intel Active Monitor,
Real Player 8.0 with
Jukebox 2

6.13
2.32
7.87
4.71
5
5.80
62
172
30.56

10.5

57
4.63
4.71
5.16

1*
130
✔
✔

20.35
20.06
6.87
12.51
59.79

Zenith Computers Ltd.

022-8377300 

48,925



Once again, the computer that excelled was the Visualan
Lavish. The two HCL computers competed closely in this cate-
gory, leading to some very interesting observations. Even
though both computers have different specifications, they were
equally suited to office suites and Net surfing, as the relevant
subsystems that were affected by the tests for this application
had nearly similar specifications. Both these systems were based
on the Pentium 4 processor with DDR memory, both had a 

17-inch monitor
with integrated
audio. Yet the dif-
ferences between
the Beanstalk 4455
and the Beanstalk
4458 were numer-

ous: the former had a RAID-0 array of 7,200-rpm hard disk
drives, while the latter had a simple 5,400-rpm drive. The
Beanstalk 4455 had 256 MB of DDR RAM while the 4458 had
just 128 MB and even though there was an ASUS V8170 Magic
graphics card in the Beanstalk 4455, this made minimal differ-
ence in office applications and surfing. Another difference was
in the optical drives used—the Beanstalk 4458 had a simple 52x
CD-ROM drive, while the Beanstalk 4455 featured a 16x Pioneer
DVD drive. The CD-ROM of the Beanstalk 4458 featured a
sequential read rate of 2.86 Mbps, while the Beanstalk 4455’s

DVD drive featured a transfer rate of slightly over 3 MBps. The
sound system of the Beanstalk 4458 delivered a very com -
mendable score of 8.83 out of 10, but the Beanstalk 4455 fell
significantly under
par, managing a
score of just 1.88.

Armed with the
Pentium 4/DDR
combination, the
Compaq Presario
3705AP proved to
be a good performer
for office applica -
tions. Despite the
fact that it had only
a 15-inch monitor,
the display was
sharp and clear. Its
processor enabled
this computer to
perform well in the
SiSoft Sandra sub-
test. Its DDR memory also managed a good data transfer rate of
1.7 GBps; particularly impressive was its CD-ROM drive, which
managed a sequential read rate of 3.96 MBps, making it the
fastest in this comparison. 

Warranty and support
In evaluating the warranty and support of the computers, the
brand that stood head and shoulders above the others was Com-
paq. With over 1,000 service centres across the country, there is
ample support for this computer when you need it. It is also the
only brand to offer telephonic customer support and a one-year
onsite warranty on the Presario 3705AP. 

Coming in a close second was HCL, with 500 service cen-
tres spread across the country. It too offeres a one-year onsite
warranty. Vintron’s service network is spread across 300 serv-
ice centres across the country and it specifies an onsite war-
ranty on its computers only within city limits. Dart’s service
network is spread across 275 service centres across the coun-
try and it offers a very impressive three-year onsite warranty.
QMAX specifies a one-year carry-in warranty and has 100 serv-
ice centres across the country. The only disappointing brand
in terms of service network support was Visualan—it has only
nine service centres in India, but does offer a one-year war-
ranty. All the brands had the provision of an AMC after the
warranty period.
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You need

Look for

The models

Price range

Gaming and Entertainment
To play the latest games such as Quake III
Arena and Unreal Tournament 2003 at the
maximum settings and with all the effects
turned on
At least a 2 GHz processor, 256 MB of DDR
RAM, a 40 GB, 7,200-rpm hard disk, a 17-
inch flat monitor, 2.1 speakers and at least a
16x DVD-ROM drive
Visualan Lavish, HCL Beanstalk 4455, Dart
Emerald
Rs 40,000 to Rs 74,000

Productivity
To work with applications such as Pho-
toshop and with audio and video edit-
ing tools

At least a 1.7 GHz processor, 128 MB
of DDR RAM, a 40 GB, 7,200-rpm hard
disk, and a 17-inch monitor

HCL Beanstalk 4455, Dart Emerald

Rs 59,990 to Rs 74,000

Office and Internet
A computer for surfing the Net and
that can run day-to-day applications
such as word processors and spread-
sheets 
At least a 1.2 GHz processor, 128 MB
of SDRAM, 40 GB hard disk, 15-inch
monitor, integrated graphics and
sound
HCL Beanstalk 4458, Compaq Presario
3705AP, Visualan Celebrity
Rs 27,750 to Rs 48,990

Decision Maker

Buying Tips
■ The specifications and associated features of you sys-
tem configuration need to be suited to your application. 
■ Verify that a service centre is located close by and you
fall within the jurisdiction of the service personnel in case
of onsite calls.
■ Your system should be capable of supporting newer and faster
processors, and must contain adequate vacant slots for RAM
and enough USB and serial ports for peripheral devices.
■ Take into account how many vacant 5.25-inch drive bays your
cabinet has for a future CD-RW drive.
■ Enquire about the cost of various upgrade components to get
a clear idea for a future budget.
■ Find out what finance schemes are available and the flexibility
options that exist. Preferably, check if the vendor has tie-ups
with your particular bank for easy finance.
■ Ask the PC vendor for references or phone numbers of former
customers. They are usually more than willing to oblige.



The Winners!
In this comparison of branded PCs, we saw a spectrum of features
and specifications. Some were more suited to high-performance
gaming while others were tailored towards productivity and some,
though low on specifications and sheer processing horsepower,
were suited to general-purpose, non-demanding applications.

In this shootout, the computer that came out tops in terms
of sheer performance was the Visualan Lavish , which bagged
our Best Performance Award. With best-of-class components
such as the 2.53 GHz Pentium 4 processor, 256 MB of DDR RAM
and a speedy 40 GB 7,200-rpm Seagate Barracuda hard disk, this
system had a very strong core to tackle most performance appli-
cations. The graphics subsystem was also very strong with the
ATi Radeon 7500 graphics accelerator paired with the 17-inch
LG E700S Flatron monitor. The roomy cabinet left plenty of
room for expansion. This was also the only system to bundle a

wireless mouse and a very able 32x CD-RW drive. In
terms of peripherals, it had a 56K PCI modem and an

integrated Intel Pro 100 LAN
card. It was pre-loaded with
Windows XP Home Edition

and also carried a CD of the
OS. Also bundled were

numerous games such as
Motocross Mania, 4x4 Evolution ,

Serious Sam, Heavy Metal
F.A.K.K.2 and Rune. The package also
included Nero 9.0, PowerDVD 4.0
along with a blank CD-RW disk—all
for a price of Rs 74,000. Armed with
very powerful core components and

a good graphics subsystem, this computer marched triumphant-
ly into the gaming and multimedia authoring arena.

Our Best Value Award went to the Visualan Celebrity. This
computer was based on an older 810E-based chipset and ran a 1.2
GHz Celeron based on the Tualatin core along with a 40 GB,
5,400-rpm Seagate hard disk and 128 MB of SDRAM. It also fea-
tured integrated sound and graphics and included a sim-
ple stereo speaker system, a 52x CD-ROM drive and a
15-inch LG Studioworks monitor. The bundled soft-
ware was quite comprehensive and
included applications such as
CD Ghost, Genesys, Language
Genius, Media Ring Talk,
PC-Cillin Antivirus, PC
DJ, Recovery Genius and
Super Voice. Given its
meagre horsepower,
it cannot handle
CPU and graphics-hungry
applications well, but at Rs
25,750, is among the low-
est–priced systems you could opt for when it comes to general-
purpose applications such as office suites and Internet browsing.

Our extensive comparison tests proved that there is more to
a branded PC than just specifications. These computers do not
stop at offering just speed, but extend the utilitarian value to
after-sales support and service. Be it intensive gaming, audio-
video editing, surfing or plain keeping tabs of the grocery you will
find one that serves your need!

YATISH SUVARNA, MITUL MEHTA and MARCO D’SOUZA
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The Visualan Lavish
impressed us with its awe-
some processing and
graphics firepower

For general-purpose applications,
the Visualan Celebrity leads the
pack in performance and price
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Red Hat’s latest version is
a complete Linux pack-

age consisting of three base
installation disks, one docu-
mentation CD, and StarOf-
fice 5.2, Server and Produc-
tivity Application CDs, and a
visiting card sized System
Administrator’s disk. All this
also comes neatly packed
within a single DVD. The
package also includes three
detailed manuals, including
a Getting Started Guide, Ref-
erence Guide and Customi-
sation Guide. 

We installed
Red Hat on a PC with a Pen-
tium III 1.2 GHz processor,
an 815EE chipset-based
motherboard, 256 MB
SDRAM and a 20 GB hard
disk. We did not face  any
hardware compatibility
issues with the onboard
audio and video, and the
monitor (Samtron 55E) was
detected effortlessly. The
base installation can range
between 1.5 GB to 3 GB
depending on the packages

you wish to install. After ask-
ing the standard questions
about the keyboard, lan-
guage preferences and
mouse, Red Hat 7.3 offers a
variety of installation classes
including Server, Worksta-
tion, Laptop, Custom and an
upgrade option for previous
versions of Red Hat. 

Once you’ve selected the
class of installation, the next
step is disk partitioning,
which is handled by the
powerful Disk Druid utility.
Ironically, this utility is
available only during disk
partition. Disk Druid sup-
ports only ext2, ext3 and
vfat (Virtual File Allocation
Table) file systems, whereas
Fdisk supports more than 80
different file types, including
FAT16, BSD, DRDOS and
HPFS.

The next few installation
steps take you to the Boot
Loader Configuration screen,
where you can choose either
GRUB or LILO to set up the
Bootup Menu. Next, you
configure the network and
firewall. Here you can speci-
fy a default security level,
trusted devices and types of
incoming connections and
ports, among other things.
The last few installation steps
include selecting the lan-
guage, packages and config-
uring your video card and
monitor.

For office productivity,
you have KWord, KSpread
and Kpresenter for word 

p r o c e s s i n g ,
spreadsheets and
presentations,
respectively. If
software develop-
ment is your
forte, Red Hat
packs around 75
programming
tools and lan-
guages such as
Perl, Guile,
Python, etc.

The core Red
Hat 7.3 distribution is based
on the 2.4.18-3 kernel, and
provides patched versions of
popular Linux software with
some interesting new addi-
tions. It includes glibc,
XFree86, KDE, GNOME,
emacs, Ghostscript, BIND,
Sendmail, MySQL, Post-
greSQL, PH and Apache.

Connecting to the Inter-
net through dial-up was easy.
We managed to set up a
generic 56K modem, config-
ure connection parameters
and connect to the ISP in just
a few minutes.

This distribution has a
lot of features mimicking
Windows such as screen-
savers, desktop themes,
sound support, multimedia,
etc. It has X-Chat for chat-
ting and supports audio CDs
with a Winamp-like applica-
tion called XMMS. On the

browser front, Netscape,
Mozilla, Galeon, KDE’s Kon-
queror and GNOME’s Nau-
tilus complete the package—
Konquerer and Nautilus are
more like file managers that
happen to understand URLs.
Konquerer helps users to
view even the hidden Win-
dows folders whereas Nau-
tilus does not. 

With its treasure box of
applications, Red Hat 7.3
caters to everyone, from
home users looking at 
an easy-to-use Windows
replacement OS, to those
looking for a powerful Web
server OS.

Price: Rs 11,435
Contact: Red Hat India Pvt Ltd
Phone: 022-2853452
E-mail: info-india@redhat.com
Web site: www.redhat.com

Red Hat Linux 7.3
It costs a measly 11 grand!

We test the latest and the best hardware and software products available in the market 

SPECIFICATIONS
System Requirements:
Pentium class processor, 650
MB disk space, 32 MB RAM

Red Hat Linux 7.3 

Performance
Ease of use
Value for money
Features

OVERALL

B+B+

➜

Use the KDE Control Center to configure the GUI
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The sleek and rounded
translucent front of this

MP3 and VCD player is bound
to attract your attention. It
has an aqua coloured front
panel and you can see the
media spinning within. It also
houses chrome-plated control
buttons for Play, Volume,
Rewind, etc. The LCD
screen does not
support ID3 tags
and displays
informat ion
such as the track
number, time, Elec-
tronic Shock Protection (ESP)
status and mode (repeat-one,
repeat-all and random). The
player has a DC 5V power
connector, earphone jack and
Video and Line Out jack with
labels clearly indicating the
function of each. The player
offers good audio quality
across the board, be it a song
with heavy instrumentals or
vocals. The bundled ear-
phones delivered all the fre-
quencies very well. The play-
er comes with an RCA cable
(audio and video cable) for
connecting to the TV to play

the VCD. The sleek looking
remote lends that extra com-
fort of operating the unit
while enjoying a movie. The
power adapter and bundled
rechargeable NiMH batteries
translate into money saved. 

On the negative side, the
documentation is meagre on

information and is
not of much

help. No carry
case was bun-
dled with the
player, which
makes it sus-

ceptible to scratches and dam-
age from impact. All in all, at
just Rs 5,000, the Mercury
MP3-VCD Player is a good
solution if you don’t wish to
spend big bucks on a full
fledged VCD system and also
want mobile audio. 

Mercury MP3-VCD Player
Entertainment in your palm

Price: Rs 5,000
Contact: Visualan Technologies
Phone: 022-8202688
Fax: 022-8368514
E-mail: sales@visualanindia.com 
Web site: www.kobian.com

Mercury MP3-VCD Player
Performance
Build quality
Value for money
Features

OVERALL

B+B+

SPECIFICATIONS
Supports MP3 and VCD for-
mats; plays CD-R and CD-RW
media; 50 second shock protec-
tion buffer; infrared remote con-
trol; repeat one/repeat all/ran-
dom play modes; 32, 44.1 and
48 KHz sampling rates

Ever wanted an application
that could manage and

archive your hardcopies as well
as electronic documents in a

common repository? ViciDocs
Pronto could be the solution
for you. The program uses MS
Access for managing its data-
base and allows you to capture
documents via an attached
scanner. It comes with a 
built-in viewer which supports
150 file formats including
Word, Excel, PDF and 
AutoCAD’s DWG. This means
that the documents can be
viewed and printed from with-
in the database even without
the native application.

Customisable templates
with pre-defined fields such
as date, author, keywords and
so on, make document 

management child’s play.
Advanced users can create
their own databases with cus-
tomisable fields. The applica-
tion also provides shortcut
keys to some of the major
Office and Internet applica-
tions such as Word, Excel,
PowerPoint, Internet Explor-
er and so on, making it easier
to work with.

The interface is a little
tough and the preferences
option only provides very
basic View and Import prefer-
ences settings. Another fea-
ture lacking is that in the
Metadata View, you can only
access files till the root folder
level of ViciDocs—any other
folder is inaccessible.

To conclude, here is one
application that began as a
great concept but was let
down by a poor interface and
has a long way to go before it
makes for a good purchase.

ViciDocs Pronto 
File it up 

SPECIFICATIONS
System Requirements:
Windows 9x and above, Pen-
tium II class processor, 32 MB
RAM, 30 MB disk space

ViciDocs Pronto

Performance
Ease of use
Value for money
Features
OVERALL

B-B-
Price: Rs 12,000
Contact: Vicisoft Technologies P Ltd
Phone: 040-7743168
Fax: 040-7743167
E-mail: info@vicisoft.com 
Web site: www.vicisoft.com

The latest offering from
Canon in the CanoScan

series is the N1240U, an ultra
slim and silent scan-
ning device.
The Z-lid
(the lid which
can be removed
from the scanner) will
allow you to scan larger,
three-dimensional objects
with extreme ease. The device
derives power through the
USB port and has a built-in

power saving mode that will
not only save on electricity
bills, but will also enhance the

life of the device. 
The package

includes a whole
bunch of appli-
cations such as

Omnipage Pro 9, Arc-
soft Photobase and Photo-

Studio 2000, which make it
easy for OCR-ing documents
or for scanning images. The
scanner was recognised

immediately on the Windows
XP Professional system and its
drivers were installed from the
bundled CD. 

The CanoScan N1240U
took 100 seconds to scan a
full colour image (A4 size) at
300 dpi, which is quite slow.
At 22 seconds, its preview
time is also not too impres-
sive—a scanner in its price
range should take about 

10 seconds to preview an
image. Though slow, the
scanner’s colour reproduction
was bright and vibrant.

Canon CanoScan N1240U scanner
The slim beauty

SPECIFICATIONS
1200x2400 optical resolution,
USB interface, 48-bit colour
depth and a CD containing
ScanGear, OmniPage Pro 9,
Arcsoft Photobase and Photo-
Studio 2000

CanoScan N1240U

Performance
Build quality
Value for money
Features

OVERALL

B+B+
Price: Rs 9,995
Contact: Canon India Ltd
Phone: 011-6806572
E-mail: brijesh.verma@canon.co.in
Web site: www.canon.co.in
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Over the years, Corel has
gradually evolved into

an extremely powerful vector
based illustration software.
Although version 11 isn’t
essentially different from its
predecessor, it does include
new tools and enhancements
that lend the programs a lit-
tle more power and make
them easy to use. Adobe Illus-
trator is the only rival to
CorelDRAW in the market as
of now, but Corel scores as an
illustration program because
of its powerful drawing tools
and brilliant interface. The
program makes it easy to cre-
ate your own toolbars, menus
and macros, then save that
customised work space for
specific tasks. For example, if
you make lots of graphs, you
can create an interface that
puts all the important graph
tools within easy reach.

CorelDRAW’s cross-plat-
form support and vast range
of import/export filters are
pretty impressive. The filters
let you port files to and from
other design programs,
including Photoshop, Illustra-
tor and Visio. When exporting
a file to Photoshop, the layers
remained intact.

A new set of ‘Three point’
drawing tools has been
added to version 11, viz. 
3-Point Ellipse, 3-Point Rec-
tangle and 3-Point Curve
tools, which enable users to

create and position angled or
slanted shapes using very few
mouse clicks. The New Poly-
line and improved Pen tools
also simplify the process of
drawing curved and straight
lines, making it a breeze even
for first time users. Shaping
has also been greatly

enhanced in this version,
with new menu items includ-
ing Simplify, Front Minus
Back, Back Minus Front join-
ing Weld, Trim and Intersect.
Each of these tools gives you
more control over the shape
and placement of the objects
in your document, thereby
giving you more flexibility. It
also gives you four different
options to create a single
closed path from multiple
paths with either straight
lines or curves, thereby 
helping to preserve the

appearance of
objects while
creating them
quickly. The Bar-
code Wizard
makes it easy for
you to make your
own personalised
barcodes.

Although ver-
sion 11 claims to
have added a fea-
ture that lets you
copy text from
elsewhere and

paste it without
losing the font and
formatting, when
we tried to copy
text from a Web
page, the format-
ting, as well as the
font size was lost.
However, you can
convert paragraph
text to curves and
then apply effects
such as drop shad-
ows, without los-
ing any formatting. Smudge
and Roughen brushes have
also been added to allow users
to edit the curves of an object
to give a wavy look. Unfortu-
nately, these tools aren’t as
effective as those featured in
Adobe Illustrator 10. 

Just like the initial versions
of Macromedia Flash, version
11 has ‘symbols’ that allow
you to save your objects in the
form of symbols and add them
to the central library to be used
later. This feature is a boon for
artists who need to import
images to reuse them. You can
drag and drop a symbol into
any document as many times
as you want. Earlier, if you
wanted to reuse objects such
as arrows or call-out boxes,
you had to save each image to
a new file, then copy and paste
this into your illustration.
Symbols are faster and easier
to use and don’t significantly
bloat file size. 

Bundled with the drawing
program is a revamped Web
graphic and animation pro-
gram called RAVE. This pro-
gram lets you create interac-
tive rollovers and generate 3D
vector extrusions that add
depth to your animations. If
you find it difficult to create
vector-based animations in

high-end software such as
Macromedia Flash, you can
easily create them here. But
make no mistake, RAVE is not
a true professional animation
software and will need to ramp
up quite a bit before it can
compete head on with Flash.

With its fantastic drawing
tools such as pressure-sensi-
tive brushes, excellent filters
that let you seamlessly import
and export more than a hun-
dred file formats and a user-
friendly and customisable
interface, CorelDRAW 11 is a
great tool for artists. Even
with all the fancy new fea-
tures, CorelDRAW remains
easy to use for novices and
professionals alike. The incor-
poration of a few new tools
and the enhancement of
already existing ones speed
up productivity as compared
to the previous releases. But if
you are already accustomed to
using version 10, the new
release does not give you
enough reasons to upgrade.

CorelDRAW 11
All the vector power you need!

Price: Rs 26,500
Contact: Trifin Technologies
Phone: 011-6486447
E-mail: trifin@vsnl.com
Web site: www.corel.com

SPECIFICATIONS
System Requirements:
Pentium II class processor, 
200 MB disk space, 64 MB
RAM, monitor supporting reso -
lution of 1024x768

CorelDRAW 11 
Performance
Ease of use
Value for money
Features

OVERALL

B+B+

The Barcode Wizard, a cool addition, helps you
create and edit barcodes

CorelDRAW 11 has a user-friendly interface and
sports the new XP-inspired look
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The C41SX, the latest budg-
et printer from Epson, has

a cool contoured look and a
great colour combination. The
package includes five photo
quality and three economy
mode photo papers. As it has
only two buttons and
two LED indicators
for the printer and ink
status, it’s easy for
the new user to find
his way around the
printer. But one
glaring drawback is
the outdated parallel
interface—as a result, it could
not be auto detected on our
test PC running Windows
2000 Professional.

We printed a combination
of documents, including a full
A4-sized colour photograph, a
text document and a combi-
nation document which had
varying fonts, colour bars, con-
centric circles and so on. The
C41SX took just 52 seconds to
print the text document, while
it took 1,910 seconds (31 min-
utes, 50 seconds) to print the
colour photograph—almost

twice as much time as taken by
the slowest printers (Olivetti
ArtJet 12 and 22) in our Print-
er comparison test in July
2002! The colour photograph
was reproduced with a slight
haze and the colours suffered
in terms of richness. However,
the combination document

reproduced amazingly
sharp results—even
minute differences
in the font sizes
and colour bars
were easily distin-

guishable. However, a
big shortcoming was that the
software did not show the ink
level, a feature found in most
printers available today.

The Epson C41SX is a
good buy if price is a bigger
concern for you than speed.
Others, who need a more fea-
ture-rich printing device, had
best look elsewhere.

player and a 5.1 channel sound-
card, then this speaker would
complement them well—the
panning effects and the punch
of the bass sounds in the movie
quality test were pretty good. In
our sound frequency test, the
speaker was able to reproduce
sounds from 30 Hz to 15 KHz
without any distortion. 

The sound quality in the
ultimate treble test was up to
the mark, but in the ultimate
bass test there was consider-
able jarring and loss of bass at
maximum volume levels. 

All in all, this speaker set
is a good choice if you already
possess a 5.1 soundcard or if
you plan to upgrade to one.

Price: Rs 3,950 
Contact: Epson India Pvt Ltd
Phone: 080-5321266
E-mail: vasu@eid.epson.co.in 
Web site: www.epson.com

Epson Stylus C41SX
Performance
Build quality
Value for money
Features

OVERALL

B+B+

SPECIFICATIONS
Parallel port, 1440x720 dpi, 
12 KB input data buffer

Epson Stylus C41SX printer
Print me pretty

The satellites of this discrete
five-channel surround

sound system are rated at 
6 watts RMS and the sub-
woofer is powered at 
20 watts RMS. The package
includes sturdy speakers
in a smooth black finish,
speaker stands and the
necessary
cables for
connecting
the speak-
ers to the respective connec-
tions. The subwoofer stands
very firm and does not get dis-

lodged even at high volumes.
The speaker performed

well in our sound quality
tests. It handled the low and

high frequency sounds
with ease. This was
especially notice-
able in the gaming
tests where the in-

g a m e
m u s i c
and the
various

sound effects were clearly
reproduced. 

If you already posses a DVD

Mercury HT4500 speakers
Sound aloud

Mercury HT4500
Performance
Build quality
Value for money
Features

OVERALL

B+B+

Price: Rs 4,200
Contact: Kobian India Pvt Ltd
Phone: 080-5566626
E-mail: rohit@kobian.com 
Web site: www.kobian.com 

SPECIFICATIONS 
5.1-speaker setup; power rating
of 6 watts RMS per channel for
satellites and 20 watts RMS for
subwoofer; Front In, Rear In,
Centre/Subwoofer In connec-
tors; includes power adapter,
speaker stands and cables; 30
Hz to 15 KHz frequency
response range

The Golden Sample cards
from Gainward impressed

us with their truly outstanding
stability and performance at
significantly overclocked set-
tings. The card is built using
specially chosen, hand picked
components and hardware
tuning techniques
to offer a level of
performance not
ordinarily attainable
by other cards made using
run-of-the-mill chips and
components. 

We tested the card
using a Pentium 4 2.8 GHz
processor along with 256 MB
RDRAM—even at the default
clock speed, the card scored
higher than what we had seen
earlier. But what really hit us
was the sheer power of the
card to sustain performance
through the high quality and
anti-aliasing tests. It ran
Quake III Arena at maximum
quality settings, with 4x anti-
aliasing enabled at a resolu-
tion of 1024x768 (32 bit high

colour, 32 bit texture depth)
at over 100 fps!

We also overclocked the
card and got it to run stably
at 320/725 MHz (the default
being 300/640 MHz), giving
us a 10 per cent increase in

performance. The
card retails for

Rs 24,195, which is way lower
than the other available
GeForce 4 Ti4600 cards in the
market. All said and done, it is
by far the fastest card we’ve
ever tested.

Price: Rs 24,195
Contact: Mediatech India
Phone: 022-2396696
E-mail: sales@MediatechIndia.com
Web site: www.gainward.com

SPECIFICATIONS
nVidia GeForce 4 Ti4600 chipset,
300 MHz default core speed,
2.8ns 128 MB high-speed DDR
SDRAM/SDRAM, 640 MHz
(DDR) default memory speed,
two DVI to CRT connectors

Gainward GeForce 4 Golden Sample 
Go 4 gold

Gainward GeForce 4 
Performance
Build quality
Value for money
Features

OVERALL

A-A-
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This CD-Writer takes back-
ups of your important

data and Audio CDs at the
never before offered speed of
48x, which translates to a the-
oretical transfer rate of 7,200
KBps. With such high speeds
at your disposal, the only
roadblock is an inappropriate
burning medium. It normally
takes a long time for the latest
media to trickle down to the
market—we got hold of 48x
media from Princo.

We created an array of
files of different sizes ranging
from 1 KB to 100 MB and
burnt them on to a 650 MB
CD. The Writer managed to
complete the task in just 

2 minutes 54 seconds. It also
burnt a 700 MB ISO file in just
3 minutes 10 seconds. We
were just as impressed by the
audio burn test scores—we
burnt a 640 MB Audio CD that
contained 14 files and the CD-
Writer took 2 minutes 45 sec-
onds to burn this CD. We also
conducted a couple of read
tests to evaluate its perform-
ance as a normal CD-ROM
drive. Here we used the previ-
ously burnt CD and copied

the files from it on
to the hard drive.
Here too the
LITEON performed
well by finishing the
task in just 2 min-

utes 15 seconds. 
The Writer features good

build quality and the tray and
button do not feel tacky. The
package includes Nero CD
burning software along with
two blank media, out of
which one is a re-writable CD.
The necessary screws and the

audio cable are also provided.
All in all, the LITEON 48x CD-
Writer is a good choice for
those who demand speed.
And the attractive price is the
icing on the cake.

The latest offering from
Intel falls just short of the

magical 3 GHz mark with a
clock speed of 2.8 GHz. Tech-
nology-wise, it is no different
than its predecessor but with
its speed advantage of 
300 MHz over the P4 2.53
GHz, top performance is
something you can expect out
of the box. 

We matched this speed
demon with equally powerful
components, so as to prevent
any bottlenecks. The proces-
sor sat on the Intel
D850EMV2 mainboard and
was accompanied by 256 MB
of RDRAM, a GeForce 4
Ti4600, a 17-inch Samsung
75E monitor, along with a
clean-formatted 20 GB, 
7,200-rpm hard disk. The OS
used was Windows 2000 with
Service Pack 2 and other
patches duly applied.

The first part of our test
included some games bench-
marks—we ran a timedemo
on the retail version of Quake
III Arena patched with version
1.30. The test was run in three
different settings: Normal,

High and Maximum
(1024x786x32x32).  Here the
Pentium 4 2.8 GHz posted a
very good score of 434.2 fps in
the normal mode. There was
barely any difference in the
score in the high quality
mode—the average frame rate
achieved was 414 fps. This
means that if you intend to
buy the next generation GPU
based GeForce 4 card, it would
be best complemented by the
P4 2.8 GHz processor. 

We ran Content Creation

Winstone 2001 as
our next test. As
this test is mainly
processor and
memory driven, it
helps to measure
core-processing
power. Here the P4
2.8 GHz posted a
record-breaking
score of 95.2 in the
content creation
benchmark, which
shows that the
processor can easily
handle image edit-
ing, video editing
and multimedia

authoring applications, which
tend to be CPU hungry. To fur-
ther stress the processor, we
ran Business Winstone 2001,
which is a system-level, appli-
cation-based benchmark. Here
the score of 76.9 posted by the
processor truly reflects its
power.

Another high-processing

power domain is video encod-
ing. We encoded a standard
MPEG-2 format video
sequence using VirtualDub
1.4. The DivX codec used was
version 4.02 and the settings
for audio and video process-
ing in VirtualDub were turned
to full. The video compression
bit rate was set at 900 Kbps.
The processor took just 
1 minute, 21 seconds to
encode a 51 MB video file.

If you already own a 
2 GHz processor, there’s no
need for you to upgrade to 
2.8 GHz right away. Besides,
to exploit the full potential of
this processor, you would def-
initely require up-to-the-
minute supporting hardware.

Intel Pentium 4 2.8 GHz processor
Intel’s fast new baby

SPECIFICATIONS
2.8 GHz clock speed/512K on
chip cache, Northwood core
(0.13 micron)

Pentium 4 2.8 GHz
Performance
Build quality
Value for money
Features

OVERALL

B+B+

Price: Rs 32,500
Contact: Nebula Technologies  
Phone: 022-6730567
E-mail: pradip@nebulatech.com 
Web site: www.intel.com

LITEON 48x12x48 CD-Writer
Low on price, high on speed

Price: Rs 4,795
Contact: Media Tech
Phone: 022-2396696
Email: sales@mediatechindia.com 
Web site: www.liteon.com

SPECIFICATIONS
48x (write), 12x (rewrite), 48x
(read); ATAPI-E/IDE interface;
supports up to Ultra-DMA
Mode2 33.3 MBps; 80 ms (typi-
cal) access time; 2 MB buffer
memory 

LITEON 48x12x48
Performance
Build quality
Value for money
Features

OVERALL

A-A-
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Using a Pentium 4 1.5
GHz processor, the

ACi Impression is priced
quite steep when com-
pared to its Emerald sib-
ling (reviewed in
S e p t e m b e r
2002), which
sports a P4 2.0 GHz
processor and is almost 
Rs 20,000 cheaper. The laptop
comes in an attractive leather
case and the build quality is
quite sturdy. The 14.1-inch
TFT screen is powered by the
nVidia GeForce 4 420 GO. This
graphics card supported an
astoundingly high resolution

of 2048x1768 but
the screen panning
makes it slightly
cumbersome to use.
It has a Hitachi 
2.5-inch 20 GB hard
disk drive, a Toshiba
DVD-ROM drive

along with 256 MB DDR
memory, making it one of the
most powerful laptops avail-
able. Its most individualistic
features were blue LEDs
instead of the usual orange
and yellow, and an MMC slot
along with a FireWire port and
three USB ports.

However, there were a few

ACi Impression notebook
Beauty in the beast

things amiss—the Windows
key was placed inconvenient-
ly at the top right hand corner
and the lock had to be jostled
with to be opened, increasing
its chances of wear and tear.

In the tests, BatteryMark
4.01 ran for 105 minutes
(approximately 3 hours in
real life). It scored 53 in Con-
tent Creation 2001, as com-
pared to the average score of
45 by most laptops; Business

Winstone 2001 failed due to
compatibility issues.

The notebook comes in  a
metallic blue and grey combi-
nation with a neatly designed
front panel—a delicate combi-
nation of beauty and speed.

SPECIFICATIONS
Pentium 4 1.5 GHz processor,
256 MB DDR RAM, 20 GB hard
disk, 8x DVD-ROM drive, 14.1-
inch LCD TFT Screen, GeForce 4
420 GO graphics processor

Price: Rs 1,04,999
Contact: Allied Computer Interna-
tional (Asia) Pvt Ltd
Phone: 022-6366800
E-mail: sales@aci-asia.com  
Web site: www.aci-asia.com

ACi Impression
Performance
Build quality
Value for money
Features

OVERALL

BB

If you are tired of the slow
Windows defragmenter, try

DisKeeper 7.0. It lets you
exclude specific files and fold-
ers from the defragmentation
process. Its frag-guard feature
prevents MFT (Master File
Table) and the Windows swap
file from fragmenting, hence

improving performance. It 
also monitors their extent of
fragmentation, triggering an
automated defragmentation
operation during bootup when
their level of fragmentation
exceeds a preset threshold.
This application is extremely
light, runs as a background
service and consumes around

3 MB of RAM. You can also
schedule multiple partitions
for defragmentation at one go.

The interface is plain and
uncluttered. The help and
documentation is detailed
and explains the process for
installation, and provides a
glossary of more than a hun-
dred terms used with disk
fragmentation. 

This application is meant
for users who simultaneously
work on multiple applications.
Home users may not find this
application worth their money
since a software suite would
take care of their defragmenta-
tion needs and much more for
a similar price. 

Executive DisKeeper Home
Edition v7.0
Destined for defrag

SPECIFICATIONS
31.1 MB install size; supports
Windows 98/Me/2000/NT/XP
System Requirements: 
Any Pentium processor based
PC running Windows 9x and
above with 32 MB RAM

Price: Rs 1,560 
Contact: Crystal Solutions Pvt Ltd
Phone: 022-5953112
Fax: 022-5953113
E-mail: sales@crystalonnet.com   
Web site: www.diskeeper.com

Executive DisKeeper v7.0 
Performance
Ease of use
Value for money
Features

OVERALL

BB

Price: Rs 4,000
Contact: Visualan Technologies
Phone: 022-8202688
Fax: 022-8368514
E-mail: sales@visualanindia.com
Web site: www.kobian.com

Ever wanted to have a
device that could record

voice, click still images,
record video and act as a PC
camera? Mercury Pocket DV
Camera (4 in 1) is one device
that gives you all these
options. It has a USB inter-
face and can record video up
to a size of 640x480 at as
high as 30 fps. The camera
has a small LCD display that
is quite helpful in under-
standing the various modes
and using the camera opti-
mally. It comes with a small
tripod and another big plus is
the applications bundled
with the camera—there are
two CDs filled with utilities
such as Ulead Photo Express
4.0SE, Ulead Photo Explorer,
Ulead Cool 360 and Ulead
Video Studio. The bundled
software offer quite a lot of
features that complement the
camera—you can easily con-
trol brightness, hue, satura-
tion, contrast, etc, using the
software. 

When not
attached to the
PC, its 16 MB
o n b o a r d
SDRAM is
sufficient
to store around 
3 minutes of video or around
200 images. However, there is
no flash or aperture focus, so
you might not be able to get
the best pictures at night or
even on a cloudy day. Anoth-
er shortcoming is that the pic-
ture settings (brightness, hue,
etc) can’t be saved—you need
to set it afresh every time.

Overall, this is a nice little
device if you are interested in
sharing videos and still
images on the Web.

SPECIFICATIONS
128 MB onboard SDRAM mem-
ory; still camera, PC camera
video mode, AV recording mode
and voice recording mode; cap-
tures at a resolution of 640x480;
package includes USB cables,
installation manual, tripod stand
and two AA batteries 

Mercury Pocket DV 
Performance
Build quality
Value for money
Features

OVERALL

B+B+

Mercury Pocket DV Camera
(4 in 1)
Smallest camera with a tripod
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People are always talking about how
to build the most powerful PC, but
what about those on a shoestring

budget? Wait! Make that a single-fibre-of-
a-shoestring budget! What is the absolute-
ly cheapest functional machine that you
could possibly put together? Forget about
shattering fps records in Quake III, or
working on massive image files. If 99 per
cent of your daily applications revolve
around word processing and the Internet
then you’re in for a surprise.

Gone are the days when the lowest
entry-level computer meant shelling out
Rs 30,000. Hardware costs have plum-
meted, much to our delight. Follow
me as I mosey over to the friendly
neighbourhood hardwarewallas
and find out what system
components can be
scrounged together to help
us build the cheapest possi -
ble computer but still has
more than adequate process-
ing power, decent storage and
memory. And remember, all these
are brand new components!

The October heat can be really swelter-
ing and no matter where you are shopping,
remember to pack a cap—hardware shop-
ping could sap you out (and no, the cost of
the cap is not included in the system)! Since
my finances did not allow a cross-country
travel allowance, I headed for Lamington
Road, the first, last and final frontier for
hardware shopping in Mumbai.

My quest had me traverse six dealers
over 3 hours in the post-monsoon morn-
ing sun. Eager dealers tried to push a
whole assortment of goodies down my
throat—all the way from Duron, to
Celeron and P-III
processors, bundled
with the usual
range of peripher-
als. At each estab-

lishment, it took repeated efforts to drive
home the point that I was on an absolute
rundown budget and wanted the cheap-
est hardware. Finally, after much probing
into their inventory, it paid off and I came
across some very interesting options, at

the most amazing
prices!

First up, the core
system components:
the processor, moth-
erboard, RAM and
hard disk. I found
that the most inex -
pensive processor is
the 500 MHz Cyrix
MIII available for a
cool Rs 2,100! While
this processor was-
n’t made to shatter
any speed records, it
definitely suited my
humble, everyday

needs. Next up, I settled for a 128 MB
stick of PC133 RAM. There are many
brands to choose from and if you aren’t
particular about names such as Kingston
or Crucial, you can buy it for as low as
Rs 1,200.

For the motherboard, I didn’t look far
from the trusty Intel 810E based board
from HIS. The board came with integrat
ed graphics and sound (so I don’t need to

spend any extra there!) and I
picked it up for Rs 2,850. For
the hard disk, I decided on
a Seagate U8 40 GB drive at
about Rs 4,150. Try as I

might, I couldn’t find a
new drive less than

40 GB. Well, so far
so good. I had half
my shopping done
for a little over
10,000 bucks!

For the moni
tor, I decided

against even con
sidering a 14-inch

monitor; after all, even
budget mongers have to set

a standard! The cheapest 15-inch
er I could find was from Microtek at 
Rs 4,700 and this suited my needs just
fine. For the cabinet, I settled on a plain
Baby AT box at Rs 850—no flaps or
shiny colours here. The only CD drives
available at a low price range were the
52x drives and I chose one from Kryp
ton that cost me Rs 1,150. My Vesta 104-
key keyboard and three-button Anubis
serial mouse cost Rs 300 and Rs 150,
respectively. I finally sealed the package
with a pair of simple stereo speakers
costing Rs 350, and a trusty 56K PCI
modem from Lancer for Rs 450. Oh yes,
finally add Rs 500 for the mandatory
(though I doubt if I’ll ever use it) 
1.44 MB Sony floppy drive.

All done! I’ve got the building blocks
for a fully functional Office Applica
tion/Internet surfing computer—com
plete with a 500 MHz processor, 128 MB
RAM, a 40 GB hard disk, and Mandrake
8.2 (courtesy of the Digit June 2002 CDs)
for a shade under Rs 20,000!

Dare to go lower
Agent 001 sets out in search of the cheapest deal on PCs

Component
Processor 
Motherboard 
RAM 
Hard disk 
Cabinet 
Keyboard 
Mouse 
Monitor 
Speakers 
CD-ROM drive 
Modem 
Floppy drive

Brand
Cyrix MIII 500 MHz
HIS 810E
Generic PC133 128 MB 
Seagate U8 40 GB (5,400-rpm)
Generic Baby AT
Vesta 104
Mercury 3-button scroll
15-inch Microtek
Generic stereo speakers
52x Krypton
Lancer 56K PCI
Sony 1.44 MB

Price (Rs)
2,100
2,850
1,200
4,150
850
300
150
4,700
350
1,150
450
500

Note: The prices could vary over time and geographical locations.
Please use them as a guideline and not as a thumb rule.

The Shopping List
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The Internet has shrunk our world,
bringing people across continents
together at a click of the mouse.
But in most cases, our mailboxes

contain more unfriendly, unsolicited 
e-mail than a congenial note from the
friend across the ocean. Spam is growing
to become one of the largest and most
annoying problems faced on the Net
today. It is also big business for the bulk
mailers—they can send out millions of
messages every day and make thousands
of dollars in the process. 

Unwanted e-mail is not only irritat-
ing, but also harmful—hoaxes offering
weight loss pills and holiday discounts
clog mailboxes, causing important mes-
sages to bounce back. Companies lose
unimaginably large amounts of money.
Studies conducted on the Internet show
that spam costs businesses close to $10 bil-
lion (Rs 5,00,000 crore) every year, just for
the bandwidth! Add to this the cost of
anti-spam measures in terms of software
and manpower to manage the software.
Internet Service Providers (ISPs) suffer the
most: the spam affects them in the form of

outgoing messages as well as incoming
mail. It also drastically slows down net -
works and many a small ISP has been
known to shut down because of huge
amounts of spam.

Over the years, hundreds of ways of
avoiding spam have been suggested and
adopted. However, these were all depend-
ent on the end-user. Using unintelligent
filters in your mail client, understanding
the methods of bulk mailers and adopt -
ing practices to discourage them, and
using third-party spam-blocking software

are some of the most popular means sug-
gested. However, spammers have always
managed to stay a step ahead and cir-
cumvent all such means. Simple things
such as clicking on any of the links in a
mail, replying to it, trying to unsubscribe

from the list and sometimes, just reading
the e-mail is enough to let spammers
know that yours is an active e-mail
address so that they can bombard you
with even more messages. It is just not
possible to cultivate disciplined practices
to discourage spam across millions of
users. Thus, some amount of spam
always manages to reach your mailbox.

Spammers use software known as e-
mail harvesters, which crawl Web sites just
like search engines, and gather any e-mail
addresses found inside them. To protect

their sites, many administrators have
installed anti-harvesting scripts. However,
not all servers implement good security
measures and spammers are always able
to acquire huge lists of e-mail addresses
from corporate sites, forums, newsgroups,

insight ■
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A look at some anti-spam organisations that have come up with radical new ways to 
help fight unwanted mail that clogs up our inbox everyday

Your Inbox

It only takes one sucker in 10,000 to
make a spam operation economical“ — Jason Catlett, President of Junkbusters, an anti-spam organisation”
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etc. For example, on a bad day, the Beijing
Express E-mail Address Extractor
(www.zstools.com ) harvests over a thousand
addresses in just 15 minutes!

Now spam-haters and anti-spam organ-
isations have launched a new battle against
bulk mailers capture the spam before it
reaches the user. Pseudo-intelligent filters
are set up on the server itself, which simply
gobble up what they think is spam. This
way, the user forgoes the daily irritation
and does not encourage spammers. 

The weaponry
Several ways of identifying and blocking
spam have evolved with the new spamming
techniques—all of them based on rules
determined by the developers of anti-spam
software, and logic, which are updated
according to the practices of spammers.
How aggressive the preventive measures are
depends on these rules and also on what
the software does with spam—whether it
simply deletes the mail, or notifies the
sender and intended recipient or moves it to
a separate folder for the recipient’s scrutiny.

Four years ago, Microsoft tried to
block unwanted e-mail by filtering out
incoming messages from Outlook 98 that
contained certain text, such as a string of
exclamation marks or the phrase ‘for free’. 

Today, spam blockers are getting more
intelligent. Hotmail has signed up with
Mail Abuse Prevention System
(MAPS, www.mail-abuse.org), an
organisation formed to crack
down on spam, which main-
tains a Realtime Blackhole List
(RBL). This list contains details
of sites and ISPs that support
sites that send out spam. Any
mail coming in to a Hotmail

mailbox is analysed against this list and if
the addresses match any of the spammers,
it is identified as spam, and sent to the Junk
Mail folder. Lately, Hotmail has been apply-
ing the filter to outgoing mail too. 

Hotmail has been handling spam with
an iron hand. It simply blocks out mail
from and to certain ISPs and several users
are now realising that they have been los-
ing important mail. For example, the US-

based ISP Media3 Technologies is listed on
the RBL because it hosts half a dozen
spammers. However, it also hosts sites
such as Peacefire.org, which recently alert-
ed its members that Hotmail users have
been unable to reach them for five
months! On the other hand, many users
are happy because the spam to their inbox
has been drastically cut down since Hot-
mail adopted spam filters.

SpamCop (www.spamcop.net) is a free
service for blocking spam, which uses sev-
eral kinds of logic to identify spam. Any-
one can sign up with SpamCop and mem-

bers can report any mail
they receive as spam, as per
the guidelines on the site.
The mail is read by an auto-
matic parser on the site that
checks whether the mail
actually seems like spam.
SpamCop maintains a
Blocking List similar to the

RBL and matches headers in the reported
spam against this. Also, if it detects the URL
of a site several times in the message body,
it considers that as advertisement and clas-
sifies the mail as spam. Once identified as
spam, it sends a report to the administrator
of the originating address, with guides to a
few possible actions that he can take.
Reported sites are not necessarily added to
the Blocking List—this depends on the
nature of the spam, the quantity and fre-
quency of reports against the site and other
such factors. 

In most cases, the identified spammer
is just an innocent bystander. Profession-
al bulk mailers look out for open servers
from where they can freely send mail. For
example, VSNL users may remember that
earlier anyone could send e-mail using
any of the VSNL SMTP servers. Later, they
closed open relay and allowed mail to be
sent only from an authorised VSNL con-
nection. In fact, professional bulk mailers
maintain entire lists of such networks so
that they can jump from one to another
when one implements tighter security fea-
tures or to avoid anti-spam organisations.
Thus, anti-spam organisations have also
started maintaining lists of open-relay

servers—ones that allow anyone to send
mail from their networks. These usually
end up being the innocent bystanders.

Apart from just reporting e-mail
abuse, ISPs and administrators can also
configure their mail servers to link up to
the SpamCop Blocking List and have all
mail screened against the SpamCop sys-
tems, thus reducing the amount of spam
on their networks. This again is similar to
the idea of MAPS—to capture spam at the
source to avoid encouraging spammers.

Spamhaus.org maintains the
Spamhaus Block List (SBL)—a list of veri-
fied spammers, spam gangs and spam sup-
port services. The Register of Known Spam
Operations (ROSKO, www.spamhaus.org) is
maintained by Steve Linford, who esti-
mates that about 90 per cent of all the
spam is from just a hundred-odd large
spam organisations. This list is intended
to help cut down spam drastically. Linford
also suggests that shutting down sites that

A study by Jupiter
Media Metrix pre-
dicts that by 2006,
an average user
will receive nearly
1,500 unsolicited
e-mails annually

If Microsoft, one of the largest technolo-
gy companies, can say who we send e-

mail to, that really puts constraints on free-
dom of“ — Ben Johnson, a frustrated Hotmail user who lost 

many important messages”

Dear Asha,
I no longer complain that nobody sends me
e-mail. Ever since you showed me how to
use the Internet, I’ve posted my e-mail
address at various newsgroups and forums.
Also, I’ve signed up with Hotmail, Yahoo!
and many others, and have chosen the
option to make my e-mail address public.
There are so many other sites on the Inter-
net that require me to sign up—they are so
nice, not only do they send me regular
news about themselves, but also hand out
my e-mail address to others.

Now I get so much e-mail everyday, it
takes me around three hours just going

through all of them. The
Internet has really helped
to get me recognised.
There are several large
companies offering me jobs from home.
They say others who have worked with
them have made millions of dollars! And
then there is this poor leper who has been
rejected by society. There’s no one to help
him. I sent him Rs 500 yesterday.

The Internet is a great window of oppor-
tunity for all of us. In fact, I’m going to put
up your address too, at all the sites I visit.

Cheers and take care!
Bhola

Spam Magnets
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offer spamware—software that helps
spammers, such as e-mail harvesters, bulk
mailers, open-relay sniffers, etc—itself will
cut down spamming drastically because 
it is these tools that make spamming 
very easy.

SpamNet (www.cloudmark.com) is a rela-
tively new service with a convincing con-
cept—compile information from users
and users’ habits to identify and eradicate
spam. The concept is based on the fact
that users don’t like spam, yet do noth-
ing about it because spammers are only
more encouraged by any action taken.
Thus, SpamNet provides a plugin that
works through Outlook 2000 and XP
(they promise to release plugins for other
mail clients soon). When you receive a
mail, you can mark it as spam or an
authentic message. The information is
reported to SpamNet where it is analysed
against similar responses from thousands
of users (SpamNet already has over 50,000
users). A positive response from a user
improves the quality rating of the site or
source of the message, while
an abuse report goes against
it. Also, each user is scored
according to the number of
valid reports and this score
factors into the score of the
domain. Finally, this real-
time list is used to filter out
spam as it zips across the
Internet, trying to get to your
mailbox.

So what does all this mean?
Spam is just as ugly as politics—nobody
likes it, most don’t do anything about it
and a few make millions from it! Large
organisations (and gangs) are built
around the spamming business and even
some ISPs have tied up with them (they
treat their own anti-spam policies as
very, very fine print), making big bucks
in the process. Those who haven’t, lose
out on not only money, but also make
huge losses in terms of bandwidth
wastage. Again, all anti-spam activists
agree that e-mail marketing is definitely
good for business. They suggest that only
the opt-in kind of marketing, where
users explicitly choose what they want
to receive, should be allowed. Spam prac-
tices that assume that if a user does not
opt out means that he agrees to receive
future mailers, should be discontinued.
In fact, on May 30, 2002, the European
Parliament passed a law stating these
rules, making them effective across the
European Economic Area.

However, having seen
and suffered the failure of
all anti-spam practices
and laws over so many
years, many organisa-
tions and activists have
taken radical steps. Hot -
mail implements proba-
bly the strictest algo-
rithms on spam—if it
smells like spam, it is

deleted irretrievably. Also, rather than
using a per-message or per-site logic,
Hotmail blocks out entire ISPs known to
support spam. Thus, if any mail is sent
from or to that ISP even on a non-abu-
sive site, it is deleted. These policies are
over and above the MAPS system that
Hotmail uses. E-mail identified by MAPS
as unsolicited is moved to a Junk Mail
folder for the user’s scrutiny.

A lot of subscribers to various e-mail
services have realised that they are losing
important messages irretrievably. Anti-
spam organisations maintain that they
simply have to be radical. Even with their
strictest measures, some amount of spam
still manages to  sneak through. Users, on
the other hand, maintain that this does
not justify loss of important messages. At
the same time, there are tens of thousands
of users who are very happy with the new
anti-spam practices. Feedback from some
indicate a cut in spam between 75 to 
100 per cent! 

Server-based anti-spam software is still
in a nascent stage. Several services such as
SpamCop and SpamNet are working hard
towards getting a clean list of spammers
and authentic marketers, but this can only
develop over time. We can help them
develop faster by providing them with
more accurate feedback. There is no fool-
proof solution to spam, but these services
seem quite capable of controlling it to a
very large extent.

VEER KOTHARI
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Hotmail was one of the most
spammed e-mail services on the
Internet, until they implemented
strict anti-spam measures. The

simple reason for this is dictionary-based
spamming software. These software use a
‘must-be’ logic to send mail. Common
names and names with an incremental
index at popular e-mail services become a
very strong target. Thus, the software
assumes that addresses such as john@hot-
mail.com and john27@hotmail.com will
definitely exist. If a message bounces back,
the software simply won’t send a mail to it
for a few months. If you have a Hotmail
address, it is very likely that you’ve been
getting a lot of spam on it.

Hotmail’s Junk Mail filter is definitely
effective, but not a 100 per cent solution.
Setting up the filter is as simple as enabling
it from the Mail Options. Hotmail saves all e-

mail identified as spam in a folder called
Junk Mail, where you can review all of it at
one go and, if required, move some to
another folder.

A much more effective way to keep
unwanted e-mail out of your mailbox is to
fill up the Contacts list. Add all the people
that you want to receive e-mail from to the
Contacts and set the Junk Mail Filter to
Exclusive. This way, only people in your con-
tacts will be able to send you e-mail and
everything else will be blocked. An easy,
though not very nice, way of adding con-
tacts to the list is by sending an e-mail to
everyone you know—on sending the e-mail,
Hotmail provides the option to add the
addresses to your address book.

Next, you may want to define a Safe
List. E-mail from addresses and domains in
this list will be able to reach your inbox.
For example, if you receive various 

newsletters from ZDNetIndia.com, you can
add it to the safe list. Once you have the
Contacts and Safe list ready, simply switch
to the exclusive filter and you’re done.
Remember to update your contacts 
list regularly.

Filters@Hotmail

Use the Exclusive filter at Hotmail to keep
spam at bay

Havoc Systems, a
spam organisation,

started sending over 
50 million spam mes-
sages per week in mid-
2001. They sell e-mail
databases at $129
(approx Rs 6,450) for
15 million addresses!
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After you’ve installed Windows, the first
thing you’ll be asked for is the drivers.
Though Windows will find most of the driv-
ers for common hardware on the Windows
installation CD itself, it will often not get
the correct ones for hardware such as the
graphics, network, sound and SCSI cards.

If you have your old Windows
installed on a different partition or a dif -
ferent folder, installing drivers becomes
very simple. Windows stores all driver
information files in \Windows\Inf, with
the files for third-party hardware in a sub-
folder named ‘Other’. Thus, when asked
for a driver, simply point the Hardware
Wizard to this folder and it will pick up
the correct driver information file. It will
ask for a lot of support files (usually SYS
and DLL files); these should be located in
the \Windows or \Windows\System fold-
er of the older installation. If you can’t

locate them, they are either on the Win
dows Setup CD, or in a subfolder of the
System or System32 folders. Use Windows
‘Find’ (Start > Find > Files or Folders) to locate
the required files and again, point the
Hardware Wizard to the correct location.
Once you have all the hardware installed
and your system is up and running, you
can connect to the Internet and download
the latest updates of all the drivers.

Point the Hardware Wizard to the older
Windows installation

Given that there are so many 
flavours of Windows in use today, as
well as the variety of applications we
use, it is not viable to cover every pos-
sible combination in this article. Thus,
the article largely focuses on Windows
98, Office 97 and Internet Explorer 5,
though alternatives for other plat-
forms are mentioned where relevant.
However, application architectures
have varied only slightly over the last
few versions, so you can generally
apply the same rules across different
platforms—only some file locations
would have changed or some dialog
boxes would have been updated. For
example, Outlook Express stores e-
mail in different locations across dif-
ferent versions of Windows.

Readme.1st
Hardware Dri -

For a 
painless
reinstall
Need to reinstall 

Windows? Here’s how 

you can avoid starting from scratch

Every Windows user, at some point
or other of his system’s life, goes
through the agony of reinstalling
the operating system. Yet, the real

pain lies not in reinstalling Windows—
on today’s systems, it takes just half an
hour to format the drive and install the
operating system again. What’s tedious is
restoring the system to a usable state—
getting all the correct drivers for the
hardware, installing all applications and
tweaking the system, all the while pray -

ing that you haven’t lost any data when
formatting the hard disk!

But worry not. Help is at hand. We

show you some
smart ways to ease the

pain and smoothen out the
reinstallation process by saving certain

application settings that will help you
pick up from where you left off when
your system crashed on you.  

insight ■
■ workshop

Insight-Workshop Option.qxd  4/30/2004  11:17 AM  Page 94



95 OCTOBER 

If you frequently customise Office appli-
cations to suit your needs—especially
Word and Excel—you will certainly feel
the pinch when reinstalling if you haven’t
backed up the configuration settings. Usu-
ally, one remembers this only after one
starts using it again, when it is too late.

There are several ways to back up Word
settings. You can simply copy the tem-
plates from the Templates folder and copy
them back after reinstalling. Thus, you can
prevent the headache of recreating all
templates from scratch. To find out where
the templates are stored in Word, either
click File > Save As and change the ‘Save as’
type to Document Template, or click Tools
> Options > File Locations. Taking a backup of
templates will not only copy the styles,
headers, footers, text and images in the
template, it will also copy the document
properties, toolbar settings, shortcut keys
and macros that you have created. Tem-
plates also store all your AutoText entries.

Similarly, taking backups of Excel
templates will save characteristics of work-
books and worksheets such as the number
and type of sheets in a workbook, cell and
sheet formats, cell styles, page formats and
print area settings for each sheet, repeat-
ing text such as page headers and row and
column labels, data, formulae, graphics,
etc. The templates also store custom 

toolbars, macros, hyperlinks and ActiveX
controls on forms, protected and hidden
areas of the workbook, calculation options
and window display options.

Apart from template settings, you can
also back up AutoCorrect lists and custom
dictionaries in Word. Word stores Auto-
Correct entries in an ACL file. Typically,
the filename is the name of the user
logged on to Windows. Thus, if you log
on to Windows as Administrator, you
should be able to find a file named
Administrator.acl that stores the list. The
dictionaries are stored in DIC files. The
default dictionary is named custom.dic.

All versions of Office can be set up in
such a way that it is possible to automati-
cally install with custom selections with-
out filling up dialog boxes. You can select
the type of installation, components,
installation folders, etc. For Office 97, the
tab-delimited STF file specifies where and in
what order files are copied and what reg-
istry entries are created. The INF file con-
tains descriptions of Office files, which are
used by the STF file to determine which
files to copy. The instructions in the
Setup.1st file provide installation parame-
ters. For Office 2000, installation settings
are read from an MST file and running
setup with the /qb- parameter suppresses
all dialog boxes—you will not have to click

anywhere through the installation process.
Note that these will not restore any cus
tomised settings, but are great for repeated
custom installs.

Almost all program settings for Office
are stored in the Windows Registry, under
HKEY_CURRENT_USER\Software\Micro-
soft\Office. You can export this key to a
file and later import it back to the Registry
after reinstalling the same version of
Office with default settings. Microsoft has
included the perfect tool for Office 2000
and XP. Called the Save My Settings Wiz
ard, it takes a backup of almost all Office
settings and saves it to the Web or a local
file. You can later restore these settings
with the same wizard. The tool is bundled
with Office XP; for Office 2000 you can
download it from http://office.microsoft.com/
Downloads/2000/o2ksmsdd.aspx.

How many of us have lost our bookmarks
after reinstalling Windows? This is one of
the first things you miss when you start
browsing. To back up favourites, simply
copy the files off the Favorites folder. In a
single-user environment, this is located in
the Windows installation folder; other-
wise you will be able to find it within the
user’s profile.

If you customise Internet Explorer
quite a bit (security, connection, browser
behaviour, etc), you would want to save
its settings too. Most settings are stored in
the Registry. You can take a backup of the
HKEY_CURRENT_USER\Software\Micro-
soft\Internet Explorer branch. To do this,
open the Registry Editor by running reged-
it, navigate to this branch and click Registry
> Export Registry File. When you want to
restore these settings, first make sure that

the same version of Internet Explorer is
installed, then double-click the registry
file that you took a backup of. Reboot the
machine and the settings will be restored.

What all should you save when back-
ing up e-mail? This is the most common

dilemma most of us face. You don’t need
just the mail store itself, but all mail set
tings such as identities, rules and filters. If
you use Outlook, you will be able to find
Outlook settings in a PRF file. Outlook
stores the Personal Address Book in PAB
files, the Outlook Bar shortcuts in FAV files
and message rules in RWZ files. Nick
names are stored in NICK and NK2 files,
print settings in an OutlPrnt file, toolbar
settings in Outcmd.dat and system folder
views are stored in Views.dat. Macros are
located in VbaProject.otm and
Send/Receive group settings are in SRS
files. Signatures are linked from RTF, HTM
and TXT files, templates are saved as OFT
files and Junk and Adult Senders lists are
in files named Junk Senders.txt and Adult
Senders.txt.

You can back up the Account settings

Automatically back up Office settings

Save IE settings from the Registry

Microsoft

Internet and E-
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by saving the HKEY_CURRENT_USER\
Software\Microsoft\Office\Outlook\OMI
Account Manager\Accounts branch from
the Registry. All mail is stored in PST files.
As with other Office programs, you can
use the Save My Settings Wizard in Out-
look 2000 and XP, though it may not back
up all your settings.

There are
fewer things you
need to back 
up in Outlook
Express. All mail
is stored in DBX
files (one file for
each mail folder)
in a separate fold-
er for each identi-
ty. On Windows
9x you will be
able to locate the
folders for all
identities in

C:\Windows\Application Data\Identities.
Simply copy the folders to another loca-
tion; they can later be imported into Out-
look Express. The Address Book is stored in
a WAB file, typically in C:\Windows\Appli-
cation Data\Microsoft\Address Book. All

account settings and rules are stored along
with the identity information in the Win
dows Registry, under the HKEY_CUR
RENT_USER\Identities key. Simply export
this branch and later restore it and Outlook
Express will start functioning just as before.

If you use stationery in your e-mail,
you will find the files in \Program
Files\Common Files\Microsoft Shared\
Stationery. If you have digital signatures,
open Tools > Options > Security > Digital IDs
select each digital certificate and export it
to a file. Remember to export the private
key too, along with the public key. You can
import them back from the same window.

Windows is not as simple to restore to the
original look and feel as applications,
especially if you tweak it quite a bit. Win-
dows stores some settings in the Win.ini
and System.ini files in the Windows fold-
er, while many others are distributed
across the Registry.

If you modify Windows settings
directly from the Registry itself, you
should export these registry keys to a fold-
er as you modify them—to apply the same
tweaks, simply double-click each file.
Another simple way is to use a third-party
tool such as Tweak UI, which makes stan-
dard tweaks a breeze. Thus, when you
reinstall Windows, you can change all
those settings in just a matter of minutes.

The fastest and most effective way to
restore Windows to its original state is to
maintain backups of the entire Registry—
this will not only save Windows settings,
but also settings of all programs that use
the Registry to store their settings. It is
extremely vital that the backup be taken
when the system is functioning perfectly.
After a fresh installation of Windows, after
all your most-used applications are

installed, you should take the first backup.
Next, go on to changing system settings
and customising applications and take
another backup. You should update your
backup every time you install a program,
change some settings or upgrade hard
ware—changes that you know you will
always want on your PC. When you want
to restore the settings after reinstalling
Windows, first reinstall all the programs
that were installed when the backup was
taken, then reboot to DOS. You can
replace the Registry with the one from
your backup using the /c switch with
regedit. Thus, if you have a file named
backup09.reg stored in D:\Backups, you
would use the following command:

regedit /c d:\backups\backup09.reg
Windows 98 includes a tool called the

Registry Checker that, by default, takes
daily backups of the Registry. Though it
keeps only the last five backups by default,
it also maintains one backup of the fresh
Windows installation. You can restore any
of the backups by running scanreg /restore
from DOS. Along with the registry, this
utility also saves and restores the Win.ini

The Certificate Manager Export Wizard takes
care of all your digital certificates

Outlook Express stores
all information in the
Windows Registry

Tools such as Symantec Ghost
(www.symantec.com ) clone entire parti-
tions and even hard disks, but these
programs cost. You can do the same
without installing any additional soft-
ware. Basically, you need to copy the
files to a different location and copy
them back when necessary. For fast
and easy copying, you should have a
hard disk with at least two partitions
and a friend who will let you use his
computer when your Windows crashes.

While in Windows, close all open
programs, open Command Prompt
and switch to the folder where you
want to make the copy. Here, type the
following command:

xcopy c:\*.* /e /c /r /h /y /k
This will copy all the files and fold-

ers from the C drive to the backup
location. By doing it from Windows,
the copy operation itself is faster than
copying while in DOS and, more
importantly, all long filenames are pre-
served. Using XCopy allows you to
copy all folders and subfolders, main-
tain file attributes and ignore errors
(copying using Windows Explorer will
throw up an error if it tries to copy the
swap file and it will stop copying).

To restore this image, you will have
to be able to access the hard disk from
Windows. Thus, if you don’t have Win-
dows installed on another hard disk or
a different partition, you’ll need to
attach the hard disk to another
machine. Run the same procedure as
above to copy the files.

If you do not have access to anoth-
er machine, you can still have a work-
ing backup. Simply dedicate a partition
to hold this backup, so that you copy

the files to the root of that partition.
You can boot to DOS and use FDisk to
switch the active partition. When in
trouble, just boot off that partition
instead! Thus, you will never have to
reinstall Windows. 

Cloning Windows

Use Fdisk to switch from a corrupt
installation to a working backup

OS Set-
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and System.ini files. Windows Me and XP
use restore points, while Windows 2000
uses the Backup and Restore Wizard to
save system settings. With restore points,
you can take a snapshot of the entire sys-
tem and save it to a restore point, which
can later be used to roll back the system
to that state. Thus, technically you would
never require to freshly install Windows
again. Backing up the System State on
Windows 2000 will save all system set -
tings to a file. As with registry backups,
remember to set restore points or save sys-
tem settings after every critical update or
change. Unfortunately, restore points take
up a lot of disk space, so it may not be
possible to keep many of them.

If your Windows installation is set up
for multiple users, simply exporting the

registry from the Registry Editor will not
suffice. You should take a backup of the
files that hold the registry, i.e. the Sys-
tem.dat and User.dat files in the Windows
folder, and each User.dat file in the 

Windows\Profile\<ProfileName> folders.
To restore these files, copy them back to
the correct locations while in DOS.

If you have a lot of fonts, copy them
from the Windows\Fonts folder. Win
dows Explorer will only display the fonts
that are installed on your machine. If
there are other font files here that are not
actually installed, you will not be able to
see them. Thus, again it is best to copy
these files to a different location using the
Command Prompt. Your files on the
Desktop are pretty straightforward—sim
ply copy them to a different location,
unless multiple users login to Windows.
The same goes for your browser’s book
marks. If you have multiple users, you
should remember to back up all folders
under the Windows\Profiles folder.

All versions of Windows can be cus-
tomised to be installed with predefined
settings and without any dialog boxes
popping up. Called Batch Setup or Unat-
tended Install, this was originally
designed for cloning installations across a
large number of PCs, say, in an organisa-
tion, but is just as useful for reinstalling
on your own PC.

When you install Windows 98, it cre-
ates a file named Setuplog.txt in C:\. This
itself can be used as a batch file. Howev-
er, there are better ways of creating batch
files on your own. On the Windows
Installation CD itself, you will find a
batch file creation tool in Tools\
Reskit\Batch. Simply install and run this.

You can specify
all installation
settings cate
gorised under
various groups
such as compo
nents to install,
licensing infor
mation, network
properties, addi
tional programs
to install, etc
and save them

to a file. To use a batch file with the Win
dows 98 setup, simply type setup batchfile
name at the DOS prompt.

VEER KOTHARI

Backup and restore operations are very
easy, but be careful to use backups
from a time when you were sure that
the system was stable. Also, ensure that
you are restoring settings for the same
version of the application as when the
backup was taken. This includes minor
updates. For example, if you’ve backed
up settings of Office 97 SR2, it is not
advisable to restore them on an Office
97 installation without installing the
Service Release first. Do not procrasti-
nate in taking backups—every time
your system successfully accepts an
update and the PC works fine for a
while, update all relevant backups.
Finally, be very careful when working
with the Registry.

Precautions

With the Backup and Restore Wizard, you can
mirror an entire Windows 2000 installation

Automate Windows
installation

Understanding Program Struc-

Most programs store settings in one or a
combination of three possible ways: a file
in the program’s installation folder, a file
in the Windows folder or in the Windows
Registry. Again, typically most programs
that use the registry store settings under
two keys: HKEY_CURRENT_USER\Soft -
ware\<Vendor Name>\<Program Name>
and HKEY_LOCAL_MACHINE\Soft -
ware\<Vendor Name>\<Program Name>.
Very few programs use other ways to store
settings, such as a file in the root of the C
drive or one in the System folder. Most
programs also use INI files, though there
are some programs that use different

extensions for their settings files.
Thus, if you use Winamp, you will

notice that it stores all its settings in a file
named Winamp.ini, in the same folder
where it is installed. WinZip, on the other
hand, dumps it all in the Registry. As we
have already seen, Windows and Office
both use files as well as the Registry, and
Internet Explorer and related tools (Out-
look Express, MSN Messenger, etc) do not
use any files and save everything in the Reg-
istry only. By understanding how different
programs work, you can individually save
settings for the ones you customise.

However, if you are using software

such as Photoshop, you don’t want to get
by with just saving the settings. You would
be more bothered about the plugins, pre
sets (brush styles, shapes, etc) and actions
you may have downloaded, saved or cre
ated. These are all located in individual
folders within the Photoshop installation
folder, unless you modified their paths.
Plus, if you have been reading up on Pho
toshop tips, you may be storing fonts with
in the Photoshop folder—this way, Win
dows does not load the fonts every time
and though the fonts are available only to
Photoshop, the system runs a much lighter
load. Remember to copy the fonts too.

Reinstalling Windows the Smart
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Like a good hairdresser, a good job
is rather hard to find and the cur-
rent economic scenario has not
made things any easier for the

hopefuls. A scouring of the classifieds
within dailies, a shuffle of pages in the
employment newspapers, a frantic ‘try-
to-get-me-in’ phone call to a friend or rel-
ative—all these are routine acts for a job
seeker. And getting a job is just half the
battle; with work satisfaction always an
illusory goal, the search for ‘something
better’ is never quite over. 

This is where the Internet comes in—it
takes your worth as an employee and
grants it greater visibility. It is like moving
from page 3 of a newspaper to a lighted bill-
board on a busy highway. So you stood
within the top 10 per cent of your gradua-
tion batch? Log on to a job site and tell the
world about it. If you have more than 14
years of hard-earned experience in the IT
field and are in search of a better payscale,
don’t apply to two or three companies, go
the whole mile and apply to 300 of them!
Advertise yourself—sooner or later, your

credentials are bound to catch the right eye
and then, who knows? So lets mouse our
way through the best job sites that the
Internet has to offer.

Opening new doors
A job site aims to offer a unified portal to
getting the job of your dreams. As Joy
Ghosh, vice president of marketing and
sales of JobsAhead puts it, “In the tradi-
tional job market, jobseekers are handi-
capped by lack of information on available
opportunities, especially outside their geo-
graphical location. The Internet gave a
huge opportunity to bridge this informa-
tion gap.” The Internet is akin to a bridge
between the job seeker and the awaiting
opportunities. Dhruv Shenoy,
vice president of marketing at
Monsterindia, explains further:
“Traditionally, the job opportu-
nities a person could seek were
constrained by geography. A per-
son in Delhi could access only
jobs advertised in newspapers of
Delhi or through placement

agencies based in Delhi. Today, a jobseeker
in Shillong has access to the same jobs as a
jobseeker in Delhi or any person, anywhere
in the world! The equation has thus shift
ed, helping talented professionals make
their choice on the employer rather than
the other way around.” 

Blurring geography is just one of the
benefits of a job site. The other large offer
ing is the database of both companies and
recruiters that such a site accumulates. This
very database has been the golden key for
many a job seeker, a fact that Rajan Parids,
a computer graduate, attests to: “I was for
tunate to discover an online job site as soon
as I completed my graduation. By setting a
simple query, I was soon inundated with

very viable and attractive job
offers.” Today, Parids works in a
major software company—a job
that he thanks the Internet for. 

Shenoy explains the evolu
tion of such a service vis-a-vis
Monsterindia: “In 1994, Mon
ster was a simple job board,
which listed jobseekers and

Cast the World Wide Web to net the job you want

Roughly 20
per cent of

Internet users
use the Web to
search for a 
better job
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jobs, without any of the sophisticated
search functionalities. Over the years, the
job board has evolved into a technologi-
cally advanced suite of tools that help the
jobseekers and employers find each other
exactly as per their requirements.” 

While all major sites offer a search
service, what they differ in is the level of
control afforded to a job-surfer. Thus,
while JobsAhead lets you
search on the basis of job
location, experience and
the category, Monsterindia
filters your search accord-
ing to whether you want a
temporary post, a contract
offering or a full-time job.
Most of these sites also let
you post your resume
online for free. naukri.com
hosts a feature called the Resume Manag-
er that stores and forwards jobs pertaining
to your qualifications and experience via 
e-mail that it terms as ‘Job Alerts’. Thus, all
the relevant jobs find their way straight to
your mailbox. Moreover, by choosing a
privacy option, you can make the entire
process as confidential as desired, safe from
the prying eyes of your current employer

and colleagues. Monsterindia and JobsA-
head offer the same facility, albeit named
a little differently.

It’s a fishpond out there
The constant flow of resumes is accumu-
lated into a dynamic electronic database,
which is bait for companies on the look-
out for fresh and bright talent. As Ghosh
explains, “Since our resume database is in
an electronic format, a million resumes
can be searched through in a minute, as
compared to a traditional hard copy for-
mat. Also, one can keep the database fresh
by constant updating. Hence, we provide
a very high quality sourcing base for can-
didates across categories, levels of special-
isation and seniority.” It is thus a
self-sustaining cycle—a job seeker posts
his resume because he knows that
recruiters frequent the site, while employ-
ers visit the job site as they recognise it as
a pool of potential employees. 

So are online job sites in direct com-
petition with agencies that take the offline

route? We ask Ghosh and this is what he
has to say: “Traditional recruitment chan-
nels were limited by their reach to local
audiences as well as access to database of
jobs. The Internet provided a low-cost
medium for recruiters as well as job seek-
ers to increase their reach exponentially
beyond their physical presence. But the
same agencies are our biggest customers.
While we give access to a high-quality
sourcing base for candidates, placement
agencies bring in their expertise in candi-
date screening and client relationships.” 

It is a symbiotic relationship that
Shenoy attests to: “While both the recruit-
ment agencies and Monsterindia are in
the same business, we go about our jobs in
a slightly different way. The core function
of the Monsterindia site is to provide a
ready database of professionals to employ-
ing organisations. The recruitment organ-
isations go beyond just sourcing talent.
Their value to the employers comes from
the fact that the agencies also screen and
shortlist the candidates. Moreover, we 

Today, talented pro-
fessionals can
choose the employ-
er, rather than the
other way around 

Dhruv Shenoy
VICE PRESIDENT-MARKETING, MONSTERINDIA

“
”

The Placement Agencies Directory of JobsAhead
promises to furnish complete contact details on
1,000 placement agencies

The Interview Centre and the Salary Centre
are two must-see resources that Mosterindia
has to offer

1 col AD
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outsource our services to traditional
organisations—worldwide recruitment
consultants form a significant chunk of
our client base. In fact, the segment of
recruitment consultants happens to be
the second biggest segment of clients on
Monsterindia, after the Information
Technology segment.”

Take a chance
Job sites are, of course, not a one-stop solu-
tion. Posting your resume on a site need
not guarantee a suitable post or for that
matter, a job. Like Parveen Mistri, a fashion

designer with three years experience found
out, such a site does not touch every
employment sector. “My resume was
online for more than six months. Every
day saw a cycle of excitement while check-
ing my mailbox, followed by moments of
trepidation upon the realisation
that I had nothing but junk
mail to delete. It got emotional-
ly taxing and I stopped fre -
quenting that mail account.
Thankfully though, I got a
decent job via a newspaper ad.”
This scenario is not unknown to
Shenoy. As a matter of fact, he
lists it as a potential drawback
on the part of job sites. “Today,
we can say that the only limita-
tion (and definitely not a hur-
dle) we have is the acceptance of the 
e-recruitment concept in some of the tra-
ditional sectors such as pharmaceuticals,
healthcare and banking. But as companies
start talking about their successes of recruit-
ing on the Internet, we expect the mindset
to turn positive.” We asked Shenoy
whether Monsterindia saw the growth rate
of the Internet as another bottleneck in the
making. “Although on an overall level the

penetration is seen as low, there is quite a
significant penetration within the working
population. There are two reasons for this:
in most offices today, Internet connectivi
ty is not as rare as it used to be. Addition
ally, the ever-growing popularity of e-mail

has made sure that people use
cyber centres more often. This
means that the Internet user
population in India is growing
at a phenomenal rate. Besides,
we see the relatively smaller pen
etration today as an opportuni
ty for the immediate future.” 

The fact of the matter is that
even though Internet penetra
tion as a whole is low, it is sig
nificant in the sectors that
count, making it a very rich

source for candidates amongst the pool of
graduates and such. Job sites should thus
be accepted as an additional facilitator
while hunting jobs and not as the sole
source for potential employment. By iden
tifying the benefits offered by such sites
and then maximising on them, the goal of
that dream job can be alleviated from the
unattainable to a distinct possibility.

AHMED

Free Resume Assessment is a walk-in service
provided by naukri.com for residents of major
cities such as Mumbai, Delhi and Kolkata

JobsAhead
connects 1 lakh

jobs from more
than 5,000
recruiters across
the country to
over 10 lakh job
seekers every
month

Monsterindia: If you are looking to immi-
grate to a foreign country, try Mon-
sterindia’s Global Gateway. You just need to
identify the country where you are being
offered a job, or would like to get one. This
section will then help you with details on
Visa requirements and immigration assess-
ment, employment issues, labour policies,
occupation demands, economic status of

the country, and a helpful assortment of
tools and resources. The tool that stands
out is the Visa calculator, which provides a
preliminary indication of your eligibility to
work in a foreign country on a temporary
or permanent basis. 

JobsAhead: The highlight of this site is cer-
tainly the Career Booster, a paid service for
the prospective employee (at a price of 
Rs 2,000). Over a four-step process, Career
Booster presents a unified and comprehen-
sive package for the job seeker. The first
step involves an expert panel writing an
appropriate resume for you. The document
is then sent to 800 placement agencies
across India, exposing you to what the site
claims, are more than 10,000 jobs. The
third phase involves highlighting the
resume on the site, guaranteeing it more

visibility. Additionally, the fourth step also
offers a comprehensive directory covering
names, addresses and telephone numbers
of top placement agencies.

naukri.com: This site offers what it calls
‘Value Packs’—custom made solutions that
are suited to the needs of every type of
employee. Therefore, the Freshers Value
Pack, customised for professionals with up
to two years experience, offers a resume
development service by an experts panel.
The resume is then displayed for a period
of one year on the site and sent to 300

entry-level recruiters—all this comes at a
price of Rs 1,600. It offers similar solutions
to both IT and non-IT professionals: IT
gurus can send across their resumes to
1,500 international recruiters, while non-IT
pundits can avail of the facilities of 1,000
domestic placement consultants.

Pressing the Right Buttons

Head to the Global Gateway for
immigration information

The Career Booster handholds you through
the nuances of job searching

Value Packs are custom made for
professionals and freshers
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Here you are, the proud owner of a
newfangled portable MP3 player,
but alas! All your favourite music is

trapped inside old Audiocassettes. Or
maybe the convenience of having your
entire music collection of tapes in a com-
pressed MP3 audio format is just too
tempting. Whichever way, converting that
old ABBA cassette into an MP3 memorial
is just a hop, skip and jump away.

What you will need
n A cassette player. The sound quality
achieved will depend on the capability of
the chosen player.
n A soundcard with a Line In jack inside
your computer.
n The MUSICMATCH Jukebox software,
featured in the Digit Mindware CD, Sep-
tember 2002. A free trial can be down-
loaded from www.musicmatch.com.
n About 1 MB of free hard disk space for
every minute of music that is to be
recorded.

Getting it together
Connect your cassette player

to the soundcard in your computer. This
can be done in two ways: if the player has
a Line Out port, use a stereo to RCA cable
(the one with a red and a white connecter
at one end and a single-pin stereo jack at
the other) to connect it to your computer.
If the Line Out port is absent, use the head-
phone port to connect it to the card—a
simple cable with 1/8-inch headphone
plugs on both ends will do just fine. You
can buy this cable from an electronic shop
or if you are feeling adventurous, you can
make one yourself. All you need to do is
locate two pairs of old headphones. It is
important that at least one of them has a
good wire. Cut off the plugs from both the
pairs and extract a length of wire from one
of them. Connect the two plugs with the

wire and voila! You have the required
cable! Next, ensure that the bass, treble and
loudness levels on the player are all set to
zero—this is called normalisation and it
will give you the best quality audio by
minimising the sound distortion.

Set the controls
Double-click on the little

speaker icon next to the clock on the
lower right of your screen to bring up the
Volume Control. You need to ascertain
two things: that the Line In control is
not muted and that the volume level for
the same is not set to zero. If the speak-
er icon is missing on your system, go to
Start > Settings > Control Panel > Multimedia Prop-
erties. Here, select the ‘Show volume con-
trol on the taskbar’ checkbox. Note that
the soundcard must be correctly
installed for this.

Set the player’s volume level to about
one-third the power level and press Play.
If the setup is correct, you will hear the
music flowing from your PC speakers. If
you do not hear any sound, check the
Volume Control settings and make sure
that the cable is connected firmly to the
Line In port of the soundcard.

Sound check
Now that you have connect-

ed your player to the computer and pre-
pared your system, do a test run to ensure
that everything is working as it should.
In MUSICMATCH Jukebox, go to Options
> Recorder > Source and select Line In.

Then, go to Options > Recorder > Quality
and select MP3 (128 kbps). Press Play on
the cassette deck and click on the Record
button of the Jukebox. Wait until the
indicator at the bottom of the MUSIC-
MATCH window shows around 30 sec-
onds of audio, and then press Stop on 
the software.

Play the created test file (find it in
your MUSICMATCH Rips directory) to get
a handle on the quality of the recording.
If the output of the recorded file is too
soft, play around with the volume level
on the player, and the Volume Control on
the taskbar till you get the clearest sounds
possible. Repeat this step to get 30-second
test snippets of the cassette, until you are
satisfied with the quality of recording.

For the record
Once you are satisfied with

the sound quality, repeat the process out-
lined under ‘Sound check’, only this time,
continue for the duration of the cassette.
Now you don’t have to worry about those
squeaky tapes!

AHMED SHAIKH

All the music you
can’t leave behind

Make sure that the Line In column is
not muted and its volume is not set to zero

The two options to look for are highlighted
above. Also note the Record button
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Quick View
I use Windows 98 SE and have Quick

View installed on my PC, but when I right-
click any file, the Quick View option does-
n’t appear. Please tell me how to enable
this for all files.
Varun Kumar Arya
Via e-mail

Quick View is by default associated
with the file types that the program can
view. If it does not appear on common
file formats such as DOC, RTF, EXE, etc,
you can uninstall and reinstall Quick
View. You can do this from Control Panel >
Add/Remove Programs > Windows Setup .

Select Accessories and click Details. If this
does not help, open the Registry Editor
by typing regedit in the Run dialog box
(Start > Run) and expand HKEY_CLASS-
ES_ROOT\*. Under this, create a key
named ‘shell’, create another key named
‘QuickView’ under shell and finally cre -
ate a key called ‘command’ under this.
Double-click the Default value and enter

C:\Windows\System\Viewers\quikview.exe as
the new value. You will now get the Quick
View option with all file types, but two
such options with the file types that were
originally associated with Quick View.

Downloading with Opera
I have just begun to use Opera 6.03 as

my default browser. Whenever I download
a file, it opens a window called Transfers.
If I disconnect and want to finish down-
loading later, there is no way to get back
to the Transfers window after restarting
Opera. Thus, I start downloading some
other file to get this window and then
resume downloading the previous file.
Please tell me if there is any other way by
which I can open the Transfers window
without such a hassle.
Rohan Naravane
Via e-mail

To open the transfers window in
Opera, click Window > Special > Transfers , or
use the shortcut key combination [Ctrl] +
[Alt] + [T].

Discoloured monitor
My monitor shows a yellowish shade

around the corners of the screen. It disap-
pears after 10 to 15 minutes, but reap-
pears randomly. Can you tell me what is
the reason for it and suggest a solution?
Rohit
Via e-mail

This usually happens due to the
magnetic field of the speakers mounted

on the monitor and can happen with
any monitor if the speakers are placed
too close to it. Though the speakers on
the monitor may be shielded, this effect
does tend to develop over time. You will
have to degauss the monitor to get rid of
the discolouration—your monitor may
not have a built-in option for degauss -
ing, but a service person will be able to
do it for you.

Installing modem on Windows 2000
I have a problem installing a modem

in Windows 2000. When the modem is
detected, it is automatically installed as a
PCI communication device. Even if I unin-
stall it, it is again detected and installed.
Please help me.
Roshan Patel
Via e-mail

Instead of uninstalling the modem,
update the driver with the actual driver
of the modem. Open Control Panel > System
> Device Manager and double-click the
device to open its Properties. Under the
Driver tab, click Update Driver and
instead of letting Windows ‘Search for a
suitable driver’, select ‘Display a list of
known drivers’. Click Have Disk to select
the correct driver for the modem and
install it.

Sloppy floppy drives
I have an assembled Pentium III 

600 MHz PC on an Intel 440 ZX board
running Windows 98 SE. I have two flop-
py drives—1.44 MB and 1.2 MB. Though

Enabling Java with IE6, fixing Windows startup errors, discoloured monitors, 
installing modems—find all your answers here

Installing Quick View
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the machine functions normally, the sys-
tem detects only one drive when I boot
from the hard disk, but detects both
drives when I boot from a bootable flop-
py. I have changed five motherboards, five
floppy drives and cables and reinstalled
Windows many times, but the problem
persists. How do I solve this?
Shrikant
Via e-mail

If the drives are connected and config-
ured correctly in the BIOS, they should
appear normally, no matter which device
you boot from. The floppy drive cable has
a twist towards one end. The drive ahead
of the twist is Drive A, and the one behind
the twist is Drive B. Once connected this
way, make sure they are configured
accordingly in the BIOS. Press [Delete] to
enter the BIOS settings when the machine
is booting and configure the drives under
Standard CMOS Setup. Once this is done,
boot to DOS from the hard disk (hold
down the [Ctrl] key while Windows is
booting) and see if both drives are avail-
able. Next, boot to Windows. If the drives
are not available in Windows, add the
drive from Control Panel > Add New Hardware .

JavaScript errors
When using Internet Explorer, I get

various script errors. What should I do to
get rid of them?
Mahesh Bhattarai
Nepal

Script errors occur when Web sites
don’t use correct JavaScript or VB Script.
The browser does not understand how to
handle these wrong scripts and throws
up an error. To avoid the error messages,

open Control Panel > Internet Options .
Under the Advanced tab, uncheck the
box next to ‘Display a notification about
every script error’. 

Playing VCDs
I have a Pentium II 300 MHz PC with

64 MB RAM and a 36x Creative CD-ROM
drive. I use Windows Me. I can’t play
VCDs on my system. The computer does-
n’t recognise the .dat files. I have tried
many VCD playing software such as Jet
Audio, Windows Media Player 7.1,
PowerDVD, VCD player, etc. Kindly sug-
gest a solution for the problem.
Abhijit Joshi
Via e-mail

You have not mentioned exactly how
you are trying to view the movies—
whether you are playing it from a VCD
or have copied only the .dat files on to
your machine. If you have copied the
movie files, it will not play as a VCD on
any of the software you are trying to
use. However, you can simply drag and
drop the .dat file onto Windows Media
Player and it will start playing the
movie—Windows Media Player recog -
nises and plays back the .dat files, but
not as a VCD.

Hiding items in Control Panel
How can I hide a Control Panel item?

J Velmurgan
Via e-mail

You can hide Control Panel items by
adding their entries to the C:\Win-
dows\Control.ini file. If it’s not already
there, add the line [don’t load]. Below this,
list out the filenames of all items that
you wish to hide, followed by =no (e.g.
joystick.cpl=no). An easier way to do this 

is to download Tweak UI from
http://www.microsof t .com/ntworkstat ion
/ d o w n l o a d s / P o w e r T o y s / N e t w o r k i n g /
NTTweakUI.asp (this works with all ver-
sions of Windows). Run Tweak UI and
deselect the items you wish to hide
under the Control Panel tab. Here, you
can even see the filenames against the 
actual names represented in the 
Control Panel.

Startup errors
I have a Celeron 200 MHz processor, a

20 GB hard disk and run Windows 98 SE.
Every time I boot, I get the following error
message: ‘Error starting program. The
LITESCAN.DLL file is linked to missing
export MFC42DLL.6467 ’. On clicking OK,
the message disappears and the 
PC works as usual. Please let me know
what to do.
Narendra
Via e-mail

Missing Java applets
I have a P-III 866 MHz PC with 

128 MB RAM and a 20 GB hard disk
running Windows XP. Internet Explorer
doesn’t have the Java Virtual Machine

(JVM) and every time
a Web page has an
applet, it asks for
downloading the
JVM. I’ve tried

changing set-
tings in

Internet
Explorer but to
no avail. I have
just installed

Java Development Kit 1.2 and it
requires me to add the path of the bin
folder to the environment. I made

changes in the autoexec.nt file, but
that didn ’t help.
Gautam
Via e-mail

Microsoft has removed support for
Java from Internet Explorer 6 bundled
with Windows XP. However, you can
still install the older JVM from
www.microsoft.com/java/. Also, Sun has
released a JVM for Internet Explorer 6
on Windows XP, which you can
download from http://java.sun.com/get -
java/default.html.

You can add environment variables
in Windows XP from Control Panel > Sys-
tem . Under the Advanced tab, click Envi-
ronment Variables and add the path of
the bin folder to the Path variable.

Disable script error reporting

Use Tweak UI to hide Control Panel items
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The program that is trying to run
(most probably LiteStep), is referencing a
DLL file, mfc42.dll. This DLL is 
probably the wrong version. To correct
the error, simply reinstall the program. If
the problem still persists, try download-
ing the file from http://www.webattack.com/
help/missingfiles.html and copy it to the
folder where the program is installed. It is
possible that the mfc42.dll file version on
your computer is incompatible with this
software, so you may have to try out a few
versions to determine the correct one.

Mystery caller
I use Windows XP. As soon as

Windows starts, it begins dialling the Dial-
up connection. Even if I close it, it comes
up in a few seconds, not allowing me to
work. Even if I login to the Internet and
sign out, it keeps redialling! Please make
this stop.
Pius
Kathmandu

You can disable automatic dialling
entirely. Open Control Panel > Internet
Options > Connections and set it to ‘Never
dial a connection’. To connect to the
Internet, you can simply double-click
the Dial-up connection and manually
connect to your ISP before you begin
browsing. 

If this does not help, open Control
Panel > Network Connections and click
Advanced > Dial-up Preferences . From here

you can disable automatic dialling for
the connections.

Deleting unwanted e-mail
I have two e-mail messages that I can ’t

recognise. These may be viruses, which
may activate if I click on them, since they
would be displayed in the preview pane. I
use Outlook Express. How can I delete
them without viewing them?
Nabeel Ahmed
Via e-mail

You can simply turn the preview pane
off to not display the message. In Out-
look Express, click View > Layout and dis-
able the ‘Show preview’ pane. You will
now see only the message list, from
where you can delete the messages with-
out viewing them.

Mass mailing
I use Outlook Express 6 with all

updates and patches applied. Whenever I
send messages to many recipients, several
of the messages bounce back with a note
from the Webmaster stating ‘Too Many
Recipients. Delivery Failed ’. However, if
the list is small, the messages are dis-
patched promptly. My ISP is Dishnet,
Chennai. Please help.
V. Ravchandran
Chennai

This is not a problem with Outlook
Express. This is a setting commonly used
by ISPs to prevent spam—they assume
that if an e-mail is sent to a number of
people, it must be spam. Usually the limit
is 20 recipients, beyond which messages
will be bounced back with errors. You can
work around the problem by sending
mail to a lesser number of recipients. If
you need to send mail to a large number
of people regularly, use a mass mailing
software such as Bulk Email Express Free
(www.bulkemailexpress.com). Software such
as these usually send out individual mes-
sages to a list of recipients, and can
optionally personalise each message too.

CD writing speeds
I have bought a new Sony CD-Writer.

My computer’s configuration is Pentium
III 933 MHz processor, 256 MB RAM 
and a 20 GB hard disk. The CD-Writer
takes around 10 to 12 minutes to write
650 MB of data at 32x write speed. Can
you tell me how I can decrease the time
taken? Does the speed depend on the
software used? I use Nero Burning ROM
5.5. Should I change the software?
Sanjay
Via e-mail

No matter what speed you set the
Writer to write at, it will not write faster
than the media’s maximum speed, or the
CD will not be written correctly. Com-
monly available CD-Rs max out at 16x,
with some going up to 24x write speeds.
Nero is a pretty good CD writing software
and automatically detects the maximum
speed of the disc, thus preventing dam-
age to it. Unless you get faster CD-Rs, you
will not be able to write at faster speeds.

Can’t open Hotmail
I have a problem with certain sites

such as Hotmail and Indiatimes mail.
When I enter the sign-in name and pass-
word, the same page reappears. This also

Automatic starter
I have a Pentium III 600 MHz com-

puter with 128 MB RAM and a 17.2 GB
hard disk. I have installed Windows 98
and Windows XP. Recently, I connected
a Panasonic KX-FM 131 fax machine to
the COM1 port. The
device is working
perfectly, but
whenever I shut
down the system,
the computer dis-
plays the Shutdown
screen and then
reboots. Even if I sim-
ply turn on the main
power switch, the
computer starts on its
own. When I removed the modem, it
started working normally again. I tried
switching the modem to COM2, but
the problem persists. I also have a

Motorola SM56 PCI internal modem
connected as COM4. Can you please
help?
Rajesh
Bangalore

This is indeed a weird
problem. Boot the machine
and enter the BIOS setup by

pressing the [Delete] key.
Check the BIOS to see if

options such as Wake on (or
Power on) Ring or Wake on (or

Power on) LAN are enabled.
If they are, disable them
and see if the problem is

solved. If not, check if
the BIOS has other Power

on options, such as by a particular
key-combination. Disable all such
options and check if the problem 
is solved.

Disable automatic dialling in Windows XP
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happens when I try to download pictures
from Webshots. I don ’t get this problem
on other computers. I can download 
e-mail from Hotmail using Outlook
Express.
Swati
Via e-mail

Your browser is probably set to not
accept cookies, or you have some 

software running that disallows cookies
from being  stored on your machine.
Most sites that require logins work either
with session cookies (temporary data
files) or cookies (permanently stored on
your machine). These files store informa-
tion on your machine, which the Web
server can access—this is one of the ways
of transferring your information from
one Web page to another. 

If cookies are disabled, the page will
not know that you are logged in because
it does not get this information from your
machine. 

To enable cookies in Internet Explorer,
open Control Panel > Internet Options and
under the Security tab click Custom
Level. Under the Cookies section, enable
‘Allow cookies that are stored on 
your computer’ and ‘Allow per-session
cookies’.

Registry Checker
I have a Pentium III 500 MHz PC run-

ning Windows 98 SE. Every time I start
Windows, the Registry Checker runs, ask-
ing whether I would like to take a back-
up of the registry. On other PCs, the
Registry Checker runs transparently,
without prompting. How can I make my
PC do that?
Swatilekha Doloi
Via e-mail

It is possible that someone has manu-
ally modified the settings for the Registry
Checker on your PC. 

To correct it, open the Registry Editor
(click Start > Run and open regedit). 
Navigate toHKEY_LOCAL_MACHINE\
S o f t w a r e \ M i c r o s o f t \ W i n d o w s \
CurrentVersion\Run and locate a 
string value named ScanRegistry. Its
value should be C:\Windows\
scanregw.exe/autorun. If it is not, 
modify it to this and the problem
should be solved.

No more Windows
I have Windows 95 installed. Is there

any way to stop loading Windows without
pressing [F8] at startup?
Vemuri Sreenivas
Via e-mail

Yes, there is a way to prevent the Win-
dows GUI from loading automatically
and make the system to boot to DOS
instead. To do this, edit the C:\msdos.sys
file and change the value of BootGUI to
0. When you want to load Windows, type
win at the command prompt after it boots
to DOS.

Windows 2000 boot options
I have a Celeron system with 

128 MB RAM, a 40 GB hard disk and
three operating systems—Windows 98,
Linux and Windows 2000 Professional.
When the system boots, the Linux
Loader gives me the following options:
linux, hda1, hda2. When I select hda1, I
get the options: Windows 98, Windows
2000, Windows 2000, i.e., Windows
2000 appears twice. How can I remove
one of them?
Anoop Abraham
Via e-mail

Initially, the Linux Loader (LiLo)
controls the boot process and gives
you the options to boot to Linux or
another operating system. When you
select hda1, the Windows Flexi Boot
Loader takes over and gives you the
boot options that are configured in
the Windows 2000 setup. You can
modify this by editing the boot.ini file
in the root of the boot drive (C). The
options will be listed one below the
other. All you have to do is delete the
extra entry and save the file.

OpenGL missing
Whenever I try to play Soldier of

Fortune I or II, I get an error message
that reads ‘GLW_StartOpenGL()—could
not load OpenGL subsystem’. I use a SiS
graphics card on a Pentium 4 1.60 GHz
PC with Windows XP. Please help.
Atul
Via e-mail

SiS graphics cards do not have
support for OpenGL, which is required
for games like Soldier of Fortune to run.
You will have to upgrade to a more
high-end graphics card, such as one of
the GeForce series. Refer to the Test
Drive on Graphics Chips in the

August 2002 issue to pick the right
card suited for your needs and budget.

Scandisk repeats itself
Scandisk and Disk Defragmenter

never run completely on drive C of my
PC. It keeps restarting, with a message
that Windows or another program is
writing to the drive. The C drive only
contains the OS, Windows 98. I dis-
abled Norton AntiVirus Auto-Protect. I
cannot understand what program is
running. How can I find and stop it?
Ajit Kanungoe
Via e-mail

The program that’s running is
Windows. You can’t stop it, but you
can prevent it from accessing the
disk. Windows uses a swap file to
temporarily store data when it runs

out of RAM. It needs to constantly
access this data, thus it is always
accessing the drive. You can disable
virtual memory from Control Panel >
System > Performance > Virtual Memory .
However, remember to enable it
again after you finish running
Scandisk and Disk Defragmenter, or
you can expect a lot of blue screens
and system crashes.

FAQs

Disable Virtual Memory

Send your computing
problems to
sos@jasubhai.com
or write to Digit, 

D-222/2, Om Sagar, MIDC, Nerul-400
706, and we may answer it here!
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Advanced File Organizer,
AVG Anti-virus 6.0 Free Edi-

tion, Birthday Reminder, Book
Librarian, Book Organizer
Deluxe, CDCoverPrint, FinePrint,
FlashGet, FreeCard, FreeRIP MP3,
Greetings! for Word, HandyBits
Voice Mail, HJSplit, Iconoid, ICQ
2002a, MP3 Studio, OpD2d -
Direct to disk audio recorder,
Paint Shop Pro 7, Personal budg-
et template, Personal financial
statement template, Recipe
Organizer Deluxe, Talking Greet-
ing Maker, Trillian, Virtual Origi-
nal CD Emulator
Plus Tips and Tricks to get your
work done more efficiently in the
office.
Find them all on the Digit 
Mindware CD.

Quick and easy answers to some of the most common 
questions asked while using the PC at home

ILLUSTRATIONS : Mahesh Benkar
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I tried recording sound
with Sound Recorder. It
cuts off after 60 seconds.
What’s the best way to
create songs on my PC?
Sound Recorder is a rather
crude program. If you keep
hitting the Record button
every 60 seconds, Sound
Recorder will keep append-
ing the audio and you will
be able to record more than
just one minute. A better
way to record sound is to use
a free utility such as Direct to

Disk Audio Recorder
(http://www.opcode.co.uk/opd2
d/default.asp). With almost all
such sound recording soft-
ware, you can capture as
much audio as your hard
disk can hold. 

Can I extract a song as
an MP3 from a movie?
To extract sound clips from
a movie, you will need a
video editing software. For
VCDs, a software such as
VCD Cutter (www.seller-
club.com/~vcdcut/ ) or Virtual -
Dub (www.virtualdub.org) will
work just fine. In either soft-
ware, cut out the length of
the movie that you want
the audio clip from, then
save the audio from it. If
saved as a WAV file, you can
use a free utility called
FreeRIP MP3

(www.mgshareware.com) to con-
vert it to an MP3. Software
such as VOB2Audio (www.dig-
ital-digest.com/dvd/downloads/
vob2audio.html) can save
sound clips from DVD files.
A convenient way to rip
audio, irrespective of the
source, is to use software
such as MP3 Studio (www.nico-
lasoft.com). This records any
sound passing through your
soundcard, so if the movie is
playing, the sound can be
grabbed to an MP3 file.

How do I create and
print inlay cards and song
lists for my CDs?
Today, many CD writing
applications are bundled
with an inlay card printer
that lets you make jewel case
covers. You can also make
your own, using Microsoft
Word. All you need to do is
place text boxes of the cor -
rect size, enter your list and
other details into it, and
print. For a song list on the
back of the jewel case, you
can place three text boxes
next to each other. The first
and last ones can be of 
11.8 cm height and 0.6 cm
width, with the text direc-
tion (Format > Text Direction )
set to vertical. These will
appear on the spine of the
jewel case. Between these,
you would have an
11.8x13.8 cm text box. This
goes behind your jewel case
for the song list. Similarly, to
design an inlay for the front
of the jewel case, use a text
box of size 11.96x12.6 cm.
Print all of these out and cut
them along the borders. If
you find Word too cumber-
some or limiting, there are

hundreds of other tools such
as CDCoverPrint (www.alien-
aus.com/software/cdcp0.shtml) ,
which you can use to print
jewel case inlays.

I have such a large hard
disk, but games don’t run
if I copy the CD on to it.
How do I avoid having to
put in the CD every time?
Many games, encyclopaedias
and other similar CDs
require the CD to be in the
drive for them to work. This
is either because the software

needs to access resources
from the CD or it is a meas-
ure taken to prevent piracy.
There are several tools avail-
able, such as the Virtual Orig-

inal CD Emulator (www.ztek-
ware.com), which can emulate
CD-ROM drives for data as
well as audio CDs. All you
need to do is install the soft -
ware and configure which
folder on your hard disk you
want it to emulate as a CD.
Thus, you can copy entire
CDs to your hard disk in sep-
arate folders and have them
all appear as different CD-
ROM drives. This software
effectively fools the applica-
tion into thinking there is an
actual CD-ROM drive with
the application CD in it.
Another advantage with this
is that of speed—being on
the hard disk, the program
will run much faster than if
the program disk were actu-
ally in the CD drive.

I need to send this file
to my friend, but there’s
no point burning a CD for
such a small file and it
won’t fit on a floppy.
To share large files, you can
split them into smaller
chunks and use a set of flop-
pies or the Internet to transfer

■ tips and tricks

Direct to Disk audio recorder

Emulate CD-ROM drives from
your hard disk
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them. There are several ways
to split files. You can use a
file-splitting utility such as
HJSplit (www.freebyte.com/hjs-
plit/) where you simply have
to specify which file is to be
split and how large each
piece should be. The files can
be joined back to the original
using the same utility. How-
ever, this means that the per-
son you are sending the files
to should have the same util-
ity (you could include it on
one of the floppies). Another
way of splitting files is to use
a compression program such
as WinZip or WinRAR.
Almost all compression pro-
grams allow you to split the
output file into multiple files
of a particular size, which can
later be joined back together.
You can make a self-extract-
ing archive so that the pro-
gram does not need to be
installed anywhere else.

You can use a service such
as Yahoo! Briefcase
(briefcase.yahoo.com) to store
your files. This allows you to
store up to 30 MB of data,
with a maximum limit of 1
MB per file. You can share
these Web folders with your
friends for them to download
the files.

I wish dad was here to
celebrate Sunita’s second
birthday. But he won’t be
coming to India before
Diwali.
Today, you can share all your
magic moments with your
friends and family, with sev-
eral options available on the
Net. You can scan photo-
graphs, group them into
albums and put them up on
the Web for others to see.

Contrary to popular belief,
you don’t need to know a
thing about making Web sites
for this. There are several serv-
ices that create photo albums
for you—all you need to do is
select the photos from your
PC. Both, Yahoo! and MSN
provide free photo albums
online. You can send out an
e-mail to your kith and kin
with links to the photographs
and they can see them from
anywhere in the world. Some
services such as Ofoto
(www.ofoto.com) even allow vis-
itors to order prints. Thus, if
they see a photograph they
like, the site will have it print-
ed out on photo-quality paper
and mail it to them! For more
details on how to share your
photographs online, refer to
Digit, August 2002.

I often end up red-eyed
in my photographs. How
do I touch them up?
Often, photographs may need
some digital imaging to look
better, regardless of whether
they’ve been taken through
an analogue or digital camera.
Typical corrections include
removing the red eye effect
(you may have noticed that
the eyes of people in many
photographs have a red spot),
changing brightness and con-
trast settings and smoothen-
ing or sharpening the images.
The latter enhancements are
pretty straightforward and
can be done with most image
editing software, but remov-
ing the red eye effect usually
gets to be a problem. Red eye
occurs when the camera flash
reflects off the subject’s retina
since the pupils are wide open
because you’re shooting in

low light. It also commonly
happens with contact lens
users.

There are thousands of
image-editing tools with
which you can add various
effects to your images. The

easiest way to eliminate the
red eye is by using an auto-
matic red eye tool, if your
image editor has it. Paint
Shop Pro (www.jasc.com) has a
great semi-automated process
for eliminating the red eye
effect. Start by opening a
photo you want to work on.
From the Paint Shop Pro
menu, click Effects > Enhance
Photo > Red-Eye Removal. On
the Red-Eye Removal dialog
box, zoom in to the eye. Set
the Method to Auto Human
Eye and select an appropriate
hue and colour. On the edit-
ing window, use the selection
tool to draw a circle to cover
the red portion. Similarly,
select the other eye and click
OK on the Red-Eye Removal
dialog box to apply the
changes.

If you’re using an image
editor that doesn’t have a
red eye remover, there are
still a few ways to tackle the
problem. For instance, you
can use the Magic Wand tool
to select the red in each eye
and then paint the selections

a colour that looks natural
for that subject. Another
way is to use the Paintbrush
tool. Resize it till it is just
about the size of the eye. Set
the foreground colour to the
natural eye colour and click
once in the centre of the eye.
Now set the brush size to
about two pixels and change
the foreground colour to
white. Again, click in the
centre of the eye to give it a
glint.

Note that you don’t have
to do a perfect job to create a
fairly convincing eye—the
detail is so small in most pic-
tures that simply eliminating
most of the red is enough to
improve the picture. 

The online photo
albums are nice, but I
want to profile something
more. How can I quickly
create my own Web site?
There are various sites that
allow free Web hosting. Not
only can you put up your
own pages on the site, but
most of them also have cool
templates and wizards that
allow you to create pages in
just a few clicks, without
requiring any knowledge of
creating Web pages at all.
Yahoo! Geocities (www.geoci-
ties.yahoo.com) is one such free
service where you can build a
free Web site.

If you don’t want the
automatic or template-based
sites, you can still create 
your own site fairly easily.
Web development tools
today are no different from
word processing tools. In fact,

you can use

Removing the red eye effect
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Microsoft Word itself to
make your Web page;
Dreamweaver (www.macrome-
dia.com) is a far better software
for making HTML pages,
though. These don’t require
any knowledge of HTML and
you simply type the text, put
in the images and the soft-
ware writes the HTML for
you. Once you have all your
pages, you can upload them
to your Web site and you’re
done. All free Web hosting
services allow you to upload
files from a friendly Web-
based interface, so you can
upload files just as you would
select attachments for e-mail.

How can I receive e-mail
from Web-based services
in Outlook Express?
It is possible to receive Hot-
mail messages in Outlook
Express. To set up the Hot-
mail account, click Tools >
Accounts in Outlook Express
and click Add > Mail. Follow
the wizard and enter your
Hotmail address when asked

for the e-mail address. Out-
look Express will automati-
cally set sup the account and
synchronise the folders.

Apart from this, you can-
not receive Web-based e-mail
on a mail client. If the mail
service supports POP or IMAP
access, only

then can you configure it to
your mail 
software. Free services such as
Fastmail.fm (www. fastmail.fm),
SubDimension.com (www.sub-
dimension.com), and MyRealBox
(www.myrealbox.com), among
others, that allow you to use
the service using Outlook or
Outlook Express, over POP or
IMAP. You can get the details
of the SMTP and POP3 servers
from each site. In your mail
client, when configuring the
account, choose the appropri-
ate protocol (POP3 or IMAP)
and enter the SMTP server
address for the Outgoing mail
server and the POP server
address for the Incoming mail
server. Earlier, Yahoo! used to
allow POP access to e-mail,
but now it is a paid service. If
you subscribe with them for
POP access, you can receive
Yahoo! mail over Outlook or
Outlook Express, too. 

How can I send voice
messages by e-mail?
Sending voice messages by 
e-mail is fairly simple. All you
need is a soundcard and a
microphone. You have to
record your message to a
WAV or MP3 file using a
sound recording software
and attach it to your e-mail.
Make sure that the file does-
n’t get very large though. To
reduce file size, you can
reduce the quality at which it
is recorded. Using the MP3
format also ensures small
files. Also, record in single-
channel (mono) mode using
8-bit samples at 11 KHz if the
software allows you to
choose the settings. These
settings are adequate for
voice. The recipient can play

the sound file directly from
the mail client or download
the attachment from a Web-
based e-mail service.

You can also use free soft-
ware such as HandyBits Voice
Mail (http://download.com.com/
3000-2369-6606638.html?tag=lst-
0-7) for this. All you need to
do is record and send. It offers
high compression of voice
messages, though it records
sound to WAV files, allowing
your messages to be played
on almost any computer.

I’ve heard that most
viruses today spread via 
e-mail. How do I ensure
that my PC is safe?
There are some ways to iden-
tify and avoid infection due
to viruses that are spread by
e-mail. Usually, such viruses
are attached to the message
itself. On double-clicking the
attachment, the virus acti-
vates and infects the PC.
From then onwards, it starts
running off your system.
Though most such viruses do
little harm, they send them-
selves out to others in your
address book, sometimes
with large attachments.
Thus, you should avoid
opening attachments from
your e-mail, especially if you
are not sure who sent it to
you and for what purpose.
Since these viruses spread
through the address book,

you cannot trust the sender’s
address. If it seems impor-
tant, check with the sender
whether it was intentionally
sent to you.

Some viruses that spread
by e-mail may use JavaScript
within the message to either
run malicious code or open
a Web page that can run
malicious script. To avoid
encountering such e-mail,
turn off message previewing
in your mail client—if you
don’t view (open) it, the
script cannot execute. Delete
mail with suspicious sender
addresses and subject lines
without viewing them.

Avoiding viruses is not
the final solution. Virus devel-
opers keep learning new tricks
every day, so you should
install a good anti-virus soft-
ware on your system and
have it running at all times.
AVG (www.grisoft.com) is a good
free anti-virus package that
can keep a tab on not only
your hard disk, but your e-
mail too.

How do I make the most
of my dial-up connection?
Dial-up connections end up
costing a bomb if you add
the cost of the ISP and, more
significantly, the telephone
bills, especially if you have
to keep redialling. If you use

Send voice messages using
HandyBits Voice Mail

Outlook Express automatically
configures Hotmail accounts

AVG scans your hard disk and
monitors your e-mail for viruses
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your Internet connection
primarily for e-mail, there
may be some things you can
do to reduce the amount of
time you have to be online.
To begin with, type your e-
mail offline in your mail
client. That way, when you
connect, all you have to do
is send and receive messages
without staying online for
too long. If you use Web-
based e-mail, login to your
account and open up all the
messages you want to read
in new windows (hold down
[Shift] as you click the link).
Once they are all open, you
can disconnect, read them
all offline and type replies to
them in Notepad. Then 
connect again, paste the
reply to each message and
send them.

If you download files
and software from the Inter -
net, you must install a good
download manager such as
Download Accelerator Plus
(www.speedbit.com) or FlashGet
(www.flashget.com). Download
managers are much better
than using your browser
because these programs split
up files into several parts
while downloading. A sin-
gle-stream download will
never be able to efficiently
utilise the available band-
width, so the software
downloads the file in multi -
ple streams. Also, usually
these software can reliably
check if the same file is
available elsewhere for
download and will get the
file from the fastest server
available. If for some reason
the download stops midway,
the software can resume
downloading from that point

instead of downloading the
entire file all over again.

I have so many images,
sound and video clips. Can
I organise them so that I
can find them easily?
What you need is a media
organiser. You may already be
using one of the best tools for
organising media files—the
Microsoft Office Clip Gallery!
This tiny tool catalogues all
kinds of media files, segre -
gates them into categories
and associates keywords and
descriptions with them,
which you can use for pow-
erful searches. You can add
your own images, sound and
video clips to the gallery and
tag them as you want. You

don’t necessarily have to 
run this catalogue from an
Office application—it is an
independent utility that can
run on its own. If you have
Office, you should be able to
find it in C:\Program
Files\Common Files\Micro-
soft Shared\Artgalry. Run
Cag.exe from here to run the
Clip Gallery.

There are also some cool
tools available for down-
load. Advanced File Orga-
nizer (www.softprime.com) is
easy to use and it can cata -
logue files and folders in
hierarchical categories. You
can tag every file with your

own keywords and descrip -
tions, making it very easy to
search for them later.

There are so many
mouth-watering recipes
available online. Yet, I
can’t find the right one
for an occasion.
Recipe Organizer (www.prima-
soft.com) is excellent for man-
aging and organising all your
recipes into several cate-
gories. Apart from the ingre-
dients and preparation
method, it also stores the
preparation time, serving
size, an image of the dish,
etc. If you want, you can
even define other informa-
tion about the recipe that
you want to save. The next
time you have a Hawaiian
party, you will be able to find
the right recipes in a flash. If
you are comfortable with
Excel, you can set up a simi-
lar functionality in Excel.
Enter different properties of
the recipes in separate
columns and you can use
Excel’s powerful Sort and Fil-
ter functions to quickly locate
recipes of certain kinds.

How do I make greeting
cards on my PC?
You can use Word to make
greeting cards on your PC
and it’s fairly simple once
you get the hang of it. Basi -
cally, you need to set up the
page so that it prints like a
card. Begin by setting the
page margins to 1.78 cm and
the orientation to landscape.
Centre the paragraph align-
ment and draw a straight line
down the middle, along the
cursor. Keep the [Shift] key
pressed to draw the straight
vertical line. This will serve as
your guide for placing other
objects on the card. Now you
can place text boxes, images,
WordArt, etc. on the page to
make up the contents. The
only thing you need to be
careful about is to not get too
close to the borders—you
would be printing on both
sides of the paper and you
wouldn’t want anything
bleeding over the fold. Once
you’ve created the inside of
the card, create a copy of the
page and make the outside.

The front
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comes on the right side and
the back on the left. Once it
is ready, delete the vertical
guide and print the card on
two sides of the same page.
Fold it down the middle and
your card is ready to send.

There are also hundreds
of software available to make
greeting cards. There are two
ways in which they work—
they let you create your card
with the normal front, back
and inside views for printing
(the software takes care of the
orientation of the card when
printing) or they create cards
that you can send by e-mail.
These are normally self-exe-
cutable so that the recipient
doesn’t need to install any
software to view them.
FreeCard (www.pcww.com),
and Talking Greeting Maker
(www.4dev.com) are some free
software for making cards.
Greetings! (www.eplumsys-
tem.com) is a plug-in for Word
that allows you to easily cre-
ate cards from Word itself
without the manual process. 

Unlike ICQ, MSN does-
n’t automatically save a
history of my chat mes-
sages. Is there any way to
log my chat sessions in
MSN?
MSN Messenger has one
major shortcoming—by
default it does not save the
chat messages. You can use
an add-on called Messenger
Plus to log all your chat ses -
sions automatically, so that
you can dig them up later
for future reference. Alter -
natively, you can use a uni -
fied messaging software
such as Trillian

(www.trillian.cc). Trillian
allows you to chat over sev-
eral messaging services
(Hotmail, Yahoo!, ICQ, AOL
and IRC), and also logs chat
sessions for each of them
and has many additional
features such as skins, 
custom Away messages, 
etc that are present in 
some IMs.

How can I have my PC
keep track of birthdays?
Keeping track of birthdays is
as simple as using a reminder
or scheduler program. If you
already use Outlook, you can
set up each birthday as a task
with the appropriate date
and configure it to be recur-
ring every year. You can set
up an alert for it as per your
convenience. Thus, the
birthdays and anniversaries

can actually be planned
among your other tasks,
making this a very useful
solution. If you don’t use
Outlook, you can still use
any other free utility to
remind you of special occa-
sions. Free tools such as
Birthday Reminder (www.har-
shal.da.ru) manage birthdays
and anniversaries quite well.

I have so many books
and my friends often bor-
row them. Keeping a
track is too taxing.
There are several software to
help you set up a library at

home. Book Librarian
(www.turbosystems.com/win-
prod.htm) can organise and
manage your library, track
borrowers and due dates.
Book Organizer Deluxe

(www.primasoft.com) has power-
ful searching, reporting and
labelling capabilities. You can
even associate scanned
images with the books.

The cartridges for my
printer cost too much. I
wonder why they run out
so fast.
Printing can be quite expen-
sive depending on the kind
of printer you have, the
number of pages you print
and also the print settings.
You can’t really do much
about the first one unless you
are buying a new printer. You
can reduce the number of
pages you print in several
simple ways. If you print
from Office applications, you
can reduce the number of
pages used from within the
software. Word, by default,
uses large page margins that
you often don’t need. Reduce
the margin size to use a larg-
er area of the page for print-
ing. Word also has a built-in
function to reduce the page
count. Go to the Print Pre -
view mode and click on the
Shrink to Fit icon on the tool-
bar. Word will try to fit the
document on one page lesser

than the current count using
automatic calculations. In
Excel, you can set the zoom
percentage at which a sheet
is printed. Lowering this
value can reduce wastage
drastically. PowerPoint, too,
allows you to print multiple
slides per page.

There are some software
such as FinePrint (www.single-
track.com), that let you print
multiple pages on a single
sheet from any application.
FinePrint installs itself as a
printer driver, so you just
need to print to this virtual
printer and enter the num-
ber of pages that should be
printed per sheet. You can
preview the layout and print
from here to your printer.
Each page is resized to the
defined area and formatted
accordingly. This is excellent
when you want to just read
the content and don’t need a
final proof.

Print settings can con-
tribute quite a bit to printing
expenses. If you don’t need
great quality prints, print in
Draft or Economy mode. This
reduces the amount of ink
used and increases cartridge

life. Also, if you don’t need
colour, print in greyscale—
colour cartridges cost more
than black ones. Set these as
default settings by clicking
Start > Settings > Printers and

Use recurring tasks in Outlook
for birthday reminders

Set up your own electronic library

Reduce the zoom percentage at
which Excel sheets are printed



113 OCTOBER 2002

opening the properties for
the printer. Changes made
here will reflect in all appli-
cations, so change all set-
tings to the most economi-
cal ones. You can change the
settings back to higher qual-
ity as required from each
application.

The wallpaper looks
great, but these icons
look patchy on it.
Icons on the desktop usually
ruin the look of the wallpa-
per. The most obvious solu-
tion is to change the back-
ground colour of the desktop
so that most of the icon
labels may blend into the
wallpaper. This can be done
from Control Panel > Desktop >
Appearance. However, getting
the right colour is quite cum-
bersome and usually you will

not get uniformity across the
entire screen. Another
option is to hide the icons.
In the Display Properties,
under the Effects tab, enable
‘Hide icons when the desk-
top is viewed as a Web page’.
Thus, when the desktop 
is set as a Web page 
(using Active Desktop), no
icons will be displayed. Yet

another way is to edit your
system’s registry and disable
your desktop altogether. 
Go to Start > Run and type
regedit . Navigate to the reg-
istry key HKEY_CUR -
R E N T _ U S E R \ S o f t w a r e \
M i c r o s o f t \ W i n d o w s
\CurrentVersion\Policies\
Explorer. Here, create a new
DWORD value called NoDesk-
top . Edit this value and
change it to 1. The next time
you reboot Windows, your
desktop icons will have dis-
appeared! To undo this, sim-
ply delete the registry key
you added. A better solution
is to use software such as
Iconoid (www.sillysot.com) to
overcome the problem. This
software can make icon
backgrounds and labels
transparent, so there will be
no patches. It can also save
and restore icon positions for
different screen resolutions. 

Sometimes the CDs that
I write are not read by
some CD-ROM drives and
other players. This hap-
pens with various CDs—
data, MP3, audio, etc.
Burning CDs is quite simple
with the applications avail -
able today. It is largely Wiz-
ard driven—you just need to
select what kind of CD you
want to write and the source
files and you’re done. How-
ever, sometimes you will find
that the CD-Rs are not read
by all drives and players. This
has to do with either the CD
itself, or the way it is burnt.
You may have noticed this
behaviour more with CD-
RWs than with CD-Rs. VCD
players are more tolerant
than most other players, but

they can be quirky too.
The first thing you

should try is lowering the
writing speed. Many older
drives and players cannot
read CDs burnt at high
speeds. This is especially true
with Audio CDs. With data
CDs, if writing at lower
speeds does not help, the
CD-ROM drive’s lens may
require cleaning. Also, you
may want to turn off real-
time processing features in
the CD writing application.
Thus, when burning an
Audio CD, use uncom -
pressed WAV files for the
source and use MPEG-1
video files for VCDs. This
will not only reduce chances
of errors when writing the
CD, it will also decrease the
odds of the burn process fail-
ing due to buffer underruns.

When burning MP3 CDs
for an MP3 player, first con-
vert all your MP3 files to one
bit rate (96 or 128 Kbps) to
ensure that none of them are
encoded with very high,
very low or variable bit rates.
Although relatively new
players can read these for-
mats, many of the older ones
cannot. They have mini -
mum and maximum bit rate
limits and some of them
don’t understand variable bit
rates. If nothing works, you
will have to change the kind
of CD-Rs or CD-RWs you use
for burning.

Three of us share the
computer. How can we
have different settings?
Different users on the same
PC would like to have differ-
ent settings for the desktop,
the location where their files

are saved, separate e-mail
settings, etc. Windows NT,
2000 and XP are already
configured for multiple
users and Windows 9x can
be made to provide similar
functionality. Different users
on Windows 9x would have
their own desktops, Start
Menu items, themes, My
Documents folders, History,
Favourites, etc. Hence, each
user can have his or her own
profile and you won’t have
to change the settings every
time you want to use the PC.
The settings can be locked

by a password so that other
users can’t change them.

To set up multiple user
profiles in Windows, open
Control Panel > Passwords > User
Profiles . Enable ‘Users can cus-
tomize their own prefer-
ences…’. When a new user
logs on, a folder with that
user’s name will be created in
\Windows\Profiles with all
the personalised settings.

For multiple e-mail
inboxes, you can set up mul-
tiple identities in Outlook
Express. Each user’s e-mail
would be under his or her
own identity, which can be
protected by a password.
You don’t have to waste

time sorting
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Hide icons to get rid of patches
from your desktop

Configure Windows to save
multiple user profiles
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the mail into separate fold-
ers. To set up multiple iden-
tities in Outlook Express,
click File > Identities > Manage
Identities while in the pro-
gram. Here you can add,
modify and delete identities
and assign passwords to
them. Each user will have a
separate view and mail store,
as configured by the user
when logged on to that
identity.

How do I get the best
quality scans from my
scanner?
The quality of the scanned
image depends as much on
the scanner as on the scan
settings. Usually, you need
to be careful with two
things: scanning with high
quality settings and correct-
ing scan errors (lines and
patterns) that are not
intended to be on the page.
Use appropriate resolutions
for scanning—300 to 600
dpi is good for photos. Keep
the scan setting at the max-
imum colour depth that
your scanner supports.
When you scan content
from magazines or newspa-
pers, you will notice a lot of
lines on the scanned image.
The best way to reduce this
pattern is to use the
Descreen option in the scan-
ner software. Uncompressed
TIFF is the best format to
save the scanned images,
since it saves the image
without any loss in quality.
Ghost images (dark areas
picked up from the back of
the page) can usually be cor-

rected by
c h a n g-

ing the brightness and con-
trast settings. Experiment
with these controls to find
the best settings for your
scanner. Also, place a thick
white paper over the docu-
ment being scanned to
reduce this effect.

Always ensure that the
glass on the flatbed is
absolutely free from dust,
fingerprints and other such
marks, since these tend to
show on the scanned
images.

I’d rather work out my
finances on paper. The
accounting software is too
confusing and I don’t need
to keep as detailed a track
as the software does.
You can set up Excel for a
basic personal accounting
system. All you need to do is
to log the relevant income
and expenses, use simple
formulae for calculating
sums and differences and
you’re done. You can use sep-
arate columns for the narra-
tion, money transferred, the
date and the kind of transac-
tion—that’s all you need to
track your personal finances.
Put in the transaction details
under narration, the actual
amount of money under
money transferred (use posi-
tive values for income and
negative values for expenses)
and you can use the kind of
transaction to logically
group the sources of income
or the kinds of expenditure.
These can be logged against
the date for each transaction. 

That was the hard way.
Now here’s the easy way:
Browse to http://officeupdate.

microsoft.com/templategallery/ and
download a pre-built template
for personal finances. All you
need to do is change the Dol-
lar notation to Rupees. The
Personal Budget workbook is
pretty impressive, as is the Per-
sonal Finance Statement
workbook. There are several
other templates available on
the Web. The flexibility that
Excel offers in terms of sort-
ing, filtering and graphs
makes it a very friendly
accounting software. Once
you get used to it, try some of
the advanced functions such
as Subtotals, Grouping and
Outlining, Consolidation, etc.

Can I send SMS mes-
sages from my PC?
Yes, you can send SMS mes-
sages from your PC. ICQ has
an excellent network that
allows you to send SMS mes-
sages to most popular mobile
services. All you need to do is
sign up with ICQ at
www.icq.com, download the
ICQ client and you’re all set.

Login to the client, choose
the person you want to send
the message to and check the
box next to the Send by SMS
option. ICQ also lets you
send SMS messages from the
Web site itself. It also main-
tains a personal inbox where
you can receive messages
sent via SMS to your ICQ
account.

Mobile services such as
BPL Mobile allows you to
send SMS messages via e-
mail, using the format num-
ber@service.com for the To
address. Thus, if you want to
send a message to a BPL
Mobile subscriber, just send
a plain text e-mail to his
mobi lenumber@bplmo -
bile.com.

Send SMS messages from the
ICQ Web site
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“God how I hate Thursdays,” swore Matt under
his breath as he drove into the driveway. “I’m
late, the crew must be waiting for me.” Sure
enough they were all there, three of them

hunched up in front of their glowing monitors. They had already
booted up Quake II and were fooling around on the map that
served as their movie set. John sat on the floor, biting his nails,
with the sketched storyboards scattered all around him. Hugh,
was predictably watching the Road Runner Show, his fountain-
head of inspiration. Their tired eyes gleamed with excitement.

Matt took the vacant seat and his camera—a Pentium
computer running Quake II with the help of a 3D graph-
ics accelerator. The map that the game was running
looked like a diner: this was the set of their movie; this is
where the magic happened. Ben’s avatar was seen glee -
fully bunny-hopping inside the diner, while Paul’s char-
acter gave chase, axe in hand. “All right guys, settle down.
Its show time”, whispered Matt. The chase ended abrupt -
ly as Paul guided his avatar to the assigned position where
Frank’s character already stood waiting; Ben took his
place behind the counter. “Quiet on the set,” said Matt.
Someone chuckled; a ‘roll tape’ started an audiocassette

that contained the pre-
recorded dialogues for
the movie. Matt readied
his camera-control keys,
“Action.” Ben pressed
the [W] key on the 

keyboard and used his mouse to deftly move his avatar up to the
counter, Frank followed suit and pressed the [T] key, triggering a
talking animation that synched perfectly with the dialogue that
filled the air. It was going to be a long night, thought Matt, but
their movie should be over by the weekend. Maybe Thursdays
weren’t all that bad after all.

Machinima is a movie-making technique that blends the flexibil-
ity of computer-generated (CG) animation with the speed and free-

dom of traditional movie
techniques. It is an ingen-
ious means of using a 
3D game engine to create a
low-budget animated film
in minimum time. To a

Reel life heroes

The next animated movie you see might be powered by Quake III !

Both Star Trek: Elite Force (above) and 
Deus Ex (right) have used Machinima to
great effect

■ gamesarcade ■

Comedy in Armour
Hardly Workin’
Find trailers of
these Machinima
movies on the
Playware CD in Arena\Movies
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handful of pioneers across the globe, Machinima is life,
their calling. The ingredients involved are deceptively
simple: a storyboard to flesh out the characters, mod-
els and ‘props’ duly sculpted with the help of 3D mod-
elling tools such as 3D Studio Max, which also serves
to create basic animations for the characters involved.
The raw materials are then brought together within a
game engine of choice and the movie is acted out by
either AI bots or ‘puppeteers’ who control digital
avatars. Add the dialogue and music, follow it with

some live editing, and the movie is done! Hugh Han-
cock, the Artistic Director at Strange Company, has this
to say about the benefits of his trade: “In a lot of ways
Machinima acts as a combination of the best things
about live-action filming, puppetry and CGI (Com-
puter Generated Images). Like film, production is fast
and fluid, and there is plenty of possibility to experi-
ment with techniques, different interpretations of the
script and ways of shooting. Unlike film, however,
Machinima has most of the advantages of animation
too: it’s possible to change any aspect of any shot down
to the finest detail to replay a shot exactly as it was
originally created, while making changes to the cam-
era or actor-setup as you go, to shoot a film anywhere
you can imagine—the list goes on!”

The technique is slowly gaining popularity as a
viable alternative to traditional CG animation. Machin-
ima movies (generally filmed with the Half-Life and
Quake II engine) range from the bizarrely violent Com-
edy in Armour, to the surreal Ozymandias and the hilar-
ious Hardly Workin’. Moreover, the budget-sensitive
game-development industry has also taken notice of
this art form. Thus expensive CG cut-scenes have been
upstaged by Machinima story-telling techniques, as
demonstrated by Half-Life and Metal Gear Solid 2. 

HARDLY WORKIN’

êing: John Olinyk as Larry Lum-
berjack, Matt Dominianni as
Lenny Lumberjack and Paul
Jannicola as Cook Carl
It took the ILL Clan nine

months of hard work to create  this award-winning
film. Here’s a recap of what went into it:
Pre-production: The motley crew wanted to have
Lenny and Larry visit a diner run by Cook Carl, a char-
acter from their previous brain storming sessions. To
get a skeleton story in place, they used a process made
famous by Chuck Jones of Loony Tunes fame. As a
group, they came up with ‘business’; funny bits that
they wanted the characters to do. The best businesses
were collected and the director and writers put them
into a basic storyline. Story boards were then drawn
and used to create timed ‘animatics’.

Character models were created in 3D Studio Max,
Nichimen’s Nendo and Q2 Modeler. They were given
basic animations that were later bound to hot keys by
the puppeteers. Objects and a map of the diner were
created using Quark Army Knife. All this was then
packed together for use by the Quake II engine.

No dialogue was written beforehand, just plot and
story points. The improvisers then recorded dialogue
based on the storyline, allowing for a lot of freedom for
comic material to be generated by the group. The funni-
est takes were edited together into what became the
final sound file, using the animatics as a guide.  

Production: A local area network was set up with a
computer for each character used in a scene. The Clan
had at the most four character computers and one
camera/server machine from which the scenes were
shot. A basic camera configuration file was created
that allowed the camera to float and keys were bound
to zoom in and change its tracking speed. All the
scenes were recorded in Quake II as demo files.

Each puppeteer bound a set of keys for their charac-
ters’ basic animation. The sound file for each scene was
played back on DAT tape; the puppeteers could thus
match the dialogue. The shoot was run just like a film
set, with ‘rolling’, ‘action’ and ‘cut’ being called. As
needed, props were tweaked beforehand for each scene.
Post Production: Select takes were dumped to
MiniDV and a basic edit put together in Final Cut Pro.
A shareware called Key Grip II was then used to
‘recam’, a technique to create and adjust camera
angles for a scene after it is shot.  This aspect of
Machinima is great because the group only had to
shoot a master shot during production. Other angles
could be recammed afterwards—this was like being
able to re-shoot a scene without having to bring the
whole crew and cast back. Tweaking the character ani-
mation and the time-consuming process of lip-synch-
ing also happened in post production. 

The team looked at the rough edit and realised that
it needed more explanation, so they recorded the
Grind-O-Matic commercial segment. Titles and end
credits were finally added, and the movie was done!

I don’t think
that there

are any specific
show-stopping
reasons why
Machinima
shouldn’t achieve 
a very high profile 

Hugh Hancock,
Chariman,
Strange Company

“
”
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So is this real-time method all set to replace tradi-
tional computer animation? “No, I don’t think it
will,” says Hancock. “I suspect that real-time produc-
tion techniques will be some of the dominant film
and CG techniques of this century, but just as the -
atre hasn’t gone away with the advent of film, so I
don’t think that hand animation will disappear with
this real-time revolution.” 

Frank Dellario, the Producer of the much-lauded
ILL Clan , holds another view: “Yes and no. Yes, because
the newest game engines and 3D cards are focusing
not on increasing frame rates anymore but on the qual-
ity of the image. Also, once we have the ability to cre-
ate and shoot Machinima in 48-bit colour vs 32-bit,
we’ll have the colour range to match the feature film
world. No, because companies like Pixar Animation
Studios will always use the newest, fastest hardware
and software to push the envelope, like they did in
Monsters, Inc by adding 3 million hair to the character
Sulley. They didn’t have to do that but they always will,
they have to be the best and push what’s possible.
There were frames in Luxo Jr (Pixar’s first animated
short film, made in 1986) that took 72 hours to render.
Today, Luxo Jr can be completely rendered in real-time.
But Monsters, Inc also has frames that took just as long
to render, almost 15 years later.” 

Stumbling blocks have prevented Machinima from
gaining support amongst the community of tradi-
tional animators and filmmakers alike. Dellario feels
that the technique needs to be understood, tried and
tested by these groups. “With Machinima, an anima-
tion director will have to let go of key-frames and take
on the role of a real-time director. He will have to sit

in a room with
puppeteers and
direct them as
actors on a live
film set.” But there
are more practical
concerns: “A major
bottleneck is the
licensing. Engine
developers sell
very expensive
licensing agree-
ments and share a

percentage of profits from the games sold. Makes
sense in the gaming industry; but for the Machinima
community, they are simply out of league. Another
obstacle is the toolsets. About every two years, newer
game engines and computer hardware are released. It
means having to develop whole new toolsets and/or
having to recreate/upgrade our character models and
world environments in a new format.” Hancock
shares Dellario’s concern on licensing: “Probably the
biggest hurdle at this point is a legal one, but I don’t
foresee engine licensing being a problem for long, as
open-source alternatives are becoming increasingly
powerful and viable.”

In a way, Machinima is a blessed art form—it
feeds off the fast-paced juggernaut that is the gam-
ing industry. Games, as we all know, are at the
zenith of technological advancements. If your com-
puter can run the best game, it can pretty much run
circles around any other application out there. The
symbiotic relationship between game developers
and computer hardware manufacturers has sparked
off a revolution of late. Next-generation engines like
those that power DOOM III and Unreal Tournament
(UT) 2003 are riding on the wave of advancement in
video cards or programmable graphics processing
units (GPUs) from the likes of ATi and nVidia, and
promise to bring to shore an experience that will
further blur the line between the digital and the real.
Needless to say, the boys are excited at the prospect
of these new toys. Hancock goes first: “UT 2003
looks good, will have a lot of support behind it and
generally seems like it could be great for Machinima.
From what I’ve heard and seen, the ‘Matinee’ toolset
built into the engine is a very solid offering,
although it does seem to be very focused on the ‘AI

Real life problems

➜
Take a video card such as the Radeon 9700, add a next-generation game engine such as the one powering DOOM III and
you can create movies like Final Fantasy: The Spirits Within on your PC, courtesy Machinima

To star in a Machinima movie, a 3D model must first be created . It is then appropriately
clothed and finally animated 
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actors’ approach to Machinima”. Dellario explains
further: “Its major disadvantage, to me, is the lack of
a real-time camera recording feature, without which
Machinima loses its major advantage as a commer-
cial production medium.” 

Does DOOM III, to be launched from the much-
worshipped id Software stable, get the juices flow-
ing? Hancock says, “Drool. I can’t wait. If I had to
place a bet on which package would blow the
Machinima scene wide open and cause it to explode
into the film world, I’d have my money on DOOM
III.” Dellario couldn’t agree more: “It’s amazing and
when it comes out next year, I predict it will be a
watershed moment for the Machinima community.

Not just because of the amazing physics or the 
attention put on increasing the level of quality, but
because of the dynamic lighting ability. Now, a 
character carrying a flashlight or a lantern for exam-
ple, will affect the lighting in the environment. This
may sound small but it’s not. Lighting in any film is
one of the major story-telling and artistic tools at a
filmmaker’s disposal.” 

The hardware driving this phenomenon is not
forgotten, nVidia’s next-generation GPU, the NV30
for example, is expected to use 64 and 128-bit
colour rendering, delivering accuracy greater than
that of Toy Story 2. Dellario thinks that the new
hardware will advance the ability to create Machin-
ima, letting it compete more closely with what Hol-
lywood creates using large (read expensive)

rendering farms. “Programmable GPUs are
where Machinima will get an extra boost.
They represent a blank canvas to the
teams that create tools for Machinima,
allowing them to explore real-time
approaches to traditional filmmaking
techniques such as wipe, transitions, etc.
But more importantly, it will allow them
to develop unique approaches that will
visually create scenes that are otherwise
nearly impossible—real-time or not.” The
fact that these solutions will take them
closer to what pre-rendering currently

offers is what gets Hancock excited: “Obvi-
ously, the only impact they will have is

visually, but that impact will be massive. Certainly,
the GPU advances happening at the moment are
one of the main things closing the gap between
real-time and pre-rendered solutions.”

So, what does the future hold for this exciting film-
creation technique? Will Machinima, like its men-
tor, the gaming industry, inundate itself into the
cloning vat, merrily stuck in the groove of unorigi-
nality? 

“I don’t think it’s old enough or settled enough
to be stuck in a rut at this time,” counters Hancock.
“Machinima is an astonishingly young art form:
we’ve scarcely even managed to figure out the basics
of Machinima creation yet, much less scratched the
surface of its possibilities. Over the past 12 months,
I’ve seen people working on Machinima projects
ranging from sci-fi epics to abstract pieces, from
ultra-real thriller projects to sketch rendered music
videos. Machinima at the moment is startling in its
diversity, and that’s only increasing as users get
more familiar with the medium.” Dellario ruminates
on the query and offers a historical perspective:
“There was a lot of activity early on, but that flurry
of excitement got buried by reality. It still takes time,
blood, sweat and tears to make a film, regardless of
what medium you use. A lot of the original com -
munity were teenage gamers who’ve since moved
on or lost interest. Now we’re in the stage of mak-
ing this into a legitimate process in the animation
community.” 

To spark a revolution, a concept has to pass this
litmus test: it should be cost-effective and it should
not force a drastic re-learning of the tools and 
techniques involved. Machinima seems poised to
usher in a new era of animation and film-creation.
Will it pass the test and deliver? As a viable 
alternative to traditional animation, it has already
made some inroads into the gaming sector, although
it has a long journey ahead. As an art form, let us
hope that budding filmmakers discover this tool—
the Machinima Film Festival 2002 was recently held
to award just such pioneers. The question then is—
is Machinima your calling?

AHMED SHAIKH

Reinventing the reel 

Because we
shoot in real-

time, in a 3D virtual
environment,
we’re combining
the fast pace of a
film shoot 
with the flexibility 

Frank Dellario,
President, ILL
Clan

The ILL Clan crew improvise the dialogues for their award-winning
Machinima movie, Hardly Workin’

“
”
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America’s Army: Operations gives you
a chance to enlist in the US Army,
without leaving your warm chair.

This online first person shooter is based
on the latest Unreal engine and brings
alive the mayhem on both the Internet
and the LAN. We kick-start you into the
game and help you choose the right role
within a team, squad or platoon.

AHMED SHAIKH

Choose your calling
Depending upon the role that you wish to
take in Operations, you should select a par-
ticular training regime. As a soldier, you
are required to finish the Basic Training,
completing which you can sign onto any
of the other schools. Thus it is the Sniper
Training school, if you wish to be a sharp-
shooter; the Airborne School, if precision
air-drops from a thousand miles high
catch your fancy; or if you wish to march
shoulder-to-shoulder with those elite
Rangers, you can do so after passing from
the Ranger School. On the basis of how
well you do in the school of your calling,
you can further opt to take on one of
many roles.

■ tactics

Career counselling for aspiring soldiers

arcade ■

TEAM/SQUAD LEADER
The Team Leader is the person responsible
for what the team does, or fails to do. The
leader is armed with the M16A2 rifle (capa-
ble of firing in either semi-automatic mode
or three-round bursts) or an M4A1 carbine

GRENADIER
Armed with a single-shot M203, which can
be mounted under the M16A2 or M4A1, the
Grenadier is a key member of the U S Army
fire team. He is capable of delivering accu-
rate fire at point and area targets from
medium to long distances

AUTOMATIC RIFLEMAN
The Automatic Rifleman combines awesome
firepower with quick manoeuvrability
thanks largely to the M249 SAW. This gun-
ner is required to provide long-distance
cover as well as assault fire

Step 1: Account setup
From the Operations Main Menu, select
the Report for Duty option and then
Create a New Online Soldier. This will
open your Web browser and connect
you to an official Authentication Server,
where you can register your name and
authenticate it with a password.

Step 2: Sign in
Use the information set up in the first
step to login to an appropriate server.
This is mandatory if you wish to take
part in any Tour of Duty (see Step 5).

Step 3: Basic Training
This is the only offline component of the
game and must be completed before
attempting a mission. It’s a compulsory
tutorial that consists of a basic rifle marks-
manship course, where you qualify for
using the M16A2 assault rifle. An obstacle
course introduces you to movement tech-
niques, whereas weapons familiarisation
introduces you to the M249 SAW, M203
grenade launcher and grenades. Finally,
you get to put your skills to test in a simu-
lated combat environment using MILES
(Laser Tag) with real weapons.

Step 4: Training schools
Some Tours of Duty require you to clear
the training schools, i.e, if you wish to
become a sniper then you must complete
Sniper Training with the required marks.

Step 5: Tours of Duty
In Tour 1, you join the 172nd Separate
Infantry Brigade to protect a bridge and
an oil-pipeline. In Tour 2 you team up
with the 10th Mountain Division to take
control of an insurgent camp and rescue
POWs. Tours 3 and 4 are in the imple-
mentation stages and promise missions
with the 82nd Airborne Division and the
75th Ranger Regiment. The tours are
meant to be played on a network.

Join the Army
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After learning that The Sum of All Fears
(SoAF) was not so much a Quake-clone

as a squad-based strategy game, our com-
bined senses raced back in time to the
painful sessions of playing Tom Clancy’s
Rainbow Six . Thankfully, SoAF does not
live up to its name and is both an
approachable and an entertaining foray
into the world of action-strategy games.

Although based on the movie, SoAF
does not cast you as Jack Ryan. Instead,
you play the team leader of an elite anti-
terrorist squad, whose services are
required after America witnesses a
nuclear detonation. You and your team
carefully navigate through 11 missions
all over the world and neutralise hostili -
ties. On the journey, you pick up impor-
tant pieces of intelligence, disarm and
plant bombs, rescue hostages, ransack
vaults, and assassinate many a baddie.

The inclusion of real-world weaponry is
elegantly handled: the MP5s are segre -
gated from the M4s, by both the damage
that each deal out and by authentic
sounds that accompany them. 

Unfortunately, for a squad-based
game, both hostile and friendly comput-
er-controlled entities will simultaneously
amuse and dumbfound you with their
lack of AI. Although the experience thus
presented is not very jarring, it is further
bogged down by the use of a dated 3D
engine. The locales are rarely breathtak-
ing, either in ambience or design; the tex-
tures used are similarly ordinary and ditto
the animations employed. All of this, of
course, means that the game is not too
demanding, hardware-wise. Plus the
inclusion of a meaty and thoroughly
enjoyable multiplayer facet (especially
over a LAN) more than redeems the game.
If you wish to give your circle-strafing and
bunny-hopping skills a rest and yearn for
something that does not involve you
jumping over exploding rockets, then you
owe this game a try.

The Sum of All Fears
Adds up to a fun experience

HEART-TO-HEART: Locate friends and foes
alike with the help of high-tech heart beat
sensors

Minimum System Requirements: 450 MHz processor, 128 MB RAM, 16 MB DirectX 8 compatible 3D card ■ Genre: Action-Strategy
Developer: Red Storm Entertainment ■ Distributor: Milestone Interactive ■ Phone: 022-8381614 ■ Web site: sumofallfears.ubi.com ■ Price: Rs 1,299 
Rating: ★★★ ✩

Hired Team: Trial Gold
An asinine mettle

Imagine a world where crime and violence
are so rampant that the government actu-

ally decides to do something about it! In
Hired Team: Trial Gold (HTTG), such a world
does exist and the government creates a
strike team to put an end to the anarchy
and bring the twin gifts of hope and joy to
an otherwise destitute world. 

It is a concept that has been attempted
before and with better execution. All
through the game, you run around the 
various levels, shooting things that dare
wear a different coloured shirt! The maps
feel tacky and the weapons are poorly 

balanced—a pistol will get you nowhere,
while a rifle has a one-shot-kill guarantee,
regardless of where you hit the baddie. The

bots have an unfinished Frankenstein-
monster feel to them. So don’t blame them
if they refuse to use the health-kit that lies
next to their feet and are unaware of the
protective benefits of an armour. Watch
them climb over your back, pass right next
to you without even a parting shot and
gaze in wonder as they float around the
world like brain-searching wraiths. 

HTTG is a bad cocktail of an extreme
effort towards Unreal Tournamentand Quake
III Arena and an element of originality is
brought only via its interface. Go ahead,
play this game, unmake your day.

Minimum System Requirements: 400 MHz processor, 64 MB RAM, OpenGL or Direct3D compatible graphics card ■ Genre: First Person Shooter
Developer: New Media Generation ■ Distributor: Aladdin Multimedia ■ Phone: 022-7895085/7903959 ■ Web site: www.nmg.ru/httrial/ ■ Price: Rs 499 
Rating: ★★✩✩✩

✩

HAVE WE MET? Hey! I killed you five seconds ago

➜
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So you’ve checked out those
Extreme Sports dudes and

dudettes wheel over cars, grind
over pipes in their entire body-
twisting, knee-bending glory.
Exciting stuff for sure. Tony
Hawk’s Pro Skater 3 (THPS3)
takes us one step away from the
spectator seat that the televi-
sion puts us in and delivers an
as-good-as-it-gets experience on
our computer monitors. 

Although this game is
available for all the major con-
soles, what separates the PC
version from the rest is the
inclusion of some great net-
work play. The online compo-
nent successfully utilises the
skating aspect to put an enjoy-
able spin on the eight different modes of
play. Thus Graffiti calls for you to tag an
obstacle or an area by pulling off a trick,
Trick Attack pits you against your opposi-
tion in a test of skill, Slap! awards points
for literally running into other players,
Control the Zone is a contest of dominat-

ing an area, and so on. Although play over
the Internet is not as solid as it should
have been, sessions over a LAN are high-
ly recommended. The single-player ele -
ment is an outstanding achievement.
Included here is the Free Skate mode
which offers unlimited skating without

score-tracking—an ideal way to
get intimate with a level. But
the crux of the game lies in the
Career mode where you will
earn points and reputation as
you unlock new levels, skaters,
and tricks.

For a PC title, the graphic
splendour is a bit of a hit-and-
miss show. The models are
greatly detailed and very natu-
ral looking, while the anima-
tions are convincing and
immersive. But what tears away
from the visual quality are the
textures used—most of them
are too uniform and lack detail,
imparting a very uninspiring
look to an otherwise splendid
game. However, where the tex-

tures miss, the audio facet makes up with
excellent sound effects and a lively sound-
track. The only caveat is that THPS3
would be better approached with a
gamepad—if any game deserves to be
pampered with that peripheral device, it is
this one!

Tony Hawk’s Pro Skater 3
Pro-foundly entertaining

DON’T TRY THIS AT HOME: Being able to pull tricks like this is what
makes this game so cool

Minimum System Requirements: 300 MHz processor, 64 MB RAM, 8 MB DirectX 8 compatible 3D card ■ Genre: Sports 
Developer: Neversoft ■ Distributor: Milestone Interactive ■ Phone: 022-8381614 ■ Web site: www.activisiono2.com/tony_hawk/ ■ Price: Rs 699
Rating: ★★★★✩

Let us begin by saying: Look for anoth-
er book, this one holds no value for a

professional and is not aimed at the
novice. The stated objective of this book is
‘the imminent need for sharing the novel
ways of learning we (the authors) have cre-
ated and experienced’. However, it is bereft
of any practical experience or novel
insights. The book attempts to cover a
broad spectrum of the e-learning domains
such as the history and development of
teaching techniques, analysis of learning
models, job roles in e-learning, as well as
the technology used to develop e-learning
solutions. However, it manages to touch
on each topic only fleetingly, and provides

overviews that may
interest the novices
but leave the profes-
sional, whom the
book is primarily tar-
getted at, unin-
formed. Important
technologies like
XML are dismissed
within a few meagre
lines and the usage
scenarios completely
miss the point.

The authors are
project managers, yet they repeatedly
attempt to make a business case for 

e-learning. The result is a book
that is predictably simple-
minded, dripping with enthu-
siasm and entirely lacking in
any kind of balanced thought
and content. The authors of the
book generously state upfront
that much of the contained
material is repetitive—a candid
preview into what’s in store for
the discerning reader. 

The facts and concepts con-
tained within its pages  can eas-
ily fit into a small booklet and

are certainly not worth the time and
expense the book demands. 

Publisher: Tata McGraw-Hill Publishing Company Ltd ■ Contact: Tata McGraw-Hill Publishing Company Ltd ■ Phone:011-5732841/918
Fax: 011-3266427 ■ E-mail: bpb@vsnl.com ■ Price: Rs 499
Rating: ★✩✩✩✩

Economically unknowledgeable
E-LEARNING, AN EXPRESSION OF THE KNOWLEDGE ECONOMY
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There’s more to Digit than just
exhaustive research and tests to
stay apace with the latest tech-
nologies and products, or taking

apart the latest high-falutin’ devices in
the Test Centre and then putting them
back together. The job often calls for step-
ping out of our hi-tech testing labs to
attend seminars organised by peers in the
media and different segments of the
technology industry. 

In a similar vein, Hakim, head of our
Test Centre set sail for Beijing, China, this
month to attend a conference organ-
ised by Canon. The three-day-long
conference was a great opportunity to
understand issues concerning the
printer market worldwide.

But the China trip turned out to
be a learning experience in more
ways than one. On the last day of
the conference, Canon had organ-
ised a grand send-off dinner for the 60-
odd delegates. The Indian delegation,
consisting of six people from the tech-
nology industry, including Hakim,
decided to use the free time before
dinner to see something of the For-
bidden City. 

After an eyeful of sightseeing, it was
time to head for dinner, but asking direc-
tions was rather tiresome, as nobody

seemed to understand English. Accus-
tomed to being prepared for all eventu-
alities, Hakim had made sure to carry
along the restaurant’s visiting card and
managed to locate the restaurant by rely-
ing heavily on sign language and point-
ing to the card when asking for
directions. 

By the time they found their way to
the restaurant, it was already a little after
the stipulated hour. But they couldn’t see

any of the other delegates there. Several
inquiries in pidgin Chinese about dinner
for 60 people from Canon to be held at
the restaurant only led to confusion and
alarm on the part of the restaurant staff at
the prospect of arranging seating space
for so many. Finally, they managed to
make some headway: it was suggested
that maybe the dinner was being held at
another branch of the restaurant in
Tiananmen Square. 

More sign language, pidgin Chinese
and 40 minutes later, Hakim and com

panions located the restaurant,
only to find it closed. Never
one to give up easily, Hakim
decided to call the Canon head
office and find out where the
venue was. As it turned out,
they had gone to the right place

the first time, but the rest of the
delegation was late and had
reached there after Hakim and
friends had left for Tiananmen
Square. By now, everybody was
terribly hungry and the prospect

of another 30-minute wait for
dinner was too much. Hunger

won over the temptation of try
ing out some more of authentic Chinese
cuisine and the weary sixsome made a
beeline for the nearest McDonald’s!

This is a story of the three pairs of shoulders
that carry the weight of Digit, or rather a
story of when they were away! Vinit Aggar-
wal, our editor, Sveta Basraon, our features
editor, and Shivshankar Pillai, our head
designer, midwife Digit through the pro-
duction cycle every month. 

But this month, as each of them got
called away, the rookies came out to play!
Pillaiji, as we affectionately call him, went
on a long-postponed trip to his native
God’s own country, while Sveta trotted to
discover the wonders of Pachmarhi, Mad-
hya Pradesh. Vinit, on the other hand, got
called back by a somewhat hostile mother-

ship (read: He decided to go home before
he forgot what it looked like. Luckily for
him, his driver still remembered the
address).

Those who were left to hold up the fort
got to play the favourite game of magazine
magazine with Digit, much to the Market-
ing department’s horror. As soon as our
publisher heard of the decreased ‘body
count’, he sent us a reassuring mail on how
we could always turn to him for guidance;
the consumer service people began practis-
ing their ‘I’m sorry your issue is late’ speech
even as the rest of the company cast nerv-
ous glances in our direction. 

But we had our priorities right—we sin
gle-mindedly focused on brewing the per
fect coffee. Our writer Veer, found the per
fect opportunity to put his theory of cross
breeding to test. Job definitions blurred into
non-existence, so Ahmed metamorphosed
into a technical editor, Marco, the head of
writers, supervised design ideas and Veer
tweaked around with the layouts, moving
them about at Mitali’s—our ever smiling
copy-editor—whims and fancies.

But surprisingly, Digit came out on time,
with all pages intact. Moral of the story:
never underestimate the power of a good
pot of coffee! 

When the Cats are Away…

Going places in the global village

ILLUSTRATION: Mahesh Benkar
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More than you deserve

Page not found

Highlight the lighter side of computing. Mail your contributions to: Backbyte Digit,
Plot D-222/2, TTC Industrial Area, MIDC, Shirvane, Nerul, Navi Mumbai 400 706
or e-mail us at backbyte@jasubhai.com
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Go to an invalid page at www.coolnessdojo.com and
this is what you will see:

Your chance to
bite back!

… and Microsoft is just getting there

This installation for Yahoo! Messenger seems
just about complete at 180 per cent… Now that’s a killer Heads Up Display!

Computer Love
Dear Cobol,
The site of you increases the clock speed of my heart. You wear a dress with all
the colours of an XGA display adapter, overclocking my eyes. When I first saw
you in the first row of the second column of the 10x5 set of seats in the bus, I
lost my Control Panel. I stopped communicating with my friend and my eyes
were fixed on you. I was caught in the Web of your beauty. I followed you to
find out more about you but I crashed and had to reboot. My desktop is filled
with icons of your love. I never had a bit of drink or byte of my cookies from
the time I Cut and Paste your image in my memory. My Random Access Mem-
ory stops responding when your high resolution image flashes through it. My
hard disk is filled with your data. I browsed through the library files in my
Office for your address but my search yielded no results. I could not contact
you earlier because I came down under a viral attack. If possible, I would like
to C you in the Procedure division near the PrettyPark where a site is being
developed, else I would like to Place a Call to your home. Please don’t truncate
my love. Do give me permanent access to your heart.
Yours programmably,
Pentium 4

Submitted by Mahesh Benkar
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